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What’s New in 2008
This version of TurningPoint includes a healthy number of improvements and additions. The new 
features provide simplified device set up, more control over how results can be displayed, interesting 
new ways to engage your audience, and a more customizable experience.

Internationalization

TurningPoint now supports users who speak non-English languages including French, Brazilian 
Portuguese, Spanish, Dutch, Japanese, Korean, German and Russian.

Enhanced Response Device
Detection

TurningPoint’s Enhanced Response Device Detection... 

• Provides Plug and Play capabilities for Response Innovation’s USB Receivers eliminating the 
Device Location and need to run the Response Device Wizard

• Allows you to predetermine and set Channels when presentations are being conducted in multiple 
adjacent rooms

User Friendly Settings and
options allow for a more

Personal Experience

With the new settings interface, you can:

• Use the Settings Hierarchy to personalize the Presentation-level, Slide-level and Answer-level 
settings

• Use drop-down menus to change many of the settings

• Choose from Common Settings or All Settings
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• Review a more detailed description of each setting

With more customizable settings and options, you can:

• Use an mp3, aiff, au, mid, midi, or wma as a Countdown Sound

• Customize where you save your sessions

• Assign negative point values to questions and answers

• Move the Showbar anywhere on the screen

Picture Slides Enhancements

Assign an answer value to a Picture Slide with a simple mouse click. 

• Set an answer as Correct/Incorrect or assign a point value

• Clear the value for an answer

TestingPoint 2008 Support

TestingPoint is a Microsoft Word add-in that allows you to:

• Create self-paced paper tests

• Collect responses via the Test Administrator

• Run reports in Microsoft Excel

• Upload TestingPoint sessions into VantagePoint to view performance of each child, class, building, 
or district level compared to State Standards

• Import your self-paced tests into TurningPoint to create interactive presentation

Built-in Testing Standards

With Built-in Testing Standards, you can choose standards by: 

• State (choose from all 50 states)

• Topic

• Subject 

• Grade
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Smarter Conditional
Branching

Creating a Conditional Branch has been simplified. TurningPoint 2008 guides you along the way. 

TestingPoint is a Microsoft Word add-in that allows users to create self-paced tests. TurningPoint 
allows users to import TestingPoint documents to create an interactive presentation.
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About 
TurningPoint

Welcome to TurningPoint, the easiest, most powerful, fully interactive group response system 
available. Designed to be used with PowerPoint, TurningPoint enables two-way communication 
between a speaker and a large group by allowing audience feedback. TurningPoint offers the ability to 
collect, evaluate, and record responses from everyone in the audience, transforming a lecture, 
workshop, or meeting into a more effective learning environment for everyone in the room. By 
engaging each participant, TurningPoint creates a unique session every time, recording response 
data that can be used immediately or later for grading, polling, attendance tracking, and demographic 
research.

Whether you want to gauge an audience’s opinion or quickly assess your students’ understanding on 
important points in a lecture, TurningPoint enables you to ask and receive a response at the very 
moment you want to ask most. The audience uses response devices to submit answers to questions 
you have created. Then, TurningPoint gathers responses from each participant and quickly translates 
them into measurable results in the form of test scores, charts, and graphs. 

After a presentation, TurningPoint helps you store the data for later access or for use in reporting or 
grading.

This chapter provides an overview of the product and its capabilities and includes the system 
requirements, the steps for installing TurningPoint on your computer, and some resources available to 
you for customer support.
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Product Introduction

TurningPoint smoothly integrates with PowerPoint to create a more interactive and memorable 
presentation. TurningPoint was designed to run on Office 2003 and Office 2007 with Office XP 
support. (Find additional information in System Requirements on page 11.) All TurningPoint options 
are accessed through the TurningPoint toolbar.

The TurningPoint toolbar can be found in PowerPoint beneath the standard PowerPoint toolbar after 
TurningPoint is installed. This toolbar offers you all the options you need to create interactive slides, 
set up and run a presentation, and generate reports. Easy-to-use features such as the Participant List 
Wizard helps to you get started quickly. 

Other TurningPoint features include participant monitoring and reporting tools. TurningPoint also 
provides the ability to connect to an educational institution’s WebCT or Blackboard server or to use 
Turning Technologies’ Enterprise Manager to streamline the creation of Participant Lists and reporting 
of classroom results and grades.

Additionally, TurningPoint is now available in a range of non-English languages. Customers may 
download a language pack from www.TurningTechnologies.com.
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System Requirements

System Requirements

TurningPoint is designed for use on computers with typical abilities. You do not need the very latest 
technology or a large amount of hard disk space to use TurningPoint. There are, however, a few 
requirements that you should check before installation. The requirements for hardware and software 
are detailed in the following sections.

Requirements for Hardware

The following hardware specifications are required before installing TurningPoint:

• Intel or AMD 600 Mhz class processor (1 GHz or higher recommended)

• 256 MB RAM (256 MB or more of “available” RAM recommended)

• 60 MB hard disk space (an additional 32 MB is required if you do not have Microsoft .NET 
Framework 2.0 installed)

• 1024x768 resolution at 32-bit color or higher

• Standard USB 1.1/2.0 port 

• Ethernet or 802.11 compatible wireless network card (for ResponseWare App and ResponseWare 
App Presenter use)

Requirements for Software

The following software applications are required before installing TurningPoint:

• Microsoft Windows XP, Vista, or higher

• Microsoft Office 2003, 2007, or XP
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Initial Setup

There are two easy steps that need to be completed before you begin using TurningPoint. This 
section will guide you through those steps.

This section describes how to:

• Install TurningPoint 

• Open TurningPoint with PowerPoint 
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Install TurningPoint

Install TurningPoint

In a few simple steps, TurningPoint can be installed on your computer. The installation process takes 
just a few minutes, and then you will be ready to create a TurningPoint presentation.

Before You Begin

Check the hardware and software specifications outlined in System Requirements on page 11. A 
computer must meet these system requirements before installation.

Step by Step Instructions To install TurningPoint software on a computer…

1 Install TurningPoint in one of 
two ways:

• Download the latest 
edition of TurningPoint 
from the Turning 
Technologies web site. 

The Turning Technologies web site is located at 
http://www.turningtechnologies.com. Complete the 
download request form and Turning Technologies sends 
an email with download instructions. When the download 
is complete, double-click the setup icon to launch the 
InstallShield Wizard.

• To install from a CD, insert 
the CD into the computer.

After you insert the CD, the InstallShield Wizard launches 
automatically.

2 If an older version of 
TurningPoint is installed, the 
InstallShield Wizard displays 
a message requesting you to 
uninstall the previous 
version. 

If this is the first time you are installing TurningPoint or have 
already removed a previous version, continue with step 3.

a. Select OK. The Windows Installer closes.
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See Windows Help file for instructions on uninstalling a 
previous version. Resume process at step 1.

3 Select the Next button to 
continue the installation.

A window opens and displays the license agreement. Use the 
scrollbar to read the license agreement on the screen or select 
the Print button to send the text to a printer. 

License Agreement

4 Select the button labeled “I 
accept the terms in the 
license agreement” if you 
accept these terms. 

Accepting the terms of the license agreement permits you to 
continue with the process of installing TurningPoint. 
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Install TurningPoint

5 Select the Next button. A window opens and displays customer information entry fields. 

Customer Information

6 Enter your name and 
organization in the fields.

7 Select the Next button. A window opens and displays a confirmation message stating 
that the computer is ready to install TurningPoint.

Install the Program
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8 Select the Install button. The computer installs TurningPoint and displays the Finish 
button on the page when the process is complete. 

Installation Wizard Completed

9 Select the Finish  button. A window opens and displays a message that the installation is 
complete. Select the Launch TurningPoint checkbox if you 
would like to immediately open the program.

The TurningPoint shortcut located on your desktop points to the 
location where you installed TurningPoint on the computer. 
Double-click the icon to open the program.

TurningPoint Shortcut Icon



TurningPoint User Guide 17

Open TurningPoint with PowerPoint

Open TurningPoint with PowerPoint

After you install TurningPoint onto your computer, you may want it to open automatically when you 
open PowerPoint. Or, you may want the programs to always open separately. You can change this 
option from the Settings window. 

Step by Step Instructions To toggle the option to automatically load TurningPoint...

1 Double-click on the 
TurningPoint icon.

2 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens.

Settings Window

3 Select Presentation from the 
Settings Hierarchy.

A specific list of settings options displays in the menu. 
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4 Scroll down the menu until 
you see the Misc settings.

5 Select the Add-In always 
loaded setting.

A drop-down menu opens.

Settings Window: Add-In always loaded

6 Choose either True or False. Choosing True means that TurningPoint automatically loads 
when PowerPoint is opened.

Choosing False means that TurningPoint does NOT 
automatically load when PowerPoint is opened; you must 
launch TurningPoint by using the TurningPoint.exe shortcuts 
created at the time of installation.

7 Select the Done button. The Settings window closes and, depending on your selection, 
TurningPoint either loads or does not load the next time you 
open PowerPoint.

Note TurningPoint uses False as the default 
setting for Add-In always loaded.
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Tour of the TurningPoint Toolbar

Tour of the TurningPoint Toolbar

When you launch TurningPoint, PowerPoint opens and the TurningPoint toolbar is displayed beneath 
the PowerPoint standard and formatting toolbars in the upper region of the window, as the following 
image depicts.

TurningPoint Toolbar

The following descriptions define the buttons that make up the tools in the TurningPoint 2008 toolbar: 

Information Allows you to view information about your TurningPoint 
Software. It also allows you to see liscensing information for 
the reveiver you are using, and it provides a mechanism to 
supply Feedback to TurningTechnologies.

Reset Displays a menu of options to clear the current user 
response data to start a new session or reset individual 
slides for polling. Find information about polling the 
audience in Chapter 7: Run Presentations.

Continue Prior 
Session

Opens a previously saved session. A session is a run-
through of a presentation where an audience has submitted 
responses to some or all of the questions. Find information 
about continuing a prior session in Chapter 9: Sessions. 

Save Session Stores the current session for retrieval later. Find information 
about saving sessions in Chapter 9: Sessions.

Insert Slide Displays a menu of TurningPoint slides that you select to 
create a presentation. Find information about TurningPoint 
slides in Chapter 3: Creating and Saving Slides.

Convert to 
Picture Slide

Assigns pictures as answers in place of text. Find 
information about picture slides in Chapter 3: Creating and 
Saving Slides.
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Insert Object Displays a menu of items that you select to enhance a slide. 
Find information about slide options in Chapter 3: Creating 
and Saving Slides.

Tools Displays a menu of options to report, modify, track, create 
and integrate TurningPoint presentations and sessions.

Select Input 
Source

Selects the input source to be used for collecting response 
data. These include Response Devices, Keyboard Keys (0-
9), and Simulated Data. Find information about response 
devices in Chapter 4: Response Device and Settings 
Management.

Participants Provides options to create, edit and delete Participant Lists. 
Find information about these options in Chapter 5: Track 
Participants and Teams.

Select a 
Participant List

Used to associate a participant list with the current session. 
Find information about Participant Lists in Chapter 5: Track 
Participants and Teams.

Display 
TurningPoint 
Help

Opens the help file. 

Toolbar Options Customizes the PowerPoint and TurningPoint toolbars.
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Customer Support Resources

Customer Support Resources

This guide defines and demonstrates many of the tools and functions that TurningPoint provides. If 
you have questions and concerns, additional resources are available to you online or by calling a 
Turning Technologies Representative. 

Online Assistance

Turning Technologies offers assistance to customers online through the Turning Technologies web 
site. To access the web site, go to http://www.turningtechnologies.com.

Go to the Product Guides and Manuals section of the Turning Technologies web site to find valuable 
information about using TurningPoint. The Downloads section provides a link to the Quick Start 
TurningPoint Users Guide. Select the link to download the user guide for viewing or printing. 

Go to the Learning Community section of the Turning Technologies web site to find training 
information including:

• Tutorials

• Online Training

• On-site Training 

• Case Studies 

• Best Practices 

• Presentations/Podcasts 

Customer Support

To speak with a Turning Representative, call our toll-free phone number: 1-866-746-3015. By E-mail, 
send your inquiry to support@turningtechnologies.com.

Office Hours:

Monday through Friday, 7:00 AM to 9:00 PM (EST)
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Mailing Address:

Turning Technologies, LLC
241 Federal Plaza West
Youngstown, OH 44503

Turning Technologies, LLC offers complete TurningPoint training. Our trainers are ready to hit the 
road to fulfill your training needs at your location. Or if you desire, send your team to our state-of-the-
art training facility in Ohio. 

Typical training sessions last from two to six hours depending on your intended use of TurningPoint 
and skill level with Microsoft Office products. For Training Services, call 1-866-746-3015 for details.
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Where Do I Go From Here?

Where Do I Go From Here?

If you are new to TurningPoint, this manual will help you on your way. Read through Chapter 2: 
Getting Started with TurningPoint to receive a general overview of working with this product. 

Are you a returning user? Details of the new TurningPoint features can be found throughout this 
document. What’s New in 2008 on page 1 outlines these new features, while the Table of Contents or 
Index should help you find them quickly.
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Getting Started 
with 
TurningPoint

The process to create interactive presentations with TurningPoint is very simple. You can successfully 
build, deliver, and save the results of an interactive presentation in five easy steps.

From there, with a little more effort, you can customize the slides and include animation, feedback 
mechanisms, and excitement in your presentation. You can also create reports to view the results of 
your presentation session.

This chapter provides the basics, a tutorial of sorts, for using TurningPoint. Following the five steps to 
success allows you to create very simple interactive presentation slides, set up the devices, create a 
Participant List, and use TurningPoint to present those slides. 

The advanced features of TurningPoint are detailed in the chapters that follow. You can find 
information about the contents of those chapters in Where Do I Go From Here? on page 50.
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Five Steps to Presentation Success

Creating an interactive presentation with TurningPoint can be accomplished in five easy steps. 
Remember, none of these steps are required, and it is not entirely necessary to perform these steps 
in this order.

Five Steps to Successs

Note While the steps below outline the suggested 
approach to presentation success, you are not 
required to perform the steps in this order, and you 
may to omit steps that do not apply to you.
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Five Steps to Presentation Success

As the previous diagram depicts, you start by creating the presentation slides. These slides can be as 
simple or complex as you desire. You can use PowerPoint’s features to apply a background, insert 
graphics, etc. to meet your needs. You will repeat this step many times as you create additional 
TurningPoint interactive slide presentations.

Next, plug the devices into your computer to be used during the presentation and you are ready to 
gather responses from the audience. You can go to the Polling Test found in Chapter 4: Response 
Device and Settings Management to test communication or skip the test and go to the next step. 

Identify your audience. Create a Participant List using the Participant List Wizard. You can choose 
from using standard list templates or create one of your own to store as much information about your 
audience as required. You can also run a presentation without a Participant List or create a 
Participant List for each audience.

When that’s done, you are ready to run the presentation. You’ll use PowerPoint’s Slide Show 
functionality for this purpose. Behind the scenes, TurningPoint is gathering, tallying, and storing the 
responses provided by your audience.

Finally, save the results of your session in a file to be used with TurningPoint’s reports to evaluate the 
audience’s responses. Perform this step for each presentation session.

Instructions to perform these five steps to success are detailed in the following sections. Instructions 
to use the advanced features of TurningPoint are found in the chapters that follow. 

This section describes how to:

• Step One: Create Presentation Slides

• Step Two: Set Up the Response Devices

• Step Three: Create a Participant List

• Step Four: Run a Presentation Session

• Step Five: Save Session Results
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Step One: Create Presentation Slides

Using TurningPoint to create an interactive presentation requires some basic PowerPoint knowledge 
and your imagination. Your slides can simply contain question and answer text, or you can add 
TurningPoint objects to each slide to allow your participants to interact effectively with your 
presentation. TurningPoint’s objects include Answer Now prompts, Countdown and Response 
Counter shapes, to name a few.

Before You Begin

Install TurningPoint on the machine to be used to run the presentation. Find installation instructions in 
Install TurningPoint on page 13.

You should be familiar with the basics of creating slides using PowerPoint. This manual discusses 
how to use TurningPoint to create interactive presentation slides.

Step by Step Instructions To create a simple slide…

1 From the TurningPoint 
toolbar, select the Insert Slide 
menu. 

A menu opens and displays a variety of pre-defined slides. Each 
slide can be used as-is or customized to behave as you desire.
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Step One: Create Presentation Slides

As you move your cursor over the entries in the Insert Slide 
menu, the slide name is highlighted. Find more information on 
slides in Types of Slides on page 62.

Insert Slide
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2 Highlight and select the 
Vertical Slide option.

TurningPoint inserts a Vertical Slide. The slide contains a 
question, answer, and chart region.

Insert Vertical Slide

3 Select the Question region 
and enter in a question.

When you select the region, the text is highlighted. The 
highlighted text is replaced with the question text that you enter.

4 Select the answer region and 
enter in the answers.

This region has the same behavior as the Question region. You 
can enter a maximum of ten answers per slide.

Question region - “Enter question text...”

Answer region - “Enter answer text...”

Chart region - This example is a vertical bar 
chart. Charts can be positioned anywhere on the 
slide.
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Step One: Create Presentation Slides

5 Repeat step 1 to 4 to insert 
additional slides.

6 Save your file from the 
PowerPoint toolbar before 
exiting TurningPoint.

Next Steps

Slides can be customized by adding a variety of animated feedback mechanisms. Find information 
about these different presentation objects and a variety of other slide features in Chapter 3: Creating 
and Saving Slides.
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Step Two: Set Up the Response Devices

Each audience participant uses a response device to respond to the questions asked during the 
presentation.

TurningPoint supports a variety of response devices including infrared and radio frequency 
ResponseCards as well as ResponseWare App, laptop and desktop computers, and Smart Devices. 

TurningPoint needs to know what types of response devices will be used before you run the 
presentation. 

Before You Begin

You must have TurningPoint installed on the computer to be used for the presentations. You must also 
have the USB Response Device Receivers and Response Devices available for testing. 

Step by Step Instructions To set up the response devices…

1 Connect the device receiver 
to the USB port of the 
presentation computer.

Connect the USB Response Device Receiver to your computer. 
Windows detects the receiver and installs the proper drivers. 
The device is now ready for use. 

Infrared and Radio Frequency Response Device Receivers

If you are using a response device licensed for TurningPoint 
2003 or 2006 you must upgrade your response device receiver 
license code. Contact your Account Executive to receive a new 
license code for TurningPoint 2008.

Note TurningPoint 2008 supports only the 
ResponseCard family of keypads.
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Step Two: Set Up the Response Devices

2 If required, Upgrade your 
Response Device. 
Otherwise, go step 3.

If you have not already upgraded your response device 
receiver, you must complete this step. 

a. From the TurningPoint 
toolbar, select Tools > 
Upgrade TurningPoint 
Receiver. Follow the on 
screen instructions. 

Upgrade Response Device
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3 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The TurningPoint Settings window opens, displaying two tabs: 
Settings and Polling Test. 

Settings Window

4 Select the Settings tab. The Settings tab displays a Settings Hierarchy in the left pane 
and the available settings in the right pane.
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Step Two: Set Up the Response Devices

5 Select Response Device 
from the Settings Hierarchy. 

Settings for the Response Devices display in the right pane of 
the Settings window. Select All Settings to access additional 
settings.

Settings Window: Response Devices

6 Enter the number of expected 
devices. 

You are only required to enter the number of expected devices 
when using Simulated Data, a Response Counter, or Response 
Table.

TurningPoint limits the number of response devices that will be 
displayed in a Response Counter or on a Response Table 
based upon the number of participants in the participant list. 

Note The ResponseWare App is a software version 
of a response device. The ResponseWare App 
must be identified for use during device setup 
as well. Find more information on device setup 
in Chapter 4: Response Device and Settings 
Management.
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Find more information on Response Counters in Add a 
Response Counter on page 140 and Response Tables in Add 
a Response Table on page 143.

7 Select the Done button. The response devices are ready for use. 

Next Steps

Find more information about Response Devices and the Settings available in Chapter 4: Response 
Device and Settings Management.

If an audience member’s device is not being accepted, check the device’s ability to communicate. 
Radio Frequency and ResponseWare App response devices provide on-screen confirmation that 
responses have been received. For infrared response devices, the use of a Response Counter, 
Response Table or Response Grid will help to alert you of a non-communicating device. Find more 
information in Add a Response Counter on page 140, Add a Response Table on page 143, or View 
Polling Status on page 337.

Note Access the Response Device settings again 
when you need to change the number or type 
of devices being used with your presentations.
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Step Two: Set Up the Response Devices

Step by Step Instructions To Check Device Communication...

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The TurningPoint Settings window opens, displaying two tabs: 
Settings and Polling Test. 

Settings Window

2 Select the Polling Test tab. TurningPoint displays the Polling Test screen. Use this screen 
to verify that TurningPoint can receive responses from the 
devices. 

Settings Window: Polling Test
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3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. You can magnify the responses by placing a 
check mark in the box next to Magnify Values.

Polling Test: Magnify Responses

4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, Channel, and the key entry 
from each response device in the order in which they were 
tested.

Polling Test: Response Device Test

5 Select the End Test button. TurningPoint ends Polling test. 

6 Select the Done button. The response device testing is now complete. 
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Step Three: Create a Participant List

 Step Three: Create a Participant List

Participant Lists identify the members of your audience—your students, your trainees, your survey 
respondents—who will use a response device during your presentation. The participant name and 
required information is stored along with the Device ID.

You may create multiple Participant Lists to be used with one interactive presentation. Doing so 
allows you to use the presentation with multiple audiences and track the session results per audience.

Before You Begin

Your Participant List must not exceed the number of devices licensed for use. If you are not sure of 
the number, check the number of devices and then perform the following steps on the computer to be 
used for presentations after you setup your response devices. 

Step by Step Instructions To create a Participant List…

1 From the TurningPoint 
toolbar, select Participants > 
Participant List Wizard.

The TurningPoint Participant List  Wizard window opens.

Turning Point Toolbar: Participants
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2 Select a template to be used 
for the new Participant List.

Participant List Wizard

Participant List template choices include:

• Education—contains standard student information used 
for K–12 and higher education presentations, such as 
name and student ID.

• Corporate—contains entries for the information most 
often used in corporate feedback meetings including 
name, company name, telephone numbers, etc.

• Available Fields—contains all information entries defined 
for use with TurningPoint.

• Custom—allows you to create a personalized Participant 
List and to name the template or it allows you to select a 
previously created template from the list.
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Step Three: Create a Participant List

3 Select the Next button to 
continue.

If you opted to create a new template, TurningPoint asks you to 
name the template. Enter a name and select the OK button.

Custom Template Name

TurningPoint displays the Participant List information entries 
(called fields). All entries that make up the template appear in 
the Selected Fields region on the right. Use this page to add, 
delete, or reorder the entries that make up the template.

Participant List: Add or Remove Fields

4 Optionally, select the right (>) 
and left (<) arrow buttons to 
to add or delete selected 
fields from the template. 
Optionally, drag and drop a 
field from the Available Fields 
to the Selected Fields.

Note Find instructions to customize Participant List 
templates in Chapter 5: Track Participants 
and Teams.
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5 Select the Next button to 
continue.

TurningPoint displays the Groups entry box. Use this screen to 
add groups to your Participant List. Groups provide 
categorization allowing for team competitions and for greater 
reporting opportunities.

Participant List Wizard: Add Groups

6 Optionally, enter in a group 
name and select the Add 
button.

TurningPoint displays all groups in the Included Groups box. 
Place a check mark next to the group name to include it in team 
competition. Find more information on team competitions in Set 
Up Team Competitions on page 247.

• Repeat this step to add 
additional groups.

Participant List Wizard: Groups Added
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Step Three: Create a Participant List

7 Select the Next button. TurningPoint displays the Participant List summary screen. 

Participant List Wizard: Summary

8 Optionally, edit the 
Participant File composition.

The settings you can change include the Participant List file 
name, number of fields, and number of groups. For file name, 
select the old file name and enter a new one in the box provided. 
For number of fields or number of groups, select the link next to 
the setting to be returned to the screen and make your edits.

9 Select the Finish button to 
create the Participant List 
and save it to a file. 

TurningPoint opens the Participant Information window where 
you can enter, edit, paste, or import data. 
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10 Optionally, add names and 
other participant information 
to the new Participant List. 

Participant Information

11 Select Save to close the 
Participant Information 
window.

Next Steps

Find more information about Participant Lists in Chapter 5: Track Participants and Teams.
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Step Four: Run a Presentation Session

 Step Four: Run a Presentation Session

TurningPoint uses PowerPoint’s Slide Show capabilities to present the interactive slides you have 
created. You test your slides during development and run the presentation for your audience by 
executing the following steps.

Before You Begin

You must use either an installed Response Device Receiver, Keyboard Keys 0-9, or select to use 
Simulated Data before attempting to run the presentation. It is recommended that you use a 
Participant List, but you can still run a presentation session by selecting Anonymous or Auto for the 
Participant List.

Step by Step Instructions To run a presentation session…

1 From the PowerPoint menu, 
select File > Open and select 
the TurningPoint 
presentation to be used.

2 From the TurningPoint 
toolbar, select the Response 
Device menu and select the 
device to be used.

TurningPoint allows you to select how responses will be 
provided during the presentation. Your choices are:

Select Response Devices

• Response Devices—a response device will be used 
during the presentation. The response devices must have 
been set up in Settings. Find more information on 
response devices in Install Devices on page 161.

• Keyboard Keys 0–9—you will provide input to the 
presentation using the keyboard keypad or number keys.

• Simulated Data—TurningPoint provides random 
responses to the presentation. TurningPoint determines 
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the number of responses to provide based on the number 
of expected devices designated in settings; i.e. if you 
enter expected devices as 100, TurningPoint will provide 
100 responses to each question in your presentation. 
Find more information on expected devices in Enable 
ResponseWare App on page 177.

3 From the TurningPoint 
toolbar, select Reset > 
Session.

This command clears any active sessions from memory and 
allows polling to take place.

Reset Session

4 From the TurningPoint 
toolbar, select the drop-down 
menu to the right of the 
Participants menu and 
choose the Participant List.

The default Participant List is shown as (Anonymous). 
TurningPoint shows all Participant Lists available in the 
Participants folder. Participant Lists located on the desktop or in 
other folders are not displayed. 

Participant List Selection

5 From the PowerPoint menu, 
select Slide Show > View 
Show.

The first slide of the presentation is shown.
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Step Four: Run a Presentation Session

6 Use the left mouse button to 
control the progress of the 
slide show. For each slide:

Optionally, you can press the Spacebar, Enter, Right-Click or 
select Next on the shortcut menu to control progress.

a Advance the presentation 
to a TurningPoint slide to 
open polling.

Polling opens automatically when a TurningPoint slide is 
displayed in the slide show. TurningPoint receives 
responses when polling is open.

Polling is the mechanism by which TurningPoint accepts 
and tallies responses. 

b Click the slide once to 
close polling and display 
the results.

No responses are accepted when polling is closed.

c Click again to advance to 
the next slide.

7 Click on the last slide to exit 
from the Slide Show.

Next Steps

Your presentation may have additional features, such as animation, that cause it to behave differently 
at runtime from the default behavior. Find more information in Chapter 7: Run Presentations.
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Step Five: Save Session Results

TurningPoint stores the results from your session. These results can be reviewed at a later date and 
used with TurningPoint’s reporting feature in a variety of ways.

When you save a session, a default TurningPoint setting automatically includes the PowerPoint 
presentation with your TurningPoint file. You have the option to exclude the PowerPoint presentation 
from the TurningPoint session file. This function allows you to save the TurningPoint results data. If 
you do NOT wish to include the PowerPoint presentation in your TurningPoint session file, navigate to 
the Settings menu, select the Presentation settings, then under the Misc heading, change ‘Include 
Presentation’ from True to False. Find more information in Settings on page 186.

The session results are stored temporarily during a session. You can save the session results to a file 
to access them later. This section provides instructions to do just that.

Step by Step Instructions To save the session results…

1 From the TurningPoint 
toolbar, select the Save 
Session button. 

TurningPoint opens the Save Session dialog box.

Save Sessions

2 Enter a file name to be used 
to store the session results.

TurningPoint names session files using the current system date 
and time. Providing your own name for the file allows you to 
retrieve the file more easily.



TurningPoint User Guide 49

Step Five: Save Session Results

3 Select the Save button.

4 From the TurningPoint 
toolbar, select the Reset > 
Session command.

TurningPoint clears the existing session results and allows you 
to run the presentation again to capture new results. 

Reset Sessions

Next Steps

You are able to run reports to review the responses provided by each participant for your 
presentation. The TurningPoint reports use the saved session file. Find more information on Turning 
Reports in Chapter 8: Reports.

Note TurningPoint prompts you to save existing 
session results when you reset the session and 
when you exit from TurningPoint without 
previously saving the session. 
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Where Do I Go From Here?

The answer to that question depends upon what you want to do. Following is a listing of the remaining 
chapters in this book along with information about what to find in each chapter.

Chapter Name Description

Creating and Saving Slides This comprehensive, instructional chapter provides details 
of not only how to create a slide, but also how to add 
TurningPoint’s custom features to the slide to meet your 
needs. 

Read this chapter to understand how to add objects such 
as Response Reminders and Correct Answer Indicators, 
how to set slide defaults, how to convert existing slides into 
interactive TurningPoint slides, and more.

Response Device and Settings 
Management

Device setup is easy. However, if you need more help than 
what is included in this Getting Started chapter, you’ll find it 
here.

Read this chapter for a comprehensive guide of the 
available settings and how they can help you create a 
presentation to meet your needs.

Track Participants and Teams Participant Lists can use the default templates or can be 
customized to include information according to your needs 
or requirements.

Read this chapter to understand how to create custom 
Participant Lists, how to create Groups, how to modify or 
delete a Participant List, and how to download participant 
information from other sources.

Tools The tools discussed in this chapter include how to work with 
the Ranking Wizard, how to set up standards for your 
slides, and how to set up advanced features such as 
Comparative Links and Conditional Branching.
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Where Do I Go From Here?

Run Presentations Would you like to establish presentation session default 
behaviors? Have you included animation in your slides? 
Would you like to add slides during your presentation? 

This chapter focuses on the behavior of your slides during a 
Slide Show presentation and identifies how you, the 
presenter, interact with TurningPoint during a “live” session.

Reports This chapter focuses on the various reports produced from 
a Slide Show presentation. These reports allow you to get a 
better understanding of the audience and presentation 
results.

Sessions You can stop and save a session, and pick up where you 
left off at a later time. This chapter will teach you how to 
save, resume, and delete a session to give you flexibility 
during your presentation.

Export You may wish to export session data. This chapter will 
teach you how to export data in various ways.

Appendices The appendices include a Glossary and a guide to 
Frequently Asked Questions. 

Chapter Name Description
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Creating and 
Saving Slides

In Chapter 2: Getting Started with TurningPoint, you learned the basic steps for creating 
TurningPoint presentations. This chapter and the remaining chapters of this user guide demonstrate 
the steps in greater detail, allowing you to use all the powerful features TurningPoint offers.
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Recall the five steps to presentation success:

Five Steps to Success

As the previous diagram depicts, the first step is to create the presentation slides. This chapter 
demonstrates how to use TurningPoint to create the slides you will use later in a presentation.

TurningPoint slides are slides in a PowerPoint presentation with the ability to dynamically display 
information based on the responses of an audience. Most TurningPoint slides ask the audience to 
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answer a question, and then tabulate and display the responses. These slides have a question, 
answer, and chart region. 

Composition of a Typical Slide

The question region contains the text of the question you are asking the audience. The answer region 
contains an enumerated list of answers that the audience can choose from. (You can even use 
pictures as the answers. Find more information in Create Picture Slides on page 118.) 

The chart region shows the results of the audience’s choices, with a bar, slice, or other indicator for 
each answer (depending on the type of chart). There are six types of charts available. Find more 
information in Chart Slides on page 63.

You start by creating some TurningPoint slides. You have two options:

• Insert a TurningPoint template slide using the Insert Slide menu in the TurningPoint toolbar. Find 
instructions for inserting a slide in Insert a Slide on page 57.

• Convert an existing PowerPoint slide into a TurningPoint slide by inserting a TurningPoint chart 
using the Insert Object menu in the TurningPoint toolbar. Find instructions for converting a 
PowerPoint slide in Make a PowerPoint Slide Interactive by Inserting a Chart on page 125.

Question region - “Enter question text...”

Answer region - “Enter answer text...”

Chart region - This example is a vertical bar 
chart. Charts can be positioned anywhere on the 
slide.
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Once you create the slides, you can modify them in a number of ways. You can add pictures, change 
colors, change the chart, mark correct answers, and perform other operations specific to 
TurningPoint. Find more information in Modify Slides on page 89.

Additionally, TurningPoint allows you to add a number of TurningPoint objects to your slides. These 
include Answer Now prompts, Countdowns, and statistics like the average and variance of the 
responses. Find information on adding objects in Add Objects on page 130.

Your TurningPoint slides are saved as part of your PowerPoint presentation in your .ppt  file. Find 
information on saving your presentation in Save the Presentation Slides on page 60.



TurningPoint User Guide 57

Creating Slides

Creating Slides

TurningPoint allows you to create and save an interactive presentation. 

This section describes how to:

• Insert a Slide

• Save the Presentation Slides

Insert a Slide

You can insert a TurningPoint slide using the Insert Slide menu.

Step by Step Instructions To insert a slide into a presentation…

1 Launch TurningPoint.

2 Open a presentation or 
create a new presentation.
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3 From the TurningPoint 
toolbar, select Insert Slide.

The Insert Slide menu opens. 

Insert Slide menu

4 Select the type of slide you 
would like to insert from the 
Insert Slide menu.

TurningPoint inserts the new slide into your presentation.

Depending on what type of slide you selected, the new slide 
may contain question, answer, and chart regions.
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Creating Slides

Find information about the different slide types in Types of 
Slides on page 62.

Composition of a Typical Slide

Additionally, depending on your TurningPoint settings, the slide 
may contain an interactive shape such as an Answer Now 
prompt, Countdown, or Response Counters. Find more 
information on adding or changing these objects in Add Objects 
on page 130.

5 Edit the text in the question 
region to reflect the question 
you would like to ask the 
audience.

Question region - “Enter question text...”

Answer region - “Enter answer text...”

Chart region - This example is a vertical bar 
chart. Charts can be positioned anywhere on the 
slide.
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6 Edit the text in the answer 
region to reflect the choices 
the audience will have when 
responding to the question.

You may enter up to ten answers in the answer region.

Repeat this procedure as many times as needed to create your 
interactive presentation.

Save the Presentation Slides

Since TurningPoint slides are native PowerPoint slides, they are saved as part of your presentation 
file (.ppt). You can share this file with other TurningPoint and PowerPoint users. 

Step by Step Instructions To save your presentation…

1 Select File > Save As… from 
the PowerPoint menu.

The Save As dialog opens.

2 Select a location to save the 
file and type a filename for 
the file in the space provided.

You should keep the.ppt  extension in the filename to ensure 
that PowerPoint opens the presentation file.

3 Select the Save button to 
save your file.

TurningPoint saves all of the presentation-level settings that 
you defined in the Settings menu with your interactive 
presentation. When you open the presentation on a different 
computer, the saved presentation settings are used instead of 
the computer’s default settings. This function preserves your 
custom settings so that you do not have to reapply them every 

Note You can safely open the presentation on 
computers without TurningPoint installed, 
but you cannot use the TurningPoint 
features. You should not edit the 
TurningPoint slides on a computer without 
TurningPoint installed. Otherwise, the slides 
may not function properly the next time you 
run your interactive presentation.
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time you open a presentation on a new computer with 
TurningPoint installed. Find more information on settings in 
Chapter 4: Response Device and Settings Management.

Note You can restore the computer’s settings 
when using any presentation. In the Settings 
menu, select the Presentation archy. A 
Restore default presentation settings box 
displays in the bar below the settings 
options. Select this button and a dialog box 
opens with this statement: ‘This will restore 
the presentation settings back to the default 
installation state.’ Select Yes to restore the 
default settings.
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Types of Slides

The Insert Slide menu on the TurningPoint toolbar lists all of the slides you can insert into a 
presentation.

Insert Slide menu

This section describes

• Chart Slides

• Competition Slides

• Template Slides

• Special Slides
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Chart Slides
The first six slides on the Insert Slide menu insert a template slide with a chart of the specified type: 
vertical, horizontal, 3D pie, distributed pie, offset, or doughnut. The chart shows the results of the 
audience’s choices for each answer.

Chart Slides Menu

The six chart slides in the Insert Slide menu each contain the following:

• A Question Region with the text “Enter question text…”

• An Answer Region with the text “Enter answer text…”

• A Chart Region with a chart of the specified type: vertical, horizontal, 3D pie, distributed pie, offset, 
or doughnut

Charts are objects on the TurningPoint slide that can be moved and resized just like ordinary objects. 
You can change the type of chart on a TurningPoint slide by following the instructions in Change 
Chart Types on page 91.

Note Horizontal and Offset slides display Choice 
One, Choice Two, and etc. in the Answer 
Region.
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Vertical Slide

The vertical slide contains a bar chart with vertical bars for each answer.

Vertical Slide

Horizontal Slide

The horizontal slide contains a bar chart with horizontal bars for each answer. Each bar displays 
behind the corresponding answer in the answer region.

Horizontal Slide
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3D Pie Slide

The 3D pie slide contains a three-dimensional pie chart with a slice for each answer and a key 
indicating the color representing each answer.

3D Pie Slide

Distributed Pie Slide

The distributed pie slide is similar to the 3D pie slide except the slices are shown separated from each 
other.

Distributed Pie Slide
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Offset Slide

The offset slide contains a bar chart with horizontal bars for each answer. Each bar is shown directly 
below the corresponding answer in the answer region.

Offset Slide

Doughnut Slide

The doughnut slide contains a pie chart with a hollow center with a slice for each answer and a key 
indicating the color representing each answer.

Doughnut Slide
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Competition Slides
The second set of four slides on the Insert Slide menu are the setup and summary slides for 
competitions. These slides allow you to assign teams and keep track of the participants or teams with 
the most points and fastest responses. 

Competition Slides Menu

The competition slides include: Team Assignment Slide, Participant Leader Board, Team Leader 
Board, Fastest Responders Slide.

Since the Leader Boards and Fastest Responders slides are updated after each question, you only 
need to include one of each in your presentation. Simply place it at the end of the presentation and 
jump to that slide when you want to know which participants or teams are in the lead.

Team Assignment Slide

The Team Assignment slide allows teams to be assigned by asking the audience members to choose 
a team. Simply include names for the teams in the answer list and the participants will automatically 
be placed on the teams according to their answers. Display this slide early in your presentation so 
that participants can join a team at the beginning.

Team Assignment Slide
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Using the Team Assignment slide is an alternative to assigning participants to creating pre-assigned 
teams in a Participant List. The Team Assignment slide allows teams to be assigned dynamically, 
while assigning groups in the Participant List ensures that the same participants are always on the 
same teams. Find more information on setting up a competition in Set Up Team Competitions on 
page 247.

Participant Leader Board
Slide

The Participant Leader Board slide displays the top individual participants ranked by their point 
totals.The Participant Leader Board slide updates dynamically after each question.

Participant Leader Board Slide

You can specify the number of participants to show on the slide using the TurningPoint settings. You 
can also specify whether the point totals should be cumulative, or for the most recent question only. 
Find more information on modifying settings in Response Device and Settings Management on 
page 157.
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Team Leader Board Slide

The Team Leader Board slide displays the top teams ranked by their point totals. (The team’s points 
are the average of the team’s participant’s points.) The Team Leader Board slide updates dynamically 
after each question. 

Team Leader Board Slide

You can specify the number of teams to show on the slide using the TurningPoint settings.You can 
also specify whether the point totals should be cumulative, or for the most recent question only. 
Additionally, you can use more than one Team Leader Board slide in your presentation. Find more 
information on modifying settings in Response Device and Settings Management on page 157. 
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Fastest Responders

The Fastest Responders slide displays the individual participants who responded correctly and the 
fastest to the most recent question. This feature requires a correct response or point value. The 
Fastest Responders slide is updated dynamically after each question. 

Fastest Responders Slide

You can specify the number of participants or teams to show on the slides using the TurningPoint 
settings. Find more information on modifying settings in Response Device and Settings 
Management on page 157. 



TurningPoint User Guide 71

Types of Slides

Template Slides
The third set of slides on the Insert Slide menu are templates for commonly used kinds of questions, 
such as Yes/No, True/False, Yes/No/Abstain, Likert Scale, Generic and Ice Breaker Slides.

Template Slides Menu

When you insert any of the template slides, a chart of the default type (specified in the Settings) is 
inserted onto the slide. You can change the chart type on the inserted slide. Find information for 
changing chart types in Chart Slides on page 63.

Note You can change the default chart type to any 
of the six chart types using the Standard 
Chart Type setting, a presentation-level 
setting. Find more information on modifying 
settings in Response Device and Settings 
Management on page 157.
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Yes/No Slide

A Yes/No slide is used for a question with a yes or no response.The slide includes a generically 
worded question and answers. You may wish to edit the question to be more specific.

Yes/No Slide

True/False Slides

A True/False slide is used for a question with a true or false response. The slide includes a 
generically worded question and answers. You may wish to edit the question to be more specific.

True/False Slide
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Yes/No/Abstain Slide

A Yes/No/Abstain slide is used with a yes or no response with an option to abstain. The slide includes 
a generically worded question and answers. You may wish to edit the question to be more specific.

Yes/No/Abstain Slide

Likert Scale Slide

A Likert Scale slide is used for a statement with a response of varying levels of agreement or 
disagreement. There are 4-, 5-, and 7-level Likert Scale slides. The slide includes a generically 
worded question and answers. You may wish to edit the question to be more specific.

Likert Scale Slide
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Generic Slide

A Generic 2 to 10 answer slide allows you to insert a slide with up to 10 answers. The slide includes a 
generically worded question and answers. You may wish to edit the question and answers to be more 
specific.

Generic Slide

Icebreaker Slides

An Icebreaker slide is a slide with analogy or word scramble questions to get your audience involved 
in your TurningPoint presentation. Analogies are automatically generated, but you must supply a word 
for the word scramble.

The Analogy icebreaker slide creates a slide with an analogy question with one missing word. (For 
example, Titanic:Ship::Hindenburg:_?) It includes four choices, one of which is marked as the correct 
choice. If you include a Correct Answer Indicator, the correct choice will be revealed after polling. Find 
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more information on adding a Correct Answer Indicator in Add a Correct Answer Indicator on 
page 146.

Analogy Slide

The Word Scramble icebreaker slide asks you to input a word. Every other letter from the word is 
removed. (For example, COMPUTER becomes C_M_U_E_.) The removed letters are scrambled and 
appear as one of four choices. The correct choice is automatically marked. If you include a Correct 
Answer Indicator, the correct choice will be revealed after polling. Find more information on adding a 
Correct Answer Indicator in Add a Correct Answer Indicator on page 146.

Word Scramble Slide
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Special Slides
The final set of slides in the Insert Slides menu are special-purpose slides. There are several special-
purpose slides: ResponseCard RF Channel Slide, ResponseWare App Log-In, Fill in the Blank Slide, 
Essay Slide, Priority Ranking, Demographic Comparison, and Moment to Moment -2 to +2.

Special Slides Menu

ResponseCard RF Channel
Slide

The ResponseCard RF Channel Slide displays channel setting instructions for the ResponseCard 
Radio Frequency devices used by participants. 

The ResponseCard RF Channel Slide displays instructions that show participants how to set the 
channel on their response devices. Setting channels prevents frequency disruption between 
response devices and receivers if simultaneous presentations are occurring in adjacent rooms. 

Before you change the channel settings on the ResponseCard devices, you will need to change the 
channel on the receiver. There are 82 possible channels for the ResponseCard RF and 74 possible 
channels for ResponseCard XR, and the default channel is 41.
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Once the channel is set correctly on the receiver, display the ResponseCard RF Channel Slide early 
in your presentation so that participants can update the channel code on their devices.

ResponseCard RF Channel Slide

ResponseWare App Log-In
Slide

The ResponseWare App Log-In slide displays setup information for participants using ResponseWare 
App to send their responses.

The ResponseWare App Log-In slide displays the computer’s friendly name, IP address, and port 
number, which are required for participants submitting responses using ResponseWare App. If some 
of the participants in your audience will be using ResponseWare App, you should include this slide 
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early in your presentation so that they can successfully connect. Find more information on using 
ResponseWare App in Chapter 4: Response Device and Settings Management. 

ResponseWare App Log-In Slide

Fill in the Blank Slide

The Fill in the Blank slide contains a question region for you to pose a question. It does not contain an 
answer region or a chart, since the responses are in the form of text. ResponseCard IR, XL, and RF 
users are limited to numerical responses, but ResponseCard XR and ResponseWare App users may 
provide alphanumeric responses of varying lengths. 
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You can specify one or more keywords in the TurningPoint settings that the answer should contain to 
be considered correct (for reporting and grading purposes). Find more information in Chapter 4: 
Response Device and Settings Management.

Fill in the Blank Slide

Essay Slide

The Essay slide contains a question region for you to pose a question. It does not contain an answer 
region or a chart, since the responses are in the form of text. ResponseCard IR, XL, and RF users are 
limited to numerical responses, but ResponseCard XR and ResponseWare App users may provide 
alphanumeric responses of varying lengths. 

Essay Slide
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Priority Ranking Slide

A Priority Ranking slide weighs participants’ choices and then ranks them accordingly.

Priority Ranking slides allow participants to respond to a question or poll multiple times. You select the 
number of responses (maximum of 10) allowed per participant. The participants’ responses are then 
weighted, with points assigned to each response. First choices are weighted with more points than 
second choices, second more than third, etc. 

By allowing participants to choose more than one option, you can see a more diverse range of their 
preferences. The Priority Ranking slide displays the weighted scores assigned to the answers based 
on participant responses. Find more information in Insert a Priority Ranking Slide on page 83.

Priority Ranking Slide

Demographic Comparison
Slide

A Demographic Comparison slide shows results based on certain demographic information.

The Demographic Comparison slide visually displays the results of a question based on certain 
demographic information obtained from the audience. For instance, you can insert a comparison slide 
that calculates how participants’ ages relate to the amount of television that they watch. To use a 
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Demographic Comparison slide you must first designate a slide as ‘Demographic.’ Find more 
information on Designate a Demographic Slide on page 90.

Demographic Comparison Slide

Moment to Moment Scoring

The Moment to Moment Scoring slide can be used to have participants rate something on a scale of -
2 to +2 at regular intervals over a period of time. The Moment to Moment Scoring slide contains a 
question region for the question and a chart that shows the average response at each polling interval 
and a curve connecting the values. Polling continues until you stop it by clicking on the slide.
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You can set the polling interval in seconds for a Moment to Moment Scoring slide in the TurningPoint 
settings using the Polling Cycle setting, a slide-level setting. Find more information about modifying 
settings in Response Device and Settings Management on page 157.

Moment to Moment Scoring Slide
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Insert Special Slides

Inserting some Special Slides differs from inserting Chart, Competition, Template, and other Special 
slides as outlined in Insert a Slide on page 57. These slides require additional information or changes 
to setting to function properly. 

This section describes how to:

• Insert a Priority Ranking Slide

• Insert a Demographic Comparison Slide

Insert a Priority Ranking Slide

You can insert a Priority Ranking slide to allow participants to respond multiple times to a question. 
The responses are then weighted and ranked accordingly.

You could use a Priority Ranking slide to find out what is most important to participants. You insert a 
Priority Ranking slide, select the number of responses you want to allow per participant, and then ask 
participants what is most important. You ask participants to enter their first choice as their first 
response, their second choice second, etc. Choices entered first are weighted more heavily.

For example: You create a slide with five possible answers. You allow three responses (choices) per 
participant where first the choice is worth ten points, the second nine, and the third eight. You have six 
participants providing responses. The first three participants select 5, 4, 3 as answers in that order. 
The second three participants select 1,2,3 as answers in that order. TurningPoint calculates the 
results as depicted in the table below.

Priority Ranking Calculation Sample

The table shows that despite participants selecting answers 1 and 5 as their first choice 3 times each, 
all six participants selected answer 3. This gives answer 3 a higher priority for the group as a whole.
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Step by Step Instructions To insert a Priority Ranking slide…

1 Navigate to the slide you 
would like the Priority 
Ranking slide to be inserted 
after.

2 Select Insert Slide from the 
TurningPoint toolbar.

The Insert Slide menu opens. 

Insert Slide Menu
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3 Select Priority Ranking. A dialog box opens asking how many responses you want to 
allow per participant.

Priority Ranking Dialog Box

4 Enter the number of 
responses you wish to allow 
per participant.

The default number of responses is set at 3. The maximum 
number of responses cannot be higher than 10. Find more 
information about changing the default number of responses in 
Chapter 4: Response Device and Settings Management.

5 Select OK. A new slide opens prompting you to enter question and answer 
text.

Priority Ranking Slide
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6 Enter the desired question 
and responses.

You can now poll participants and ask them to respond the 
selected number of times. Their responses are weighted and 
ranked: first responses weighted more than second, second 
more than third, etc.

Insert a Demographic Comparison Slide

The Demographic Comparison slide can be used to visually display the results of a question slide in 
terms of certain demographic information gathered from the audience. 

For example, you could use this slide to show how participants’ age groups influence the number of 
hours of television they watch per day. To do this, you first create a question slide asking participants 
what age group they fall under and then designate that slide as ‘Demographic.’ Next, poll participants 
by asking ‘How many hours or television do you watch a day?’ Finally, you insert a Demographic 
Comparison slide that provides percentages for how many hours of television each participant’s age 
group watches a day.

Demographic Comparison Slide

It’s important to remember that you must designate a slide as ‘Demographic’ in the Settings menu to 
be able to insert a Demographic Comparison slide. Find more information on designating a slide as 
‘Demographic’ in Designate a Demographic Slide on page 90.
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Step by Step Instructions To insert a Demographic Comparison slide…

1 Navigate to the slide you 
would like the Demographic 
Comparison slide to be 
inserted after.

2 Select Insert Slide from the 
TurningPoint toolbar.

The Insert Slide menu opens. 

Insert Slide Menu
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3 Scroll down the list and select 
Demographic Comparison.

The Demographic Comparison dialog box opens.

Demographic Comparison Dialog Box

4 Select a demographic slide 
from the first drop-down 
menu.

Any slides you have designated as ‘Demographic’ are included 
in the menu. Find more information on designating a slide as 
‘Demographic’ in Designate a Demographic Slide on page 90.

5 Select a question slide to link 
with the demographic slide 
from the second drop-down 
menu.

You must choose both a demographic slide and a question 
slide.

6 Select OK. The Demographic Comparison slide is inserted displaying the 
demographic results in a chart. This slide creates its title based 
on the question slide.
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Modify Slides

TurningPoint slides are simply ordinary PowerPoint slides with extra features, so you can use and 
customize them as you would an ordinary PowerPoint slide. You can reorder slides, move objects, 
add text and pictures, apply fonts and color schemes, and use animation. Find more information in 
your PowerPoint documentation.

You can also modify the features TurningPoint adds to your slides. You can change chart types and 
colors. Find more information in Chart Slides on page 63 and in Change Chart Colors on page 120. 
You can use pictures for answers. Find more information in Create Picture Slides on page 118. And 
you can add a Correct Answer Indicator Find more information in Add a Correct Answer Indicator on 
page 146.

This section describes how to: 

• Designate a Demographic Slide

• Change Chart Types

• Enable Zero-based Polling

• Identify a Correct Answer from the Settings Window

• Identify a Correct Answer on a TurningPoint Slide

• Use Keywords for Fill in the Blank Slides

• Set Point Values from the Settings Window

• Set Point Values on a TurningPoint Slide

• Clear Answer Values from the Settings Window

• Clear Answer Values on a TurningPoint Slide

• Use Speed Scoring

• Create Picture Slides

• Change Chart Colors

• Make a PowerPoint Slide Interactive by Inserting a Chart

• Disable Auto Scale in Charts

Note Chart settings will retain any modifications 
you make, even after you add or remove 
answers on the modified chart slides.
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Designate a Demographic Slide

You can designate a slide as demographic to see how a certain group in your audience responds to 
certain questions. Slides designated as Demographic can be used in conjunction with Demographic 
Comparison Slides or Demographic Reports. Find more information on Insert a Demographic 
Comparison Slide on page 86 and on Demographic Reports on page 361.

Step by Step Instructions To designate a slide as ‘Demographic’...

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens.

Settings Window

2 Select the slide you want to 
designate as Demographic 
from the Settings Hierarchy.

The available settings for the slide display in the right pane of 
the window. 
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3 Under the Misc settings, 
select Demographic.

A drop-down menu opens.

Settings for Demographic Slide

4 Select True.

5 Select Done. Your slide is now a Demographic slide.

Change Chart Types

You can change the type of chart on a TurningPoint slide using the Insert Object menu.

Step by Step Instructions To change a chart’s type…

1 Navigate to the TurningPoint 
slide in your presentation on 
which you would like to 
change the chart.
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2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

Insert Object Menu

3 Select Charts to display the 
Charts submenu.

Insert Object: Chart Selection

4 Select the type of chart you 
would like to appear on the 
slide.

When you select the chart type, TurningPoint changes the chart 
on your slide to match the type.
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Enable Zero-based Polling

By default, answers are numbered 1-10, but you can change the settings to enable answers to be 
numbered 0-9 for zero-based polling. 

Step by Step Instructions To enable Zero-Based Polling...

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens.

Settings Window

2 Select Presentation or a 
specific Slide from the 
Settings Hierarchy.

Selecting a slide affects the currently selected slide. Selecting 
Apply All button affects all of the slides in the presentation. 

Note You will need to select the All Settings to 
reveal the Zero-Based Polling Option for the 
Presentation.
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3 Under the Misc settings, 
select Zero-Based Polling.

A drop-down menu opens to the right.

Settings Window: Enable Zero-Based Polling

4 Use the drop-down menu to 
select True.

Your answers are now numbered 0 to 9. 

Identify a Correct Answer from the Settings Window

You can specify whether answers in your TurningPoint slides should be considered correct or 
incorrect from the Settings window. By setting answer values, you can show the correct answer after 
polling with a Correct Answer Indicator. Find more information in Add a Correct Answer Indicator on 
page 146 or by coloring the chart to indicate correct and incorrect answers (find more information in 
Change Chart Colors on page 120).

You can set keywords for fill in the blank questions. If a response contains the keyword, it will be 
considered correct if that Answer Value has been set to correct. Find more information in Use 
Keywords for Fill in the Blank Slides on page 99.

Note To enable Zero-Based Polling for the entire 
presentation, you will need to select “Apply 
All.”
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You can identify a correct answer to a question from the Settings window. By default, answers marked 
Correct have a point value of 100 points, and answers marked Incorrect have a point value of 0 points 
for the purposes of scoring and competition. Find information about assigning specific point values to 
answers in Set Point Values from the Settings Window on page 102 or Set Point Values on a 
TurningPoint Slide on page 108.

Step by Step Instructions To mark an answer correct from the Settings window…

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens.

Settings Window

2 From the Settings Hierarchy, 
select the slide on which you 
would like to identify a correct 
answer.
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3 Select the Answer you want 
to identify as correct.

The settings for that answer display in the right pane of the 
window.

Settings Window: Answer Settings

4 Select Correct from the 
Answer Value drop-down 
menu.

Settings Window: Select Correct
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TurningPoint sets the selected answer as Correct and 
automatically sets all other answers on that slide as Incorrect.

You can have more than one correct answer on a slide by 
repeating these steps on another answer.

You can change an answer you marked as Correct to Incorrect 
by repeating these steps and selecting Incorrect from the drop-
down menu.

Identify a Correct Answer on a TurningPoint Slide

You can specify whether answers in your TurningPoint slides should be considered correct or 
incorrect. By setting answer values, you can show the correct answer after polling with a Correct 
Answer Indicator, or by coloring the chart to indicate correct and incorrect answers. Find more 
information in Add a Correct Answer Indicator on page 146 and Change Chart Colors on page 120.

You can set keywords for fill in the blank questions. If a response contains the keyword, and that 
keyword has been set to be the Correct Answer Value, it will be considered correct. Find more 
information in Use Keywords for Fill in the Blank Slides on page 99.

You can identify a correct answer to a question on a TurningPoint slide. By default, answers marked 
Correct have a point value of 100 points, and answers marked Incorrect have a point value of 0 points 
for the purposes of scoring and competition. (Find information about assigning specific point values to 
answers in Set Point Values from the Settings Window on page 102 or Set Point Values on a 
TurningPoint Slide on page 108.)

Note You can also set the Answer Value to Correct 
or Incorrect Answer Value from the slide. 
Find more information in Identify a Correct 
Answer on a TurningPoint Slide on 
page 97.
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Step by Step Instructions To mark an answer correct…

1 Navigate to the slide on 
which you want to mark a 
Correct Answer.

2 Right-click on the picture (for 
a picture slide) or the number 
of the answer (for all other 
slides).

A Contextual menu opens. Observe the Set as Correct and Set 
as Incorrect options at the bottom of this menu.

Contextual Menu
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3 Select Set as Correct from 
the Contextual menu.

TurningPoint sets the selected answer as Correct and 
automatically sets all other answers on that slide as Incorrect.

You can have more than one correct answer on a slide by 
repeating these steps on another answer.

You can change an answer you marked as Correct to Incorrect 
by repeating these steps and selecting Set as Incorrect from the 
Contextual menu.

Use Keywords for Fill in the Blank Slides

Fill in the Blank slides, by their nature, do not have enumerated answers. You can, however, specify 
that responses to a Fill in the Blank slide be counted as correct if it contains a certain word or words—
a “keyword.”

Note You can also set the Correct or Incorrect 
value in the Answer Value setting, a slide-
level setting for each answer. Find more 
information about modifying settings in 
Response Device and Settings 
Management on page 157.
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Step by Step Instructions To use keywords…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The Settings window opens.

Settings Window

2 If it is not already selected, 
select the slide from the 
Settings Hierarchy on which 
you would like to assign 
keywords. 
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3 Under the Misc settings, 
select Keywords.

Settings Window: Keywords

4 Enter the word(s) to include 
as keywords in the space 
provided.

Separate multiple keywords with semicolons. Responses 
containing any of the keywords will be counted as correct if that 
keyword has been set as the Correct Answer Value.

5 Select the Done button in the 
Settings window (settings are 
automatically saved).

Note The Keywords setting will only be displayed if 
you select a Fill in the Blank or Essay slide. 
Although you can assign keywords for Essay 
slides, keywords are only considered for Fill 
in the Blank slides for reporting and grading 
purposes.
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Set Point Values from the Settings Window

The answer values are used to compute the scores in the summary slides for competitions. 
Additionally, they are available for generating graded reports, scoring reports and others available in 
Turning Reports. Find more information in Reports on page 351.

You can set the point value for an answer in the range of negative 10,000 through 10,000. An answer 
set as Correct has a default point value of 100. An incorrect answer has a default point value of 0. 

You can assign different point values to different answers (if one answer should be awarded more 
than another, for example).

You can change the default point value settings for both correct and incorrect answers at the 
Presentation or Slide-level from the Settings window. Additionally, you could enable participants to 
receive positive points even if they answer incorrectly. Conversely, you can enable participants to 
receive negative points for correct answers in the same way. 

You can identify a correct or incorrect answer by following the instructions in Identify a Correct 
Answer from the Settings Window on page 94 or Identify a Correct Answer on a TurningPoint 
Slide on page 97. 

Step by Step Instructions To set a point value for an answer…

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens.

Settings Window
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To assign the same point values to the whole presentation, go 
to step 2. To assign point values to a specific slide, go to step 3.

2 To assign the same point 
values to the whole 
presentation:

a Select Presentation from 
the Settings Hierarchy.

The available presentation settings display in the right 
pane of the window. 

Settings Window: Presentation Settings
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b Under the Misc settings, 
select Correct Point Value.

A text box opens allowing you to enter a point value for 
correct answers. The point value can range from negative 
10,000 through 10,000.

Settings Window: Correct Point Value

c Enter the correct point 
value.

d Press the Enter key. TurningPoint sets the point value for all slides you create 
in the future.

To set incorrect point values, go to step e. If you are done 
setting point values go to step 4.

Note Select the Apply All button to set the point 
value for all existing slides in your 
presentation.
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e Under the Misc settings, 
select Incorrect Point 
Value.

A text box opens allowing you to enter a point value for 
incorrect answers.

Settings Window: Incorrect Point Value

f Enter the incorrect point 
value.

g Press the Enter key. TurningPoint sets the point value for all slides you create 
in the future.

To set point values for a specific slide go to step 3. 
Otherwise go to step 4.

Note Select the Apply All button to set the point 
value for all existing slides in your 
presentation.
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3 To assign individual point 
values to a specific slide,

a Select the slide from the 
Settings Hierarchy.

The available slide settings display in the right pane of the 
window. 

Settings Window: Slide Settings

b Under the Misc settings, 
select Correct Point Value.

A text box opens allowing you to enter a point value for 
correct answers. The point value can range from negative 
10,000 through 10,000.

Settings Window: Correct Point Value
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c Enter the correct point 
value.

d Press the Enter key. The correct point value is set. To set incorrect point 
values, go to step e. If you are done setting point values 
go to step 4.

e Under the Misc settings, 
select Incorrect Point 
Value.

A text box opens allowing you to enter a point value for 
incorrect answers. The point value can range from 
negative 10,000 through 10,000.

Settings Window: Incorrect Point Value

f Enter the incorrect point 
value.

g Press the Enter key. The incorrect point value is set. 

Repeat step 3 for each slide on which you want to assign 
individual point values. If have finished setting point 
values go to step 4.

You can change the point value by repeating these steps 
on the same slide and entering a new point value.

Note You can also set the point value on a 
TurningPoint slide. Find more information in 
Set Point Values on a TurningPoint Slide 
on page 108.
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4 Select Done. Use speed scoring to award points for answers proportionally to 
fastest responders on an individual basis or in team 
competitions. Find more information in Use Speed Scoring on 
page 115.

Clear the point value for a particular answer or for all answers 
on the slide by following the instructions in Clear Answer 
Values from the Settings Window on page 111 or Clear 
Answer Values on a TurningPoint Slide.

5 Enter a point value.

Set Point Values on a TurningPoint Slide

Answer values are used to calculate individual and team scores from summary slides used during 
competitions. Additionally, the answer values are used in generating certain Reports. Find more 
information in Reports on page 351.

You can set a numerical point value for an answer in the range of negative 10,000 through 10,000. An 
answer set as Correct has a default point value of 100. An incorrect answer has a default point value 
of 0. 

You can assign different point values to different answers (if one answer should be awarded more 
than another, for example).

You can change the default point value for both correct and incorrect answers. Additionally, you could 
enable participants to receive positive points even if they answer incorrectly. Conversely, you could 
enable participants to receive negative points if they answer correctly. Find more information in Set 
Point Values from the Settings Window on page 102.

Note If you have assigned negative points to a 
correct answer or positive points to an 
incorrect answer, use the Point Value 
reports. The Percentage Reports treat the 
correct answers with negative point values 
as incorrect answers and incorrect answer 
with positive point values as correct answers.



TurningPoint User Guide 109

Modify Slides

You can identify a correct or incorrect answer by following the instructions in Identify a Correct 
Answer from the Settings Window on page 94 or Identify a Correct Answer on a TurningPoint 
Slide. 

Step by Step Instructions To set a point value for an answer…

1 Navigate to the slide on 
which you want to set point 
values.

2 Right-click on the picture (for 
a picture slide) or the number 
of the answer (for all other 
slides).

A Contextual menu opens. Observe the Set Point Value option 
at the bottom of this menu.

Contextual Menu
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3 Select Set Point Value from 
the Contextual menu.

A dialogue box opens.

Point Value Dialog Box

4 Enter a point value in the 
space provided and select 
the OK button.

TurningPoint sets the point value for the selected answer.

You can set the point value for another answer by repeating 
these steps on another answer.

You can change the point value you set by repeating these 
steps on the same answer and entering the new point value.

Use speed scoring to award points for answers proportionally to 
fastest responders on an individual basis or in team 
competitions. Find more information in Use Speed Scoring on 
page 115.

Clear the point value for all answers in a presentation by 
following the instructions in Clear Answer Values from the 
Settings Window on page 111. You can clear the point value 
for a particular answer or for all answers on the slide by 
following the instructions in Clear Answer Values on a 
TurningPoint Slide on page 113.

Note You can also set the point value in the 
Settings window. Find more information in 
Set Point Values from the Settings Window 
on page 102.



TurningPoint User Guide 111

Modify Slides

Clear Answer Values from the Settings Window

TurningPoint enables you to reset answer values to default from the Settings window. Selecting this 
option affects only slides created after you have performed the steps outlined below. Clearing answer 
values from any existing slides must done from the TurningPoint slide. Find more information on 
resetting individual answers in Clear Answer Values on a TurningPoint Slide on page 113.

Step by Step Instructions To clear the answer values for a presentation…

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens.

Settings Window
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2 Select Presentation from the 
Settings Hierarchy.

The available settings display in the right pane of the window 
and the Restore default presentation settings button displays 
under the Settings Hierarchy.

Settings Window: Restore Default Presentation Settings

3 Select the Restore default 
presentation settings button.

A dialog box opens warning that all settings will be restored 
back to the default state.

Restore Default Presentation Settings Warning

4 Select Yes to clear answer 
values. 

TurningPoint resets all of your answer values to the default 
values. 

Note This only resets the answer values for all 
slides you create in the future. Find more 
information on resetting answer values for all 
existing slides in Clear Answer Values on a 
TurningPoint Slide on page 113.
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Select No if you do not wish to reset all of the settings back to 
the default state.

Clear Answer Values on a TurningPoint Slide

If you wish to reset answer values, you can clear the value from one or all answers.

Step by Step Instructions To clear the values for an answer…

1 Navigate to the slide on 
which you want to clear 
answer values.
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2 Right-click on the picture (for 
a picture slide) or the number 
of the answer (for all other 
slides) for which you would 
like to clear the value, or any 
answer on that slide if you 
would like to clear all values.

A Contextual menu opens. Observe the Clear Answer Value 
and Clear All Answer Values options at the bottom of this menu.

Contextual Menu

3 Select one of the following 
from the Contextual menu:

• Clear Answer Value - 
clears the value for the 
selected answer only.

The answer value for the selected answer is set to No 
Value if no other answer is set to Correct. The Answer 
Value is set to Incorrect if there is another answer that is 
set to correct.
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• Clear All Answer Values - 
clears all answer values 
for the slide.

TurningPoint sets the answer values for all answers on 
the slide to No Value.

Find information for setting Correct or Incorrect values in 
Identify a Correct Answer from the Settings Window on 
page 94 or Identify a Correct Answer on a TurningPoint 
Slide on page 97.

Find information for setting point values in Set Point 
Values from the Settings Window on page 102 or Set 
Point Values on a TurningPoint Slide on page 108.

Use Speed Scoring

Speed scoring awards points proportionally based on how quickly a participant responds. Any slide 
with correct or point value answers marked can be used for speed scoring. Speed scoring calculates 
points based on when polling opens and closes or the length of a countdown when a Countdown 
Indicator is used.

If you use speed scoring without a Countdown Indicator, a participant receives all the points for an 
answer when responding correctly after polling opens. If the participant does not select an answer 
before polling closes, they receive no points. If the participant responds immediately after polling 
opens, the participant receives all points for a correct answer. If the participant answers correctly at 
any other time, TurningPoint proportionally scales the points based on the amount of time that polling 
was open. If polling was open for 10 seconds, a response received at 5 seconds is awarded half 
(5/10) the points.

If you use speed scoring with a Countdown Indicator, a participant receives all the points for an 
answer when responding correctly before or as soon as the countdown begins. When the countdown 
begins, TurningPoint proportionally scales the points awarded by the amount of time remaining. In a 
10-second countdown, a response with 5 seconds remaining is awarded half (5/10) the points. 

Below are two examples. Both examples assumes that polling remained open for ten seconds or a 
Countdown Indicator set at ten seconds was used.

Note You can clear an answer value from the 
Settings window. Find more information 
about modifying settings in Clear Answer 
Values from the Settings Window on 
page 111.
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Example 1: Answer A is given a point value of 10 points. When polling opens, if the participant selects 
answer A immediately they will receive 10 points. As time progresses, the point value decreases. If 
the participant selects answer A with 5 seconds left, they receive 5 points. If the participant does not 
select an answer before polling closes or the timer hits zero they receive no points.

Example 2: Answer B is given a point value of -10 points. When polling opens, if the participant 
selects answer B immediately they will receive -10 points. As the countdown timer counts down from 
10, the point value increases. If the participant selects answer B with 5 seconds left, they receive -5 
points. If the participant does not select an answer before polling closes or the timer hits zero they 
receive no points.

Before You Begin

To use speed scoring, you should set points for one or more answers on the slide. Find information on 
setting points in Set Point Values from the Settings Window on page 102 or Set Point Values on a 
TurningPoint Slide on page 108.

Step by Step Instructions To use speed scoring…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The Settings window opens. 

Settings Window
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2 If it is not already selected, 
select the slide on which you 
would like to enable speed 
scoring from the Settings 
Hierarchy.

3 Select Speed Scoring under 
the Misc settings. 

A drop-down menu opens.

 Settings Window: Speed Scoring

4 Select True from the menu to 
enable speed scoring.

• Select False to disable 
speed scoring.

5 From the Settings window, 
select the Done button 
(settings are saved 
automatically).
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Create Picture Slides

Instead of using textual answers in the answer region, you can use pictures. This is useful if you pose 
a question with visual responses or where a visual aid will help the audience choose.

Step by Step Instructions To create a picture slide…

1 Create a TurningPoint slide. The text in the answer region will be replaced by pictures. 
Therefore, it is recommended that you use descriptive words or 
phrases for the answer text in the answer region because this 
text will still be used for the chart labels (answer aliases) and 
answer text in settings and reports. 

Find more information on creating a slide in Insert a Slide on 
page 57.

2 Insert pictures to use as 
answers using the options in 
PowerPoint’s Insert > Picture 
menu.

Insert one picture for each answer.

Find more information on inserting pictures in PowerPoint’s 
online help.

3 Resize and arrange the 
pictures the way you want 
them to appear on the slide.

Select and drag the picture to reposition it. Resize the picture 
using the Format Picture Command. Find more information in 
PowerPoint’s online help.

Note Since you will be using pictures as answers, 
the horizontal and offset charts will not align 
correctly with the answers. Use a vertical, 3D 
pie, distributed pie, or doughnut chart. Find 
more information in Types of Slides on 
page 62.
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4 To order the pictures 
correctly with the answers, 
follow these steps:

a Ensure that no objects on 
the slide are selected by 
clicking outside the slide.

b Select the picture that 
corresponds to the first 
answer by clicking on it.

You can tell that the picture is selected when the resize 
handles are shown on its sides and corners.

c Select the picture that 
corresponds to the second 
answer by holding the 
Control key on your 
keyboard and clicking on 
the picture.

Now both the first and second picture are selected.

d Repeat step c for each 
additional picture until you 
have selected one for each 
answer.

5 Select the Convert to Picture 
Slide button from the 
TurningPoint toolbar. 

Convert Picture Slide Button

When you select the Convert to Picture Slide button, the answer 
region is hidden and the pictures are enumerated with a label, 

Note You may include pictures on your slide that 
are not associated with one of the answers 
(for decoration or illustration). Do not select 
these pictures.



120 Turning Technologies

Chapter 3: Creating and Saving Slides

and the chart answers are updated with the answers you 
assigned them.

Picture Slide

After you convert the answers to pictures, you can resize and 
arrange the pictures if you need to adjust them.

Additionally, you can identify a correct answer or set point 
values. Find more information in Identify a Correct Answer 
from the Settings Window on page 94 or Identify a Correct 
Answer on a TurningPoint Slide on page 97 and Set Point 
Values from the Settings Window on page 102 or Set Point 
Values on a TurningPoint Slide on page 108.

Change Chart Colors

The colors used by charts are defined in the TurningPoint settings. By default, the charts take on the 
colors defined in your PowerPoint presentation’s color scheme. 

Note Chart settings will retain any modifications 
you make, even after you add or remove 
answers on the modified chart slides.
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Step by Step Instructions To change chart colors…

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens.

Settings Window

2 Select the All Settings radio 
button.

The Chart Color settings display in the right pane of the window.

Settings Window: All Settings
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3 Select Presentation or a Slide 
from the Settings Hierarchy 
to specify whether you’d like 
to make changes to chart 
colors on the presentation-
level or slide-level.

The level at which you change the settings controls which slides 
are affected:

• Making changes at the presentation-level affects all 
slides you create in the future.

• Making changes on the slide-level affects only the slide 
you select.

If you make changes on the slide-level, you must select a 
specific slide from the Settings Hierarchy.

4 Locate the Chart Colors 
setting in the Chart Settings 
group and select it.

A drop-down menu opens. 

Chart Colors Setting

5 Select a value for the Chart 
Colors setting.

There are three options:

Note You must select the Apply All button to 
change the chart colors for all existing slides 
in your presentation.
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• Color Scheme - uses the color scheme of your 
PowerPoint presentation.

• User Defined - uses ten user-defined colors.

• Correct Incorrect - uses two user-defined colors, one for 
correct answers and one for incorrect. (The default colors 
for correct and incorrect are green and red respectively.) 

Note When Color Scheme is selected, PowerPoint 
reverses the color order for Horizontal and 
Offset Charts. Example: If your color scheme 
has Light Blue, Blue, Aqua, and Green with 
Light Blue as the first color to be displayed 
and Green as the last, PowerPoint will 
display the colors in reverse for Horizontal 
and Offset Charts. Green is the first color 
displayed and Light Blue is the last.
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6 If you chose to use User 
Defined or Correct Incorrect, 
specify the colors in the 
Settings Window Chart 
Settings by completing the 
following steps:

Settings Window Chart Settings

a Select one of the colors 
labeled 1–10 or Correct 
and Incorrect.

A grid of 40 color swatches opens.

Color Swatches

b Select a color from the 
swatches.

The grid closes and TurningPoint assigns the color.

To change all colors back to their defaults, select the 
Defaults button.

c Repeat steps a–b for all 
colors you would like to 
change.
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7 Select the Done button 
(settings are automatically 
saved).

If you made changes on a presentation-level, any new slides 
you create will reflect the new colors. 

If you made changes to the slide-level setting, the slide you 
selected will reflect the new colors.

Make a PowerPoint Slide Interactive by Inserting a Chart

You can make an ordinary PowerPoint slide interactive by adding a chart to a slide that already has a 
question and a list of answers, or by creating a PowerPoint slide with a title and a bulleted or 
numbered list. 

When you convert the slide to a TurningPoint slide using the following instructions, the title will 
become the question and the bulleted or numbered list will become the list of answers. You can 
include up to ten items in the list. The question/title and the list of answers/numbered list must be in 
two separate boxes in order for the conversion to work properly.

Step by Step Instructions To convert a PowerPoint slide to an interactive slide…

1 Navigate to the PowerPoint 
slide in your presentation that 
you would like to convert to a 
TurningPoint slide.

Note You must have selected the Apply All button 
in step 3 to change the chart colors for all 
existing slides in your presentation.



126 Turning Technologies

Chapter 3: Creating and Saving Slides

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

Insert Object Menu

3 Select Charts. A submenu opens and displays the list of available charts.

Insert Object: Chart Selection

4 Select a chart to add to the 
slide.

When you select the chart to be added, TurningPoint converts 
the title of your slide to the question, the bulleted or numbered 
list to the answers, and adds the chart to the slide. 

You now have a functioning TurningPoint slide.
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Find more information on chart types in Chart Slides on 
page 63.

Disable Auto Scale in Charts

When you insert a slide in TurningPoint, vertical charts are set to auto scale according to their 
percentages. In some cases, the vertical charts do not display polling results proportionately. You can 
make vertical charts display on a proportionate scale by disabling the Auto Scale Charts setting.

For example: You have a vertical chart with response values of seventy percent and thirty percent 
with Auto Scale Charts enabled. The size of the vertical bars will not vary much. The bar for seventy 
percent will not be much larger than the bar for thirty percent. If you have Auto Scale Charts disabled, 
the vertical bars will look more realistic. The bar for seventy percent will be much larger than the bar 
for thirty percent.

Note The bulleted or numbered answer list is re-
numbered according to your TurningPoint 
settings. 
You can modify the numbering scheme for 
answers in the Answer Bullet Format setting, a 
presentation-level setting. Find more 
information about modifying settings in 
Response Device and Settings Management 
on page 157.
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Step by Step Instructions To disable Auto Scaling...

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The Settings window opens.

Settings Window

2 Select Presentation from the 
Settings Hierarchy.

3 Under the Chart Settings, 
select Auto Scale Charts.

A drop-down menu opens.

Auto Scale Setting
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4 Select False to disable Auto 
Scale.

Charts will not Auto Scale after this setting has been changed. 

• Select True to enable Auto 
Scale.
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Add Objects

TurningPoint offers several static and interactive objects you can add to your slides: Answer Now 
prompts, Countdowns, Response Counters, Response Tables, Correct Answer Indicators, Text 
Message prompts and Statistics Indicators. 

Insert Object Menu

This section describes how to:

• Add an Answer Now Indicator 

• Add a Countdown Indicator

• Add a Countdown Sound to a Countdown Indicator

• Add a Response Counter

• Add a Response Table

• Add a Correct Answer Indicator

• Add Text Messaging

• Add Statistics Indicators
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Add an Answer Now Indicator

An Answer Now Indicator gives the audience a visual cue that the slide is a TurningPoint slide to 
which they have the opportunity to respond. An Answer Now Indicator appears during a presentation 
when polling opens and disappears when polling is closed. 

Answer Now Indicators are available in 12 styles.

Answer Now Indicators

Note You can specify that an Answer Now 
Indicator should appear automatically on 
each TurningPoint slide that you create using 
the Answer Now setting, a presentation-level 
setting. Find more information about 
modifying settings in Response Device and 
Settings Management on page 157.

 Bevel  Left Explosion

 Right Explosion  Scroll

 Bolt  Prompt

 Moon  Sun

 Banner  Marquis

 Smiley  Twilight
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The Answer Now Indicator can be moved and resized like an ordinary PowerPoint object. You can 
change the text “Answer Now” by selecting the text to edit it.

Step by Step Instructions To add an Answer Now Indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add 
an Answer Now Indicator.

2 From the TurningPoint 
toolbar, select Insert Object.

The Insert Object menu opens.

Insert Object Menu
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3 Select Answer Now. A submenu opens displaying the available Answer Now 
Indicators.

Answer Now Submenu

4 Select an Answer Now 
Indicator.

TurningPoint places the Answer Now Indicator on your slide.

You can move, resize, or change the text of the Answer Now 
Indicator to better fit your slide. You can also delete the Answer 
Now Indicator if you no longer want it to appear on the slide.

To replace an existing Answer Now Indicator with a different 
type, simply repeat these steps. The current Answer Now 
Indicator will be replaced with the new one you select.

Note You can change the default text of Answer 
Now Indicators when they are added to a 
page from “Answer Now” to any text of your 
choosing using the Answer Now Text setting, 
a presentation-level setting. Find more 
information about modifying settings in 
Response Device and Settings 
Management on page 157.
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Add a Countdown Indicator

A Countdown Indicator gives the audience a visual cue that polling for a question is about to close. 
The Countdown Indicator shows the number of seconds remaining and counts down to zero. A 
countdown can have a maximum length of 999 seconds. The indicator appears during a presentation 
when you advance the slide during polling. When the countdown expires, the Countdown Indicator 
disappears and polling is automatically closed.

You can specify that a Countdown Indicator should appear automatically on each TurningPoint slide 
that you create using the Countdown setting, a presentation-level setting. Find more information 
about modifying settings in Response Device and Settings Management on page 157.

Countdown Indicators are available in 11 styles.

Countdown Indicators

*

 Ball Drop  Letter

 Clock  Hourglass

 Timer  Candle

 Sunset  No Vote

 Logo  Second Hand

 Gemstone
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Step by Step Instructions To add a Countdown Indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add 
an Countdown Indicator.

2 From the TurningPoint 
toolbar, select Insert Object.

The Insert Object menu opens.

Insert Object Menu
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3 Select Countdown. A submenu opens displaying the available Countdown 
Indicators.

Countdown Indicator Submenu

4 Select a Countdown 
Indicator.

TurningPoint places the Countdown Indicator on your slide.

You can move or resize the Countdown Indicator to better fit 
your slide. You can also delete the Countdown Indicator if you 
no longer want it to appear on the slide.

Note You can change the length of the countdown 
in seconds for a particular slide or for all 
slides using the Countdown Seconds setting, 
a setting available on both the presentation-
level and the slide-level. Find more 
information about modifying settings in 
Response Device and Settings 
Management on page 157.
You can also change the length of the 
countdown by double-clicking, single 
clicking, or right clicking on the Countdown 
Indicator on the slide. A dialog box opens 
prompting you to ‘enter a value 1-999 for the 
Countdown time limit.’
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To replace an existing Countdown Indicator with a different 
type, simply repeat these steps. The current Countdown 
Indicator will be replaced with the new one you select.

You can also use Countdown Indicators in competitions to 
award points based on how quickly a participant responds. Find 
more information in Use Speed Scoring on page 115.

Add a Countdown Sound to a Countdown Indicator

A Countdown Sound is a TurningPoint setting that allows you to add a sound file to your slide. The 
acceptable file extensions include: .aiff, .au, .mid, .midi., .mp3, .wav, and .wma. A Countdown Sound 
gives the audience an audible cue that polling for a question is about to close. The sound begins to 
play when you activate the Countdown Indicator. 

Your slide must have a Countdown Indicator to use a Countdown Sound. To add a Countdown 
Indicator see to Add a Countdown Indicator on page 134. 

Step by Step Instructions To add a Countdown Sound…

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens.

Settings Window
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2 Select the Settings tab.

3 From the Settings Hierarchy, 
select the slide to which you 
want to add a Countdown 
Sound.

Settings Window: Slide Settings

The available settings display in the right pane of the window. 
Find the Response Reminders Settings.

4 Select Countdown Sound. A dialog opens.

Settings Window: Countdown Sound
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5 Navigate to the folder where 
the sound file is located

Countdown Sound: Windows Dialog Box

6 Select the file name.

7 Select Open. TurningPoint lists the file path of the sound file in the right pane 
of the Settings window.

Countdown Sound File Path
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8 Select Done.

Add a Response Counter

A Response Counter keeps track of how many participants have submitted a response out of the total 
number of participants. A Response Counter appears during a presentation when polling opens and 
disappears when polling is closed.

Note If your presentation will be used on a 
different computers, ensure that the 
Countdown Sound (sound file) can be found 
on the presentation computer and that it has 
the same file path. Otherwise, the 
presentation computer will not be able to use 
your Countdown Sound. For example, if the 
file path for the Countdown Sound is 
C:\Documents and Settings\My 
Documents\Explosion.wav. You must ensure 
that the Countdown Sound is located at the 
same file path on the presenting computer.
You can also add a Countdown Sound to a 
Countdown Indicator by right-clicking on the 
Countdown Indicator and selecting Add 
Countddown Sound from the contextual 
menu that appears.
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Response Counters are available in six styles:

Response Counters

The Response Counter can be moved and resized like an ordinary PowerPoint object. 

Step by Step Instructions To add a Response Counter…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Response Counter.

*

 Flag Pole  Meter

 Bubble  Gauge

 Liquid  Tube

Note You can change whether the Response 
Counter displays the number or percentage 
of participants who have responded (or both) 
using the Response Counter Format setting, 
a presentation-level setting. Find more 
information about modifying settings in 
Response Device and Settings 
Management on page 157.
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2 From the TurningPoint 
toolbar, select Insert Object.

The Insert Object menu opens.

Insert Object Menu

3 Select Response Counter. A submenu opens displaying the available Response Counters.

Response Counter Submenu
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4 Select a Response Counter. TurningPoint places the Response Counter on your slide.

You can move or resize the Response Counter to better fit your 
slide. You can also delete the Response Counter if you no 
longer want it to appear on the slide.

To replace an existing Response Counter with a different type, 
simply repeat these steps. The current Response Counter will 
be replaced with the new one you select.

Add a Response Table

A Response Table keeps track of which participants have submitted a response. A Response Table 
appears during a presentation when polling opens and disappears when polling is closed. The 
Response Table shows each participant’s number, and a background color that changes when a 
response from the participant has been successfully received.

The Response Table is available in two types, fixed and rotating. A fixed table shows all the 
participants. A rotating table displays up to 40 participants at a time, and rotates through the list every 
few seconds. It shows participants 1–40, then 41–80, and so on. When it reaches the last participant, 

Note You can specify that a Response Counter 
should appear automatically on each 
TurningPoint slide that you create using the 
Response Counter setting, a presentation-
level setting. Find more information about 
modifying settings in Response Device and 
Settings Management on page 157.
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the next rotation starts again with 1. A rotating table takes up less space on your slide if you have 
more than 40 participants.

Response Table

You can move or resize the Response Table to better fit your slide. You can also delete the Response 
Table if you no longer want it to appear on the slide.

Before You Begin

If you are using a Response Table with a Participant List, you must record the Device ID for each 
participant in the list. If you do not, the Response Table will not display the participants without a 
Device ID recorded. 

Note You can specify the rotation interval in 
seconds for a rotating Response Table using 
the Rotation Interval setting, a presentation-
level setting. Find more information about 
modifying settings in Response Device and 
Settings Management on page 157.
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Step by Step Instructions To add a Response Table…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Response Table.

Insert Object Menu

2 From the TurningPoint 
toolbar, select Insert Object.

The Insert Object menu opens.

3 Select Response Table. A submenu opens displaying the available Response Tables.

Response Table Submenu

4 Select a Response Table. TurningPoint places the Response Table on your slide.

See above for information on the differences between fixed and 
rotating Response Tables.
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You can move the Response Table and change the font it uses 
to better fit your slide. You can also delete the Response Table 
if you no longer want it to appear on the slide.

To replace an existing Response Table with a different type, 
simply repeat these steps. The current Response Table will be 
replaced with the new one you select.

As an alternative to a Response Table, TurningPoint also offers 
the Response Grid, which is overlaid on your slide during a 
presentation and can be shown and hidden at your command. 
The Response Grid shows more information than a Response 
Table and does not take up space on your slide, but you must 
manually choose to display and hide it during your presentation. 
Find more information in View Polling Status on page 337.

Add a Correct Answer Indicator

A Correct Answer Indicator gives a visual cue to the audience to indicate the correct answer(s) after 
polling for a question is finished. A Correct Answer Indicator appears during a presentation when you 
advance the slide after displaying the chart.

A Correct Answer Indicator appears for each answer marked as Correct or for which a point value is 
specified. Find more information in Identify a Correct Answer from the Settings Window on 
page 94, Identify a Correct Answer on a TurningPoint Slide on page 97, Set Point Values from the 
Settings Window on page 102, or Set Point Values on a TurningPoint Slide on page 108.

Note You can specify that a Response Table 
should appear automatically on each 
TurningPoint slide that you create using the 
Response Table setting, a presentation-level 
setting. Find more information about 
modifying settings in Response Device and 
Settings Management on page 157.
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Correct Answer Indicators are available in seven styles.

Correct Answer Indicators

Step by Step Instructions To add a Correct Answer Indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Correct Answer Indicator.

*

 Rectangle  Checkmark

 Smiley Face  Star

 Arrow  Blinking Rectangle

 Custom Indicator
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2 From the TurningPoint 
toolbar, select Insert Object.

The Insert Object menu opens.

Insert Object Menu

3 Select Correct Answer 
Indicator.

A submenu opens displaying the list of available Correct 
Answer Indicators.

Correct Answer Indicator Submenu

4 Select a Correct Answer 
Indicator.

TurningPoint places the Correct Answer Indicator on your slide.
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You can delete the Correct Answer Indicator if you no longer 
want it to appear on the slide.

To replace an existing Correct Answer Indicator with a different 
type, simply repeat these steps. The current Correct Answer 
Indicator will be replaced with the new one you select.

Add Text Messaging

Text Messaging allows you to send messages to ResponseWare App users to reinforce the content 
and their participation.

 A Text Message appears as a small object on your slide, but when it is shown, it automatically sends 
a message that can be viewed on a ResponseWare App.

You can add more than one text message to a slide. For example, you might add a “Respond Now” 
message to send when polling opens and a “Time Is Up” message to send when polling closes. 

Step by Step Instructions To add a Text Message…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Text Message.

Tip Since Text Messages are objects on your slide, 
you can use PowerPoint’s animation features 
to time when they should be displayed. Find 
more information in PowerPoint’s online help.
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2 From the TurningPoint 
toolbar, select Insert Object.

The Insert Object menu opens.

Insert Object Menu

3 Select Text Message. A dialog box opens.

Text Message Dialog Box

4 Enter your message in the 
dialog box and select the OK 
button.

A speech balloon displays in the upper left corner of the slide. 
When TurningPoint is running the presentation session, this 
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symbol notifies the participants in the audience to check their 
ResponseWare Apps for a text message. 

Slide with Text Message

You may now alter the timing of the message using 
PowerPoint’s animation features. By default, the message is 
sent as soon as the slide is shown, Find more information in 
PowerPoint’s help file.

You can delete the Text Message object from the slide if you no 
longer want it to be sent. To add an additional Text Message, 
simply repeat these steps.

Add Statistics Indicators

Statistics Indicators allow you to reveal statistics about the responses after polling is closed.
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Statistics Indicators show a calculation after polling is closed based on the responses received. You 
can show the mean (average), median, standard deviation, and variance of the responses. The value 
of the statistic is revealed when the chart is displayed.

Statistics Indicators

Statistics are calculated based on the numerical value of the response (the number of the answer on 
the slide). Since the statistics are based on the number of answers, they are most useful for questions 
with an ordered scale of answers (such as a Likert scale).

Step by Step Instructions To add a Statistic Indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Statistic Indicator.
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2 From the TurningPoint 
toolbar, select Insert Object.

The Insert Object menu opens.

Insert Object Menu

3 Select Stats. A submenu opens displaying the available Statistic Indicators.

Statistics Submenu

4 Select a Statistic Indicator. TurningPoint places the Statistic Indicator on your slide.

You can move or resize the Statistic Indicator to make it better 
fit your slide. You can delete the Statistic Indicator if you no 
longer want it to appear on the slide.
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You can add additional Statistic Indicators to the same slide (up 
to all four types). Simply repeat these steps and select the 
additional Statistic Indicator you would like to place on the slide.
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Where Do I Go From Here?

This chapter has demonstrated how to create and customize TurningPoint slides for your 
presentation.

The next step in successfully using TurningPoint for an interactive presentation is to set up the 
hardware devices for participants to respond. Chapter 4: Response Device and Settings 
Management demonstrates this process. You only need to install the hardware devices one time on 
the computer you will use them with, unless you add or change the hardware devices.

If you have already installed hardware devices, the next step is to create a Participant List to keep 
track of the participants for your presentation. Chapter 5: Track Participants and Teams 
demonstrates this process.

If you already have a Participant List for the audience you will be presenting to, you are ready to 
conduct your presentation! Chapter 7: Run Presentations demonstrates this process.
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Response Device 
and Settings 
Management

This chapter discusses the installation and management of the Response Devices available for use 
by your audience. Additionally, this chapter describes the various settings available for customizing 
your presentation.
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Your audience responds to your interactive presentation using a response device. You can license 
response devices from Turning Technologies for use with TurningPoint. These response devices 
include:

Response Device Description

Responsive Innovations’ 
ResponseCard IR—a compact 
response device that uses infrared 
technology to send audience 
responses.

Responsive Innovations’ 
ResponseCard XL—a compact 
response device that uses infrared 
technology to send audience 
responses and allows for self-paced 
testing by letting students enter 
responses to many different 
questions on the card’s LCD then 
transmitting all the answers at once.

Responsive Innovations’ 
ResponseCard RF—a compact 
response device that uses radio 
frequency technology to send 
audience responses.
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TurningPoint also offers many settings you can use to customize the way your slides look and 
behave. You may notice that sections throughout this user guide mention settings that can have an 
effect on the tasks you perform with TurningPoint. 

Responsive Innovations’ 
ResponseCard XR —a compact 
response device that uses radio 
frequency technology to send 
audience responses and allows for 
self-paced testing by letting 
students enter responses to many 
different questions on the card’s 
multi-line LCD; then transmitting all 
the answers at once.

Turning Technologies’ 
ResponseWare App—a virtual 
keypad, installed on a personal 
computer, or Smart Devices, that 
takes advantage of a classroom 
network to send responses or 
control presentations. 

TurningTechnologies’ RemotePoll— 
a software program that allows 
remote and/or multi-site polling 
using an IP address. Participants 
using Response Device Receivers 
can use RemotePoll to connect to a 
host computer and transmit their 
responses to the presentation over 
the internet. Find more information 
about RemotePoll at 
www.turningtechnologies.com.

Response Device Description
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Recall the five steps to presentation success:

Five Steps to Success

This chapter covers the second step, connecting response devices with TurningPoint’s plug and play 
capabilities and managing your settings. 
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Users interact with your TurningPoint presentation using response devices that communicate through 
a response device receiver, or over a network or the internet. 

Response device receivers are connected directly to the computer that will be used to run the 
TurningPoint interactive presentation.This section includes instructions to install the device receivers.

The ResponseWare App response device software application allows users to participate with your 
presentation through an internal network. The ResponseWare App response software application has 
two versions: the client ResponseWare App and Presenter ResponseWare App. The client 
ResponseWare App allows participants to respond to and provide feedback about your presentation. 
The Presenter ResponseWare App enables the presenter to control the presentation from a computer 
on the same network. This section includes instructions to install the ResponseWare App software. 

This section describes how to:

• Install Infrared Response Device Receiver

• Install Radio Frequency Response Device Receiver

• Install the ResponseWare App Response Software
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Install Infrared Response Device Receiver

The ResponseCards IR and XL communicate with TurningPoint using infrared technology. The 
receiver accepts the signal produced by the individual ResponseCards and passes the response 
along to TurningPoint.

Infrared ResponseCard and Receiver

Before You Begin

The receiver must be installed on the machine that will be used to run the presentation.

Step by Step Instructions To install the infrared response device receiver…

1 Connect the device receiver 
to the USB port of the 
presentation computer.

Connect the USB Response Device Receiver to your computer. 
Windows detects the receiver and installs the proper drivers. 
The device is now ready for use.

Infrared Response Device Receiver
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2 Place the receiver in an 
unobstructed area at the front 
of the room.

The receiver operates on a “line of sight” and needs to be 
positioned so that it can receive the signal from the response 
devices. You may want to elevate the receiver so that it can be 
seen by everyone in the room.

Next Steps

Go to Response Device Management on page 176 to manage the settings for the response devices. 

The use of a Response Counter, Response Table or Response Grid will help to alert you of a non-
communicating Infrared response device. Find more information in Add a Response Counter on 
page 140, Add a Response Table on page 143, or View Polling Status on page 337.

Step by Step Instructions To Check Device Communication…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The Settings window opens. 

Settings Window

Note The effective range of an infrared device 
receiver is about 90 feet (27meters). You will 
need to install one receiver for every 80 
participants.
Use more than one receiver during your 
presentation if your room size or participant 
size exceeds these maximum specifications. 
Contact Turning Technologies for suggested 
receiver layout plans.
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2 Select the Polling Test tab. TurningPoint opens the Polling Test window. Use this window to 
verify that TurningPoint can receive responses from the 
devices.

Settings Window: Polling Test

3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. Magnify the responses by placing a check 
mark in the Magnify Values box.

Polling Test: Magnify Responses
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4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, Channel, and the key entry 
from each response device in the order in which they were 
tested. 

Polling Test: Response Device Test

5 Select the End Test button. TurningPoint ends Polling test.  

6 Select the Done button. The device communication check is now complete. 
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Install Radio Frequency Response Device Receiver

The ResponseCards RF and XR communicate with TurningPoint using a radio frequency. The 
receiver accepts the signal produced by the individual ResponseCards and passes the response 
along to TurningPoint.

Radio Frequency ResponseCard and Receiver

Before You Begin

The receiver must be installed on the machine that will be used to run the presentation.
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Step by Step Instructions To install the radio frequency response device receiver…

1 Connect the device receiver 
to the USB port of the 
presentation computer.

Connect the USB Response Device Receiver to your computer. 
Windows detects the receiver and installs the proper drivers. 
The device is now ready for use.

Radio Frequency Response Device Receiver

Next Steps

Go to Response Device Management on page 176 to manage the settings for the response devices. 

If an audience member’s device is not being accepted, check the device’s ability to communicate. 
Radio Frequency response devices provide on-screen confirmation that responses have been 
received. 

Note The effective range of most RF Receivers is 
about 200 feet (60 meters) and the Long 
Range Receiver is about 400 feet (120 
meters). A single receiver is sufficient for up to 
1000 ResponseCards, and a direct line of sight 
between the receiver and the ResponseCard is 
not necessary.
Use more than one receiver during your 
presentation if your room size or participant 
size exceeds these maximum specifications. 
Contact Turning Technologies for suggested 
receiver layout plans.
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Step by Step Instructions To Check Device Communication…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The Settings window opens. 

Settings Window

2 Select the Polling Test tab. TurningPoint opens the Polling Test window. Use this window 
verify that TurningPoint can receive responses from the 
devices.

Settings Window: Polling Test
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3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. Magnify the responses by placing a check 
mark in the Magnify Values box.

Polling Test: Magnify Responses

4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, Channel, and the key entry 
from each response device in the order in which they were 
tested. 

Polling Test: Response Device Test

5 Select the End Test button. TurningPoint ends Polling test. 

6 Select the Done button. The device communication check is now complete. 
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Install the ResponseWare App Response Software

The ResponseWare App group response software acts as a virtual response device. Audience 
members use the software from desktop or laptop computers or Smart Devices that are connected to 
the presentation computer using a wired or wireless network.

ResponseWare Apps exhibit the same response behavior as ResponseCards. If you are running a 
ResponseWare App and connect during a presentation, you can close and reopen the 
ResponseWare App and still have the same response Device ID.

ResponseWare App Response Device

Before You Begin

TurningPoint must be installed on computers that use the same network.

Step by Step Instructions To install and set up the ResponseWare App software on a 
PC…

1 Insert the ResponseWare 
App installation CD into your 
computer’s CD-ROM drive.

2 Run the ResponseWare App 
setup program.

Follow the instructions in the ResponseWare App setup wizard 
to install ResponseWare App on your desktop or laptop 
computer. The installation creates a ResponseWare App 
desktop icon and an entry in your computer’s Start > Programs 
menu.
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3 Double click on the 
ResponseWare App desktop 
icon to start the 
ResponseWare App 
software.

The Turning ResponseWare App window opens.

ResponseWare App Response Device

You need to configure ResponseWare App to enable it to 
communicate on the network.

4 On the Turning 
ResponseWare App window, 
select File > Select Host 
Computer.

The Select a Host Computer window opens.

ResponseWare App: Select A Host Computer
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5 Select the Add button. The Turning ResponseWare App dialog box opens and displays 
the friendly name setup prompt. 

ResponseWare App: Enter Friendly Computer Name

6 In the Turning 
ResponseWare App window, 
enter the host computer’s 
friendly name or IP address 
and select OK.

The Turning ResponseWare App dialog box displays the port 
number setup prompt.

ResponseWare App: Enter Port Number

7 In the Turning 
ResponseWare App window, 
enter the port number to be 
used for communication 
between the ResponseWare 
App and TurningPoint and 
select OK.

Turning ResponseWare App uses port 1001 by default. Enter a 
different number, if defined otherwise on the host computer.

The newly added host computer appears in the Select a Host 
Computer window.

8 In the Select a Host 
Computer window, select 
OK.

Turning ResponseWare App displays a dialog box asking to 
connect to the selected host.
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9 In the TurningPoint 
connection dialog box, select 
OK.

The Turning ResponseWare App window displays a message: 
Connected to mylaptop at 2:30:21 PM. 

The host computer’s friendly name (entered in step 6) and the 
time when you connected (as a result of completing this step) 
are displayed in place of the words above.

10 Repeat step 1-9 for each 
computer to be used as a 
response device.

Next Steps

Go to Response Device Management on page 176 to manage the settings for the response devices. 

If an audience member’s device is not being accepted, check the device’s ability to communicate. 
ResponseWare App response devices provide on-screen confirmation that responses have been 
received. 

Step by Step Instructions To Check Device Communication…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The Settings window opens. 

Settings Window
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2 Select the Polling Test Tab. TurningPoint displays the Polling Test window. Use this window 
to verify that TurningPoint can receive responses from the 
devices.

Settings Window: Polling Test

3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. Magnify the responses by placing a check 
mark in the Magnify Values box.

Polling Test: Magnify Responses
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4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, Channel, and the key entry 
from each response device in the order in which they were 
tested. 

Polling Test: Response Device Test

5 Select the End Test button. TurningPoint ends Polling test.  

6 Select the Done button. The device communication check is now complete. 
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Response Device Management

Each audience participant uses a device to respond to the questions asked during the presentation. 
TurningPoint supports a variety of response devices including infrared and radio frequency 
ResponseCards as well as networked laptop and desktop computers and laptops and desktops with 
internet access and Smart Devices and computers with internet access.

TurningPoint needs to know what types of response devices will be used before you run the 
presentation. Access the Response Device settings to confirm TurningPoint is configured to your 
needs. 

You may need to confirm your settings when you add new response devices and change the number 
of response devices to be used during a presentation session.

Additionally, you are able to test communication between TurningPoint and the response devices 
using the Polling Test found in settings.

This section describes how to:

• Add or Update Response Device Receivers

• Enable ResponseWare App

• Check Device Communication

• Identify the Number of Devices to be Used

Add or Update Response Device Receivers 

You may need to access the Response Device settings when you change the response device 
receivers. 

Before You Begin

You must have TurningPoint installed on the computer to be used for the presentations and response 
device receiver and ResponseCards at hand. 
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Step by Step Instructions

1 Connect the device receiver 
to the USB port of the 
presentation computer.

Connect the USB Response Device Receiver to your computer. 
Windows detects the receiver and installs the proper drivers. 
The device is now ready for use. 

Next Steps

If an audience member’s device is not being accepted, check the device’s ability to communicate. 
Find more information in Check Device Communication on page 180. Radio Frequency response 
devices provide on-screen confirmation that responses have been received. For infrared response 
devices, the use of a Response Counter, Response Table or Response Grid will help to alert you of a 
non-communicating device. Find more information in Add a Response Counter on page 140, Add a 
Response Table on page 143, or View Polling Status on page 337.

Enable ResponseWare App

Use the Response Device settings to enable ResponseWare App use with TurningPoint. 

Before You Begin

You must have TurningPoint installed on the computer to be used for the presentations and 
ResponseWare App installed on the computer to be used by participants.
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Step by Step Instructions To manage the response devices…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The Settings window opens. 

Settings Window

2 Select the Settings tab. 

3 Select Response Device 
from the Settings Hierarchy.

The available response device settings display in the right pane 
of the window.

Settings Window: Response Devices
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4 Enable the ResponseWare 
App.

a Find Enable 
ResponseWare App under 
the ResponseWare App 
settings.

b Select Enable 
ResponseWare 
App/RemotePoll.

A drop-down menu opens. 

Settings Window: ResponseWare App Settings

c Select True. TurningPoint enables the ResponseWare 
App/RemotePoll.

d Press the Enter key.

5 Select Done. Your devices are ready for use with your interactive 
presentation.

Note TurningPoint uses False as the default 
setting for Enable ResponseWare 
App/RemotePoll.
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Next Steps

If an audience member’s device is not being accepted, check the device’s ability to communicate. 
ResponseWare App response devices provide on-screen confirmation that responses have been 
received. 

Repeat this procedure when you need to change your ResponseWare App settings. Additionally, go 
to Identify the Number of Devices to be Used on page 183 when you need to make changes to the 
number of devices being used with your presentations.

Check Device Communication

You should test the communication between a device and TurningPoint if an audience member’s 
response is not being accepted during a live presentation. Radio Frequency and ResponseWare App 
response devices provide on-screen confirmation that responses have been received. For infrared 
response devices, the use of a Response Counter, Response Table or Response Grid will help to 
alert you of a non-communicating device.Find more information in Add a Response Counter on 
page 140, Add a Response Table on page 143, or View Polling Status on page 337.

Before You Begin

Ensure the device receiver is properly installed and the device to be tested is available.
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Step by Step Instructions To test for device communication…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. 

The Settings window opens. 

Settings Window

2 Select the Polling Test tab. TurningPoint displays the Polling Test window. Use this window 
to verify that TurningPoint can receive responses from the 
devices.

Settings Window: Polling Test
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3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. Magnify the responses by placing a check 
mark in the Magnify Values box.

Polling Test: Magnify Responses

4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, Channel, and the key entry 
from each response device in the order in which they were 
tested. 

Polling Test: Response Device Test

5 Select the End Test button. TurningPoint ends Polling test.  

6 Select Done. The device communication check is now complete. 
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Identify the Number of Devices to be Used

Access the Response Device settings whenever you need to change the number of expected 
devices. TurningPoint uses the number of expected devices when choosing Simulated Data as your 
input source or when using a Response Counter or Response Table without a Participant List.

Find more information on Response Counters in Add a Response Counter on page 140 and 
Response Tables in Add a Response Table on page 143.

Step by Step Instructions To increase or decrease the expected devices…

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens. 

Settings Window
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2 Select Response Device 
from the Settings Hierarchy.

The available response device settings display in the right pane 
of the window. 

Settings Window: Response Devices

3 Enter the number of expected 
response devices. 

a Find Expected Devices 
under the ResponseCard 
Misc settings.

Settings Window: Expected Devices
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b Select Expected Devices. A text box opens. 

c Enter the number of 
expected devices.

d Press the Enter key.

4 Select Done. The expected number of response devices has been updated.

Next Steps

Optionally, test your response device communication by selecting the Polling Test tab from the 
Settings window. Find more information in Check Device Communication on page 180.

Note You cannot exceed the number of licensed 
devices. For example, if you enter the number 
of expected devices as 60 in this region, but 
TurningPoint is licensed for 50 devices, only 50 
devices can be used during the presentation.
This does not apply to presenters with an 
unlimited license. They can use as many 
response devices as they choose.
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 Settings

TurningPoint allows you to view and modify various settings from the Settings window. To access the 
Settings window select Tools from the TurningPoint toolbar and settings. 

Tools > Settings
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You can adjust the settings in the Settings window:

Settings Window

The Settings window contains two tabs: Settings and Polling Test. See Check Device 
Communication on page 180 for more information on Polling Test. 

The Settings tab displays a Settings Hierarchy in the left pane of the window which allows you to 
change the settings for Response Device, Presentation, Slide or an Answer. The right pane of the 
window lists the settings. The settings are grouped by type and listed alphabetically. The name of 
each setting is in the left portion of the right pane and its value is on the right. Some settings may 
allow you to enter a value, while others will offer a drop-down menu to select from several choices.
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At the bottom of the Settings window is a region that displays a detailed description of a setting when 
you select it. You can use these descriptions or the following pages to learn about the settings. The 
bottom region offers additional options for some presentation-level settings.

Settings Window: Bottom Region

The Common Settings and All Settings Buttons allow you to select your level of customization. The 
Common Settings Button displays the most commonly modified settings. The All Settings Button 
reveals more settings allowing for a more personalized presentation.

The Restore default presentation settings button allows you to return the settings back to the default 
installation state. 

The Defaults button is active for chart colors on a presentation-level only. The button allows you to 
return your chart colors back to the default installation state. 

The Apply All button is active for settings on a presentation-level that have corresponding slide-level 
settings. The button applies and saves the setting changes that you made to the all existing 
applicable slides. 

The section describes:

• Response Device Settings

• Presentation Settings

• Slide Settings

• Answer Settings

The following sections contain information about the settings available by selecting the Settings tab 
and then selecting one of the following items from the Settings Hierarchy: Response Device, 
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Presentation, an individual slide or an answer. Settings listed in italics can be found by selecting the 
All Settings radio button.
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Response Device Settings
Response Device contains settings for the response devices compatible with TurningPoint. The list 
below contains more detailed information for each setting.

Response Device Settings

ResponseCard Channels

Allows you to view the Response Receiver settings.

Setting Description

Receiver Displays Receiver ID and Channels 
of the receivers connected to 
computer.
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ResponseCard Misc

Allows you to view and change various ResponseCard settings.

Setting Description

Force Channel 
Change

Determines whether to force the 
Receiver Channel to change at the 
time of connection to the computer. 
The default is set at False and will 
force TurningPoint to accept the 
channel from the receiver. True will 
set the receiver to the first available 
slot in TurningPoint.

Expected Devices Displays the number of Response 
Devices that you expect to be used 
during the presentation. This is only 
required when using Simulated 
Data, a Response Counter or 
Response Table.

Enforce Participant 
List

Determines whether only members 
of a Participant List can respond 
during a presentation or if anyone 
with a response device can 
respond. The default is set to True, 
which allows you to exclude the 
responses from participants who 
are not in the loaded Participant 
List. When set to false, all 
participants’ responses will be 
accepted and responses from 
participants who are not in the 
loaded Participant List will be 
appended to the end of that list. 

Overwrite User 
Information

Determines whether participant data 
received from a response device 
will overwrite the matching fields in 
the Participant List. The default is 
set to False, which will only write the 
information if the field is currently 
blank. 
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ResponseWare App

Enables you to view and change various ResponseWare App settings.

Setting Description

Enable 
ResponseWare 
App/RemotePoll

Determines whether 
ResponseWare Apps or computers 
using RemotePoll can participate in 
the presentation remotely. The 
default is set to False and will not 
allow ResponseWare Apps or 
computers using RemotePoll to 
participate remotely.

Port Number Manually change the Port number 
that ResponseWare Apps use to 
participate in the presentation.
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Presentation Settings
Presentation contains settings for the creation of slides, the way they are displayed, and other 
TurningPoint options. If you change a presentation-level setting, the change applies to all slides you 
create in the future and in some cases in the currently opened presentation.

Presentation Settings

Answer Settings

Enables you to view and change Answer settings.

Setting Description

Answer Bullet 
Format

Determines type of answer bullets 
TurningPoint will display. The 
available settings include: Alpha 
Lowercase Parenth = a), Alpha 
Lowercase Period = a., Alpha 
Uppercase Period = A., Decimal 
Parenth = 1), Decimal Period = 1., 
Roman Lowercase Period = i., 
Roman Uppercase Period I. The 
default is set at Decimal Period.
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Backup Settings

Enables you to view and change the backup settings.

Chart Settings

This enables you to view and change the chart settings. To change Chart Color 1 through Chart Color 
10 and Chart Color Correct and Incorrect: 1.) Select the current color to display the Color Select 

Setting Description

Backup 
Maintenance

Sets the number of days a backup 
session will be kept before being 
automatically deleted. You can set a 
range between one and ninety 
days. The default is set at seven 
days.

Backup Sessions Automatically have TurningPoint 
create a backup copy of all your 
completed sessions. The default is 
set to True, which creates a backup 
copy.

Real-time Backup 
Path

Determines the default location 
where your real-time backup 
session will be saved. When you 
determine a location, TurningPoint 
saves an XML version of your 
session while you are conducting it. 
The default is at None which stores 
a copy in your Backup/Sessions 
Folder. 

To change the location:1.) Click the 
current setting to open a dialog box. 
2.) Manually enter the location or 
navigate to one by selecting the 
ellipses. 3.) A dialog opens. 4.) 
Choose your location. 5.) Select 
OK. 6.) Select Apply to set the 
location.

To restore to the initial default 
location, click the current setting 
and select Turn Real-Time Backup 
Off.
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window. 2.) Select the desired color. Find more information on the procedure for changing chart colors 
in Change Chart Colors on page 120.

Setting Description

Auto Scale Charts Determines whether the charts are 
scaled proportionate to the 
responses or displayed forcing a 
scale of 0 to 100% for percentages 
and 0 to the maximum responses 
for count. The default is set to True, 
which sets the scale of the chart 
proportionate to the responses.

Chart Colors Determines what chart colors will be 
used during your presentation. The 
available settings are Color 
Scheme, Correct/Incorrect and User 
Defined. Color Scheme - uses the 
selected PowerPoint color scheme. 
Correct/Incorrect - uses user 
defined colors for slides that have 
answers selected as correct and 
incorrect. User Defined - uses user 
defined colors. 

The default is set at Color Scheme.

Chart Color 1 Determines the first chart color to 
be used for the User Defined color 
setting. 

Chart Color 2 Determines the second chart color 
to be used for the User Defined 
color setting. 

Chart Color 3 Determines the third chart color to 
be used for the User Defined color 
setting. 

Chart Color 4 Determines the fourth chart color to 
be used for the User Defined color 
setting. 

Chart Color 5 Determines the fifth chart color to 
be used for the User Defined color 
setting. 

Chart Color 6 Determines the sixth chart color to 
be used for the User Defined color 
setting. 
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Chart Color 7 Determines the seventh chart color 
to be used for the User Defined 
color setting. 

Chart Color 8 Determines the eighth chart color to 
be used for the User Defined color 
setting. 

Chart Color 9 Determines the ninth chart color to 
be used for the User Defined color 
setting. 

Chart Color 10 Determines the tenth chart color to 
be used for the User Defined color 
setting. 

Chart Color Correct Determines the color to be used for 
Correct answers for the 
Correct/Incorrect color setting. 

Chart Color 
Incorrect

Determines the color to be used for 
Incorrect answers for the 
Correct/Incorrect color setting. 

Chart Labels Determines if Answer Aliases 
(Answer Bullet Format) or Bullet 
Points will be displayed in the chart 
labels and legends. The default is 
set to Aliases.

Chart Value Format Determines whether TurningPoint 
displays the chart values as a whole 
number (Number of people who 
answered a question) or 
Percentage (Percentage of people 
who answer each question.) The 
valid formats are: 0, 0%, 0.0%, and 
0.00%. The default is set at 0%.

Reset Charts Determines whether the chart data 
will be cleared whenever a slide is 
reset. The default is set to True, 
which resets the chart data. 

Setting Description
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Competition Settings

Allows you to view and change the settings for competition slides.

Review Only Determines whether a chart 
showing how participants 
responded to a question is 
displayed during a presentation or 
only when a presenter reviews the 
presentation. The default is set to 
False which displays charts during 
the presentation.

Standard Chart Type Determines the default chart that is 
used when a slide is inserted into a 
presentation. The default is set to 
Vertical. All chart options are 
available to choose from.

Setting Description

Setting Description

Default Number of 
Teams

Determines how many teams are 
displayed in the Team Assignment 
slides. The acceptable range is 2-10 
teams. The default is set at 5.

Include Non-
Responders

Determines whether non-
responders will be included in team 
scoring. The default is set to False, 
which does not include non-
responders.

Maximum 
Responders

Determines the maximum number 
of responders that are included in 
the fastest responders slide. The 
acceptable range is 1-0 responders. 
The default is set at 5.

Participants in 
Leader Board

Determines the number of 
participants to include in the 
participant leader board. The 
acceptable range is 1-20 
participants. The default is set at 5.

Teams In Leader 
Board

Determines the number of teams 
displayed in the leader board. The 
acceptable range is 1-20 Teams. 
The default is set at 5.
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Misc

Enables you to view and change various settings. 

Setting Description

Add-In always 
loaded

Determines if TurningPoint loads 
with PowerPoint. The default is set 
to False, which does not 
automatically load TurningPoint. 

Allow Duplicates Determines whether participants are 
allowed to submit the same 
response more than once on 
multiple response slides. The 
default is set to False, which does 
not allow the same response to be 
submitted more than once on 
multiple response slides.

This setting is most often used 
when multiple participants are 
sharing one response device.

Allow User 
Feedback

Determines if user feedback will be 
accepted during the presentation. 
This option is available for 
ResponseWare App and 
ResponseCard users who press the 
“?” button. The default is set to 
True, which allows user Feedback.

Auto-Update Aliases Determines if Question and Answer 
Aliases will automatically reflect 
changes in text made to the 
Question and Answer placeholders. 
The default is set to True, which 
automatically updates aliases.

Correct Point Value Sets the default Point value of a 
correct answer. The acceptable 
range is from negative 10,000 
through 10,000. The default is set to 
100.

Default Participant 
Setting

Determines whether the Participant 
List Drop-down menu default is 
Auto or Anonymous. The default is 
set to Anonymous.
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Default Save 
Location 

Determines a custom location to 
save your sessions. The default 
setting is My Documents. To change 
the location:1.) Click the current 
setting to open a dialog box. 2.) 
Manually enter the location (and go 
to step 4) or navigate to a location 
by selecting the ellipses. 3.) A 
dialog opens. 4.) Choose your 
location. 5.) Select OK. 6.) Select 
Apply to set the location. 

To restore to the initial default 
location, click the current setting 
and select Restore to default path.

Include Presentation Determines whether to include the 
PowerPoint presentation with your 
saved session. The default is set to 
True, which includes the 
PowerPoint presentation.

Incorrect Point 
Value

Sets a default point value for 
incorrect answers. The acceptable 
range is negative 10,000 through 
10,000. The default is set to zero.

Input Source Sets the default input source that 
TurningPoint uses when running a 
presentation. The choices are 
Keyboard Keys, Simulated Data 
and Response Devices. The default 
is set to Response Devices.

Language Changes the language format. The 
default is set to the language you 
chose when installing TurningPoint 
2008.

Multiple Response 
Divisor

Determines whether the divisor 
used to calculate the percentages 
on multiple a response question will 
be the total number of responses 
received or the total number of 
devices that participated. The 
default is set to Devices.

Setting Description
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Moment to Moment Settings

Enables you to view and change settings for Moment to Moment slides.

Presenter ResponseWare App
Settings

Enables you to view and change the settings for the Presenter ResponseWare App.

Responses Determines the number of 
responses accepted from a 
response device without overwriting 
the previous response. The 
acceptable range is 1-10 
responses. The default is set to 1.

Zero Based Polling Number answers from 1-10 or 0-9. 
When set to True, answers will be 
number from 0-9 and will override 
the current answer bullet format. 
The default is set to False.

Setting Description

Setting Description

Polling Cycle Determines the polling interval in 
seconds on a moment to moment 
slide. The default is set at two 
seconds.

Setting Description

Default Port Number Set the local port number used by 
the Presenter ResponseWare App. 
Some ports may not be usable due 
to system or network configurations. 
The acceptable port number ranges 
from 1 - 65535. The default is set to 
1001.

Enable Presenter 
ResponseWare App

Determines whether a Presenter 
ResponseWare App can be used to 
control a SlideShow. The default is 
set to False, which does not allow 
the Presenter ResponseWare App 
to control a slideshow.
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Ranking Settings

Enables you to view and change the settings for Ranking Chart Slides.

Presenter 
ResponseWare App 
Password

Set a password for the Presenter 
ResponseWare App. By default, a 
password is not set.

Require Password Require that the ResponseWare 
App presenter uses a password. 
The default is set to False, which 
does not require a password.

Setting Description

Setting Description

Bubble Grouping Determines the number of bubbles 
shown while rotating using the tab 
key on a Ranking Chart slide. The 
acceptable range is 1-10 bubbles. 
The default is set at 3.

Bubble Name 
Visible

Determines whether the bubble 
names are displayed. The default is 
set to True, which displays bubble 
names.

Bubble Size Value 
Format

Determines the displayed format for 
bubble sizes. The acceptable 
formats are 0, 0.0 and 0.00. The 
default value is set to 0.

Bubble Size Visible Determines if bubble size values 
are visible. The default is set to 
True, which shows the bubble size 
value.
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Response Reminders Settings

Enables you to view and set Response Reminders settings.

Setting Description

Answer Now Select the default Answer Now 
object that will be automatically 
added to new slides. The default is 
set to None, which does not 
automatically add an Answer Now 
Indicator. All Answer Now objects 
are available to choose from.

Answer Now Text Change the Answer Now text that is 
displayed in the Answer Now object. 
The default text is Answer Now.

Auto-Advance Determines whether the SlideShow 
will automatically advance to the 
next animation if polling is closed by 
a Countdown Indicator or Response 
Counter object. The default is set to 
False, which does not automatically 
advance the SlideShow.

Countdown Determines if a Countdown object 
will be automatically added to new 
slides. The default is set to None, 
which does not automatically add a 
Countdown object to new slides. All 
Countdown objects are available to 
choose from.

Countdown 
Seconds

Set the number of seconds a 
Countdown object will display. The 
acceptable range is 1-999. The 
default is set at 10 seconds.

Response Counter Determines whether a Response 
Counter object is automatically 
added to new slides. The default is 
set at None, which does not 
automatically add a Response 
Counter. All Response Counter 
objects are available to choose 
from.
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Response/Non-Response
Grid Settings

Enables you to view and set the Response/Non-Response Grid Settings. To change Background and 
Foreground colors: 1.) Select the current color to display the Color Select window. 2.) Select the 
desired color. 3.) Select Ok.

Response Counter 
Format

Determines the format for new 
Response Counter objects. The 
acceptable formats are Count 
(number of responses), Percent, or 
Both (Count and Percent). The 
default is set to Count.

Response Table Determines whether a Response 
Table object is automatically added 
to new slides. The default is set to 
None, which does not automatically 
add a Response Table object. All 
Response Table objects are 
available to choose from.

Rotation Interval Determines the number of seconds 
that a Rotating table will pause 
between intervals. The acceptable 
range is 1-10 seconds. The default 
is set to two seconds.

Setting Description

Setting Description

Auto Size Grid Determines whether the 
Response/Non-Response Grid will 
automatically resize to fit the 
screen. The default is set to True, 
which automatically resizes the 
Response/Non-Response Grid.

Custom Cell 
Background Color 1

Determines the color that will be 
used for the Response/Non-
Response Grid’s 1st cell 
background color. 

Custom Cell 
Background Color 2

Determines the color that will be 
used for the Response/Non-
Response Grid’s 2nd cell 
background color. 
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Custom Cell 
Background Color 3

Determines the color that will be 
used for the Response/Non-
Response Grid’s 3rd cell 
background color. 

Custom Cell 
Background Color 4

Determines the color that will be 
used for the Response/Non-
Response Grid’s 4th cell 
background color. 

Custom Cell 
Foreground Color

Determines the color that will be 
used for the Response/Non-
Response Grid’s foreground cell 
color. 

Custom Grid 
Background Color

Determines the color that will be 
used for the Response/Non-
Response Grid’s background color. 

Display Device IDs Determines if Device IDs will be 
displayed on the Response/Non-
Response Grid. The default is set to 
True, which will display Device IDs.

Display Participant 
Names

Determines if Participant names will 
be displayed in the Response/Non-
Response Gird. The default is set to 
True, which will display the 
Participant Names.

Gr id Opacity Determines how transparent or 
opaque the Response/Non-
Response Grid is displayed. The 
accpetable range is 1 (transparent) 
to 100 (opaque). The default is set 
at 90 (mostly opaque).

Grid Position Determines the placement of the 
Response/Non-Response Grid 
when displayed. The acceptable 
positions are: Bottom, Bottom Left, 
Bottom Right, Center, Left, Right, 
Top, Top Left, Top Right. The default 
position is the Bottom of the screen.

Grid Rotation 
Interval

Determines the number of seconds 
a Response/Non-Response Grid 
will pause between intervals. The 
acceptable range is 1 to 10 
seconds. The default is set at 2.

Setting Description
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Showbar Settings

Enables you to view and change Showbar settings.

Grid Size Determines the size, in pixels, of the 
Response/Non-Response Grid 
when the Auto Size Grid is set to 
False. The default size is set to 800 
x 600.

Use Scheme Colors Determines whether the 
Response/Non-Response Grid is 
displayed using Scheme Colors or 
Custom Colors. Scheme Colors will 
use the current PowerPoint color 
scheme. Custom Colors are set in 
Custom Cell and Grid settings for 
Response/Non-Response Grid 
Settings. The default is set to True, 
which uses Scheme Colors.

Setting Description

Setting Description

Display Showbar Determines if the Showbar is visible 
during a SlideShow. The default is 
set to True, which displays the 
Showbar.

Expand Showbar Determines if the Showbar is 
displayed in its expanded state. The 
default is set to True, which displays 
the Showbar in its expanded state.

Use Secondary 
Monitor

Determines if the Showbar is 
displayed on secondary monitor if 
available. The default is set to True, 
which displays the Showbar on the 
secondary monitor.
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Slide Settings
Slide settings affect specific slides.

Slide Settings
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Chart Settings

This enables you to view and change the chart settings.

Setting Description

Chart Colors Determines what chart colors will be 
used during your presentation. The 
available settings are Color 
Scheme, Correct/Incorrect and User 
Defined. Color Scheme - uses the 
selected PowerPoint color scheme. 
Correct/Incorrect - uses user 
defined colors for slides that have 
answers selected as correct and 
incorrect. User Defined - uses user 
defined colors. 

The default is set at Color Scheme.

Chart Color 1 Determines the first chart color to 
be used for the User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 2 Determines the second chart color 
to be used for the User Defined 
color setting. To change the color: 
1.) Select the current color to 
display the Color Select window. 2.) 
Select the new color. 

Chart Color 3 Determines the third chart color to 
be used for the User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 4 Determines the fourth chart color to 
be used for the User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 
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Chart Color 5 Determines the fifth chart color to 
be used for the User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 6 Determines the sixth chart color to 
be used for the User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 7 Determines the seventh chart color 
to be used for the User Defined 
color setting. To change the color: 
1.) Select the current color to 
display the Color Select window. 2.) 
Select the new color. 

Chart Color 8 Determines the eighth chart color to 
be used for the User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 9 Determines the ninth chart color to 
be used for the User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 10 Determines the tenth chart color to 
be used for the User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color Correct Determines the color to be used for 
Correct answers for the 
Correct/Incorrect color setting. To 
change the color: 1.) Select the 
current color to display the Color 
Select window. 2.) Select the new 
color. 

Setting Description
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Chart Color 
Incorrect

Determines the color to be used for 
Incorrect answers for the 
Correct/Incorrect color setting. To 
change the color: 1.) Select the 
current color to display the Color 
Select window. 2.) Select the new 
color. 

Chart Labels Determines if Answer Aliases 
(Answer Bullet Format) or Bullet 
Points will be displayed in the chart 
labels and legends. The default is 
set to Aliases.

Chart Value Format Determines whether TurningPoint 
displays the chart values as a whole 
number (Number of people who 
answered a question) or 
Percentage (Percentage of people 
who answer each question.) The 
valid formats are: 0, 0%, 0.0%, and 
0.00%. The default is set at 0%.

Review Only Determines whether a chart 
showing how participants 
responded to a question is 
displayed during a presentation or 
only when a presenter reviews the 
presentation. The default is set to 
False which displays charts during 
the presentation.

Setting Description
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Misc

Enables you to view and change various uncategorized settings.

Setting Description

Allow Duplicates Determines whether participants are 
allowed to submit the same 
response more than once on 
multiple response slides. The 
default is set to False, which does 
not allow the same response to be 
submitted more than once on 
multiple response slides.

This setting is most often used 
when multiple participants are 
sharing one response device.

Anonymous Designates a slide as anonymous 
when polled. The default is set to 
False, which does not make the 
selected slide Anonymous.

Correct Point Value Sets the default Point value of a 
correct answer. The acceptable 
range is from negative 10,000 
through 10,000. The default is set to 
100.

Demographic Determines if the question on the 
selected slide is treated as a 
demographic question. The default 
is set to False, which does not treat 
the question as demographic.

Incorrect Point 
Value

Sets a default point value for 
incorrect answers. The acceptable 
range is negative 10,000 through 
10,000. The default is set to zero.

Multiple Response 
Divisor

Determines whether the divisor 
used to calculate the percentages 
on a multiple response question will 
be the total number of responses 
received or the total number of 
devices that participated. The 
default is set to Devices.
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Question Alias Determines how the question is 
labeled. This only applies when 
running some reports. The default is 
set to how the question appears on 
the slide.

Response Data Determines whether a slide 
contains response data. When set 
to True, the slide has polled data 
and will not be polled again. When 
set to False, the slide can be polled 
again. The default is set to True.

Responses Determines the number of 
responses accepted from a 
response device without overwriting 
the previous response. The 
acceptable range is 1-10 
responses. The default is set to 1.

Speed Scoring Determines whether point values 
will decrease relative to the time 
polling is kept open. The default is 
set to False, which will not decrease 
point values relative to the time 
polling is kept open.

Zero Based Polling Number answers from 1-10 or 0-9. 
When set to True, answers will be 
number from 0-9 and will override 
the current answer bullet format. 
The default is set to False.

Setting Description
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Response Reminders Setting

Enables you to view and set Response Reminders settings.

Setting Description

Auto-Advance Determines whether the SlideShow 
will automatically advance to the 
next animation if polling is closed by 
a Countdown Indicator or Response 
Counter object. The default is set to 
False, which does not automatically 
advance the SlideShow.

Countdown 
Seconds

Set the number of seconds a 
Countdown object will display. The 
acceptable range is 1-999. The 
default is set at 10 seconds.

Countdown Sound Use a sound file for a Countdown 
Sound.To add a Countdown Sound: 
1.) Click the current setting to open 
a dialog. 2.) Navigate to the folder 
containing the sound file. 3.) Select 
the file name. 4.) Select open. 5.) 
Select done.

The default is set to (None). The 
acceptable file extensions include: 
.aiff, .au, .mid, .midi, .mp3, .wav, 
and .wma.
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Answer Settings
Answer-level settings affect specific answers. The answer settings apply to the answer selected from 
the Settings Hierarchy.

Answer Settings

Answer Settings

This enables you to view and change the Answer settings.

Setting Description

Answer Alias Determines the Alias (Name) that is 
used for the chart labels and in 
some reports. The default is set to 
the answers entered during slide 
creation. 

Answer Value Determines whether the Answer is 
Correct, Incorrect, No Value, or has 
a point value of negative 10,000 
through 10,000. The default is set to 
No Value.
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Where Do I Go From Here?

If you are setting up your devices for the first time, the next step is to create your Participant List. A 
Participant List allows you to track the responses provided by your audience for each slide you 
present. Find instructions to create a Participant List in Chapter 5: Track Participants and Teams.

If you have installed new response device hardware, and you have already set up your Participant 
List, you can create a new interactive presentation or run an existing presentation using the new 
device. Find instructions to create slides in Chapter 3: Creating and Saving Slides. Find instructions 
to run a presentation in Chapter 7: Run Presentations.
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Track 
Participants and 
Teams

Participant Lists identify the members of your audience—your students, your trainees, your survey 
respondents—who will use a response device to respond to questions during your presentation. The 
participant name and other required information are stored along with the Device ID, a unique 
identifier for a response device. The Device ID is printed on the device tag, which is located on the 
back of the device (unless you are using ResponseWare App response software).
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Recall the five steps to presentation success. 

Five Steps to Success

This chapter discusses creating and managing a Participant List.
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Participant List Wizard

Participant List Wizard

Create a Participant List using the Participant List Wizard, Enterprise Manager from Turning 
Technologies or Course Management Systems by Web CT and Blackboard.

You may create multiple Participant Lists to be used with the same interactive presentation. One 
Participant List contains information about one audience group. Creating multiple Participant Lists 
allows you to capture responses from multiple audiences to your slides.

• Create a Participant List Using Participant List Wizard

• Create a Participant List from Enterprise Manager

• Create a Participant List from a Course Management System

Create a Participant List Using Participant List Wizard

The Participant List Wizard guides you through the creation of a Participant List to be used with your 
interactive presentation. You can control the number of responses TurningPoint will accept, which 
equates to the number of audience members by selecting to enforce a Participant List. A Participant 
List captures the audience names, their Device IDs, and other relevant information. Find more 
information about enforcing a Participant List in Response Device and Settings Management on 
page 157.

Create a Participant List using the Participant List Wizard. You can choose from using standard list 
templates or create one of your own to store as much information about your audience as is desired. 

Step by Step Instructions To create a Participant List…

1 From the TurningPoint 
toolbar, select Participants > 
Participant List Wizard.

Participants Menu
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The TurningPoint Participant List Wizard window opens 
presenting the option to use a pre-defined Participant List 
template or to create a custom template. Custom templates 
created in the past will appear in the My Custom Templates 
region when the Custom Template button is selected.

2 Select a template to be used 
for the new Participant List.

Participant List Wizard

Participant List template choices include:

• Education—contains standard student information used 
for K–12 and higher education presentations, such as 
name and student ID.

• Corporate—contains entries for the information most 
often used in corporate feedback meetings including 
name, company name, telephone numbers, etc.

• Available Fields—contains all information entries defined 
for use with TurningPoint.

• Custom—allows you to create a personalized Participant 
List and to name the template or it allows you to select a 
previously created template from the list.
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3 Select the Next button to 
continue.

If you opted to create a new template, TurningPoint asks you to 
name the template. Enter a name and select the OK button.

Custom Template Name

TurningPoint displays the Participant List information entries 
(called fields). All entries that make up the template appear in 
the Selected Fields region on the right. Use this page to add, 
delete, or reorder the entries that make up the template.

Participant List: Add or Remove Fields

4 Optionally, customize the list 
of Selected Fields. 

Right (>) and left (<) arrow buttons appear.



220 Turning Technologies

Chapter 5: Track Participants and Teams

• To remove an entry from 
the template, select it 
under the Selected Fields 
region and click the left 
arrow button. 

When selecting entries from the fields lists, click and drag 
single entries into the fields list, hold Shift to select 
multiple contiguous entries, or hold Control to select 
multiple entries. 

• To add an entry to the 
template, select the 
desired entry from the 
Available Fields region, 
and click the right arrow 
button.

• To change the order of the 
selected Fields click the up 
and down buttons.

5 Select the Next button to 
continue.

TurningPoint displays the Groups entry box. Use this screen to 
add Groups to your Participant List. Groups provide 
categorization for greater reporting opportunities, such as 
demographic reports or team competitions.

Participant List Wizard: Add Groups

Note Alternatively, double click on an entry to 
remove it from the Select Fields region.

Note Alternatively, double click on an entry to add 
it to the Select Fields region.
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6 Optionally, enter in a group 
name and select the Add 
button.

TurningPoint displays all groups in the Included Groups list. 
Repeat this step to add additional groups.

a. Place checkmarks next to 
the groups to designate 
them as teams.

7 Select the Next button to 
continue.

TurningPoint displays the Participant List summary page.

Participant List Wizard: Summary

8 Optionally, edit the 
Participant File composition.

The settings you can change include the Participant List file 
name, number of fields, and number of groups. For file name 
select the old file name and enter a new one in the box provided. 
For Number of Fields or Number of Groups, select the link to be 
returned to the screen and make edits.

9 Select the Finish button to 
create the Participant List 
and save it to a file.

TurningPoint displays the Participant Information window where 
you can enter, paste, edit or import data. You can also 
Add/Remove or Rename Fields and Groups from this window. 
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Find more information on editing a Participant List in Modify a 
Participant List on page 234.

Participant List Wizard: Participant Information

10 Optionally, save the template 
for future use. 

If you have modified a pre-defined template or created a custom 
template, TurningPoint asks whether to save the settings as a 
custom template. If you select the Yes button to name and save 
the template, the custom template will be available under My 
Custom Templates the next time you create a Participant List.
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11 Add names and other 
participant information to the 
new Participant List. 

Participant Information

12 Select the Done button, or 
Select File > Save to save the 
data in the Participant List 
before closing the Participant 
Information window.

TurningPoint adds the new Participant List to TurningPoint 
toolbar in the Select a Participant List drop-down menu.

Next Steps

Find more information on editing and deleting your Participant Lists in Manage Participant Lists on 
page 234.

Create a Participant List from Enterprise Manager

You can use Enterprise Manager from Turning Technologies with TurningPoint. Enterprise Manager is 
an essential tool for large organizations that puts the TurningPoint 2008 group response system to 
work in a classroom setting. Using a web-based interface, users interact with Enterprise Manager to 
identify classes that use TurningPoint 2008 as part of the curriculum, assign faculty and students to 
those classes, and record Device IDs for the students’ response devices. Enterprise Manager 
captures this information and manages the licenses for response device usage.
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Class rosters stored in Enterprise Manager are ready for use with TurningPoint 2008. A faculty 
member using a computer on the organization’s network can open TurningPoint 2008 and use the 
Enterprise Manager Wizard to import a class roster and use it as a Participant List.

On TurningPoint Enterprise Manager, the system is designed to work with ResponseCards and does 
not require the special setup of WebCT and Blackboard. 

To access TurningPoint Enterprise Manager, you need the following information from the technical 
support staff at the school:

• server name of the Enterprise Manager server 

• your username

• your password

Before You Begin

Open TurningPoint 2008 on the computer hosting the presentation.
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Step by Step Instructions To load a Participant List into TurningPoint 2008…

1 From the TurningPoint 
toolbar, select Tools. 

A menu opens and displays a list of TurningPoint tools. The 
Enterprise Manager option displays near the bottom of the list.

Enterprise Manager Menu

2 Select Enterprise Manager. The Enterprise Manager Log-in window opens.

Enterprise Manager Log-In Window
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3 Enter the Server URL, User 
Name, and Password.

The Server URL is the web address where faculty members 
access Enterprise Manager. Faculty members enter the user 
name and password used to log into Enterprise Manager.

4 Select the Next button. The Class Select window opens. The drop-down menu displays 
the list of classes assigned to the faculty member. A checkbox 
displays next to Import Participant List.

Class Select Window

5 Select the class from the 
drop-down menu.

6 Select the Import Participant 
List checkbox.

A checkmark appears in the box when selected.

7 Select the Finish button. Confirmation text displays in orange in the Class Select window 
when the file has been successfully imported. The Class Select 
window closes.

A Save As dialog opens for saving the Participant List on the 
host computer. In the location field, the file is set to be saved in 
the Participants folder under My Documents \TurningPoint. In 
the File Name field, the class name displays with the date and 
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time of the import. You may edit the name to be more 
meaningful. 

8 In the Save As dialog, select 
the Save button.

A confirmation message displays.

Confirmation Message

9 Select the OK button. The newly imported Participant List displays in the Participant 
List drop-down menu in the TurningPoint toolbar. 

Next Steps

Before giving the presentation, select the Participant List from the Participant List drop-down menu.

Create a Participant List from a Course Management System

As a versatile educational tool, TurningPoint is also compatible with course management systems by 
WebCT and Blackboard. If you teach at a school or other educational institution that uses WebCT or 
Blackboard you can use TurningPoint to transfer classroom information between your computer and a 
server. Varying degrees of integration are available for different versions of these course 
management systems.

TurningPoint can work with WebCT and Blackboard to import a Participant List from a server. The 
following steps describe how to connect to WebCT and Blackboard from TurningPoint. Before trying 

Note The Participant List must be saved in the 
Participants folder under My Document > 
TurningPoint on the host computer for 
TurningPoint to find the list.
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to import data into TurningPoint, ensure you are set up properly on the system’s server. Contact the 
technical support at the school if you need assistance with setup.

Before You Begin

On WebCT, the following steps need to occur with WebCT before using the WebCT Wizard:

• The system administrator at the institution adds a column called “KeyPadID” in WebCT. The 
instructions on how to add a column are found in the System Administrator’s Guide: WebCT 
Campus Edition.

• The instructor creates a class list and includes the KeyPad ID field.

• The students log into WebCT and enter their KeyPad ID number twice, the second time to confirm, 
and then enter their contact information. Students receive a message that the add was successful 
and that their currently registered Device ID is xxxy, etc.

• The instructor can then gather all response Device IDs from registered students.

To use the WebCT Wizard, you need to obtain the following information from the technical support 
staff at the school:

• server name of the WebCT server 

• port number of the WebCT server 

• your username

• your password

On Blackboard, the following steps need to occur with Blackboard before using the Blackboard 
Wizard: 

• The instructor creates a class list and identifies an existing column to store the KeyPad ID data. 
(Blackboard does not allow adding a column.)

• The students log into Blackboard and enter their KeyPad ID number in the column specified by the 
instructor. Students must reenter their KeyPad ID when new classes are added.

• Instructors and students can also download information for multiple classes into a zip file and 
choose a location in which to save the file.

To use the Blackboard Wizard, you need to obtain the following information from the technical support 
staff at the school:

• server name of the Blackboard server 

• your username

• your password
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Step by Step Instructions To import a Participant List…

1 From the TurningPoint 
toolbar, select Tools. In the 
menu, select WebCT Wizard 
(CE 4.1 or CE 6.0/Vista 3, 4) 
or Blackboard Wizard 
Manager, depending on your 
system.

Course Management Menu
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2 Select Import Participant List. WebCT Wizard: Select Task

3 Select the Next button. TurningPoint provides a window for your login information. 
Contact the technical support at the school to obtain this 
information if you do not have it.

4 Enter your login information. WebCT Wizard: Login

Note The illustrations shown in this section are of the 
WebCT CE 4.1 interface, but the interfaces for 
WebCT CE 6.0/Vista 3, 4 and Blackboard are 
similar. 
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TurningPoint saves the Server Name (IP) and the Port Number. 
You must enter your username and password for WebCT. The 
system prompts you for the Institution’s name and then displays 
all courses associated with your user name and password.

5 Select the Next button. The next steps differ slightly depending on the type of system 
you have. In WebCT CE 4.1, you indicate the course pertaining 
to the Participant List you want by following the instructions in 
the window. In WebCT CE 6.0/Vista 3, 4, you select the 
institution you belong to and then the course you wish to import 
from. In Blackboard, you provide the name of the field in the 
Participant List file that holds the KeyPad ID data.



232 Turning Technologies

Chapter 5: Track Participants and Teams

6 Provide the information 
requested in the window, 
including selecting the course 
containing the data you want 
to import. In Blackboard, 
select the name of the field 
you designated to hold the 
KeyPad ID.

WebCT Wizard: Class Select

Blackboard Wizard: Class Select

7 Select the Finish button. TurningPoint displays a window describing the location where 
the data will be imported to the computer and the file name you 
wish to import. The default location is My 

Note In Blackboard, a class list is limited to the 
existing columns. When you set up a class 
list, you cannot add a column for KeyPad ID 
numbers. You must use a column that 
already exists but is unused, such as 
Company or Work Fax. Inform students of 
the name of the column you designate for 
KeyPad ID numbers so they enter their data 
correctly.
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Documents\TurningPoint\ Participants. TurningPoint adds the 
current date and time to the file name.

8 Select the Save button. TurningPoint displays a confirmation message that your file has 
been imported. Optionally, you may edit the location or file 
name, and then select the Save button.

9 Select the OK button. The file name displays in the Select a Participant List drop-down 
menu if it is saved in the My Documents\TurningPoint\ 
Participants folder.

TurningPoint Toolbar: New Participant List

Note A Participant List must be saved in My 
Documents\TurningPoint\Participants on the 
computer that runs the presentation session. 
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Manage Participant Lists

After you have imported a Participant List or created one with the Participant List Wizard, you can 
make changes to a Participant List or delete it altogether.

This section describes how to:

• Modify a Participant List

• Delete a Participant List

Modify a Participant List

Follow these steps if you would like to make changes to an existing Participant List. You can change 
the recorded Device ID for a participant by modifying the list.

Before You Begin

A Participant List should have a.tpl extension (TurningPoint participants format). You must import the 
Participant List or create a list using the Participant List Wizard before editing it with TurningPoint. 

Step by Step Instructions To modify a Participant List…

1 From the TurningPoint 
toolbar, select Participants > 
Edit a Participant List.

Participants Menu

TurningPoint displays a window of Participant Lists saved in My 
Documents/TurningPoint/Participants.
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2 Select the desired Participant 
List, and then select the 
Open button.

TurningPoint displays the Participant List data in the Participant 
Information window. The grey fields represent data that cannot 
be edited, such as the row numbers.

Participant Information Window



236 Turning Technologies

Chapter 5: Track Participants and Teams

3 Optionally, edit the existing 
data in the white fields by 
selecting the entries and 
typing new information.

4 Optionally, add a new 
participant by right-clicking in 
in the row above the row that 
you want to add a participant 
and selecting Add 
Participant.

Participant Information Window: Add New

5 Optionally, remove a 
participant by right-clicking in 
the first cell of the row 
containing that participant 
and selecting Remove 
Participant(s).

Participant Information Window: Remove Participant
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6 Optionally right click on the 
column that you want to add a 
field to the right of, and select 
Add Field. 

a Alternatively, select a 
column in the Participant 
Information window.

TurningPoint inserts the new field to the right of the 
selected column. 

b Select Edit from the menu 
bar.

Participant Information: Edit Menu

TurningPoint displays the available editing options. 

c Select Add Field/Group > 
Add Field. 

An Add Participant Information window opens.

Participant Information: Add Participant Information
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d Enter the name of the new 
field in space provided 
under Add a custom field.

e Select Add. TurningPoint adds the newly created field to the Selected 
Fields list.

Participant Information: Field Added

f Repeat steps d and e to 
add additional fields.

g Select Finish. TurningPoint adds the fields to your Participant List.

Note To remove any fields from the Selected 
Fields list, highlight the field name and select 
Remove.
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7 Optionally right click on the 
column that you want to add a 
Group to the right of, and 
select Add Group.

a Alternatively, select Edit 
from the menu bar.

Participant Information: Edit Menu

TurningPoint displays the available editing options. 

b Select Add Field/Group > 
Add Group. 

An Add Groups to your Participant List window opens.

Participant Information: Add Groups
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c Enter the name of the new 
group in space provided 
under Create a new group.

d Select Add. TurningPoint adds the newly created group to the 
Included Groups list. 

Participant Information: Group Added

e Repeat steps d and e to 
add additional groups.

f Place checkmarks next to 
the groups to designate 
them as teams.

g Select Finish. TurningPoint adds the groups that you created at the end 
of your Participant List.

Note To remove any groups from the Included 
Groups box, select the Group Name, and 
select Remove.
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8 Optionally, right click on a 
Field/Group that you want to 
rename and select Rename 
Field/Group. 

a Alternatively, select the 
field or group that you want 
to rename.

b Select Edit from the menu 
bar.

Participant Information: Edit Menu

TurningPoint displays the available editing options.

c Select Rename 
Field/Group.

Participant Information: Field/Group Entry

A text entry window opens. 
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d Enter the new name of the 
field/group.

e Select Ok. TurningPoint renames the selected field or group.

9 Optionally, right click on a 
Field/Group that you want to 
remove and select Remove 
Field/Group. 

a Alternatively, select the 
Field/Group that you want 
to remove.

b Select Edit from the menu 
bar.

Participant Information: Edit Menu

TurningPoint displays the available editing options.

c Select Delete Field. TurningPoint deletes the selected field.



TurningPoint User Guide 243

Manage Participant Lists

10 Optionally, right click on a 
column that you want to 
Freeze and select Freeze 
Column.

TurningPoint provides you with the option to Freeze a column. 

a Alternatively, select the 
column that you want to 
Freeze.

Participant Information: Freeze Column(s)

b Select Edit from the menu 
bar.

TurningPoint displays the available editing options.

c Select Freeze Column(s). TurningPoint locks the column that you selected and 
limits your ability to rearrange the column order as 
outlined in step 11. You will not be able to move any 
columns located to the left of the frozen column to the 
right of the frozen column in the Participant Information 
window. Conversely, you will not be able to move any 
columns located to the right of the frozen column to the 
left of the frozen column in the Participant Information 
window. 
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11 Optionally, rearrange the 
column order in your 
Participant List.

a Place a checkmark in the 
box next to Check to 
rearrange column order 
located at the bottom of 
the window.

Participant Information: Rearrange Columns

TurningPoint limits the editing abilities while this function 
is active. 

b Select the column you 
would like to be moved. 

c Drag and drop the column 
in its new location.

12 Select File > Save. A confirmation message displays. 

13 Select Done. The Participant Information window closes.
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Delete a Participant List

This section describes how to remove a Participant List from TurningPoint.

Before You Begin

Deleting a Participant List sends the file to the computer’s Recycle Bin. Save a backup copy in 
another location if you would like to be able to access the file later.

Step by Step Instructions To delete a Participant List… 

1 From the TurningPoint 
toolbar, select Participants > 
Delete a Participant List.

Participants Menu

TurningPoint displays a window listing all Participant Lists that 
have been created or imported.

2 Select the file name of the 
Participant List you wish to 
remove. 

Delete Participant List
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3 Select the Delete button. A window display confirming that you want to delete the 
selected Participant List. 

4 Select Yes to delete the 
Participant List. 

TurningPoint removes the file from the list.

Tip To retrieve a Participant List after deleting it, 
open the computer’s Recycle Bin, find the file 
and select it. Either select to Restore Item or 
drag and drop the file from the Recycle Bin to a 
new location. If you choose to drag and drop 
the file to a new location, It will not be available 
to TurningPoint unless you import the file. 
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Set Up Team Competitions

TurningPoint can enhance group interaction to create a more memorable and educational 
presentation. Team competitions are a fun way to incite this interaction. Set up team competitions 
through the Participant List Wizard. You can create a Participant List that enables you to assign 
participants to teams who will compete for the highest score during your presentation. 

You can also edit an existing Participant List and add Groups as teams using the Add Group feature, 
and checking the appropriate checkboxes next to the Group names.

For participants or teams to accumulate scores, you will have to assign point values to correct 
answers. You can even assign points based on how quickly participants respond using speed scoring.

TurningPointTurningPoint offers several slides to keep track of participant and team point totals and 
which participants respond most quickly. Find more information in Competition Slides on page 67

This section describes how to:

• Add Teams to a Participant List

Add Teams to a Participant List

You can create a Participant List that can enable team competitions by following the steps below. 
Alternatively, you can edit an existing Participant List and add Groups as teams using the Add Group 
feature, and checking the appropriate checkboxes next to the Group names.

Before You Begin

These steps create a new Participant List that assigns participants to teams before the presentation, 
and it allows you to edit a existing Participant List to include Teams. 

If you would like to pick teams on the fly during the presentationtest, you need to insert a Team 
Assignment slide. Find information about this special slide in Competition Slides on page 67.



248 Turning Technologies

Chapter 5: Track Participants and Teams

Step by Step Instructions To set up team competitions…

1 Follow step 1 through step 5 
in Create a Participant List 
Using Participant List 
Wizard on page 217. 

In the Participant List Wizard window, TurningPoint displays the 
Groups entry box. Use this page to add groups to your 
Participant List. 

2 Enter a group name in the 
Create a new group field, and 
select the Add button. Repeat 
for all desired team names.

TurningPoint displays all groups in the Included Groups list. 
These groups can represent any type of grouping you wish to 
assign participants to, such as teams, class level, or any other 
demographic information.

• Repeat step 2 to create 
additional groups.

Participant List Wizard: Add Groups
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3 Choose the groups in the 
column to the right that you 
want to designate as teams 
who will compete against 
each other by selecting the 
appropriate checkboxes.

Checkboxes appear next to the groups designated to compete 
as teams.

Participant List Wizard: Groups Added

4 Select the Next button to 
continue.

TurningPoint displays the Participant List summary screen.

Participant List: Summary
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5 Select the Finish button to 
create the Participant List 
and save it to a file.

Next Steps

Find more information about slides for keeping track of participants’ and teams’ points in Competition 
Slides on page 67.
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Where Do I Go From Here?

If you have not set up the hardware devices for participants to respond, Chapter 4: Response Device 
and Settings Management demonstrates this process. You only need to set up hardware devices 
once on the computer you will use them with, unless you add or change the hardware devices.

If you have already set up hardware devices and have a Participant List for the audience you will be 
presenting to, you are ready to conduct your presentation! Chapter 7: Run Presentations 
demonstrates this process.
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TurningPoint offers several tools that allow you to use powerful advanced features:

• Create slides to rank items

• Create and assign standards for evaluating participants

• Create slides aligned to state standards using QuestionPoint

• Create comparative links for comparing the responses from several slides in a single chart in your 
presentation

• Use conditional branching to control the order of slides in your presentation based on responses

• Create slides from imported files

The Ranking Wizard allows you to create slides to rank items on several criteria. Find more 
information in Ranking Wizard on page 257.

The Standards tool enables you to use reports to evaluate the performance of participants based on 
standards. You can use the built-in standards or set up a list of standards and associate those 
standards with questions, and then evaluate the performance of the audience as a whole, by groups, 
or by individuals on each standard. Find more information in Standards on page 266. 

QuestionPoint allows you to access a question bank to create slides. Find more information in Create 
Slides from QuestionPoint on page 283.

The Comparative Links tool is used to compare the results from several slides in a single chart in your 
presentation. For example, you might ask several similar questions in succession, and then wish to 
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compare the responses from each question on a single slide. By creating comparative links between 
the slides, a single slide’s chart can show the results from up to three additional questions. Find more 
information in Comparative Links on page 291. 

The Conditional Branching tool allows you to control the order of slides based on the responses to a 
question. For example, you could have the audience vote on which topics to cover in your 
presentation, or you could continue with a different topic when the audience demonstrates a sufficient 
understanding of the current one by answering a question correctly. Find more information in 
Conditional Branching on page 296.

The TurningPoint Parser allows you to automatically create presentations from XML, Excel, or Word 
documents. Find more information in Import Slides with the TurningPoint Parser on page 317.

The Import from TestingPoint tool allows you to automatically create presentations from TestingPoint 
documents. Find more information in Import Slides from TestingPoint on page 321.
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Ranking Wizard

You can quickly and easily create slides that support decision-making, prioritization, or other kinds of 
ranking using TurningPoint’s Ranking Wizard. The Ranking Wizard automatically creates slides for 
comparisons of items on one to three criteria, then summarizes the results of the comparisons in a 
chart.

For example, suppose you wanted to prioritize several projects you are considering. You might 
compare them on the basis of cost, impact, and urgency.

You can choose to rank each item on a numerical scale for each criterion. For example, one slide 
would ask you to rank Project A on urgency from least (1) to most (10). You can use a scale beginning 
with 1 and ending with any number up to 10.

Alternatively, you can choose to compare items on the criteria by pairs. For example, one slide would 
ask you whether Project A or Project B is more urgent.

You can include as many items as you wish, and you can compare them on up to three criteria. The 
results are displayed in a chart which ranks the items. The chart looks similar to this:

Ranking Wizard chart

In this example, Project D looks like a clear winner, since it has the lowest cost, most urgency, and a 
relatively high impact.

*
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The Ranking Wizard gathers information from you about the items, the criteria, and how you would 
like to make the comparisons. Then it automatically constructs a series of slides with the questions 
and answers necessary to construct a final comparison chart.

This section describes how to:

• Create Slides with the Ranking Wizard

Create Slides with the Ranking Wizard

The Ranking Wizard is located in the Tools menu on the TurningPoint toolbar. It guides you through 
the process of creating a set of ranking slides.

Step by Step Instructions To create slides with the Ranking Wizard…

1 Navigate to the slide you 
would like the ranking slides 
to be inserted after.

When you complete the Ranking Wizard, the ranking slides will 
be added to the presentation after the currently selected slide.
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2 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.

Select Ranking Wizard

3 Select Ranking Wizard. The Ranking Wizard window opens.

Ranking Wizard: Add Items
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4 Enter a name for an item to 
be ranked in the box provided 
and select the Add button.

The item will be added to the list. You must add at least two 
items.

Repeat this step until you have added all the items you would 
like to rank.

5 When you have added all the 
items to rank, select the Next 
button.

The next set of options allows you to specify the criteria that is 
displayed in the Ranking Wizard.

Ranking Wizard: Enter Criteria

6 Enter a name for the X 
criterion and, optionally, the Y 
criterion, in the boxes 
provided.

You must enter at least one criterion (X) for the ranking. If you 
are comparing only a single criterion, leave the Y criterion blank.

The X and Y criteria appear on the horizontal and vertical axes 
of the chart, respectively.

Note You can save a list of items if you will reuse 
them with the Ranking Wizard. Lists are 
stored as simple text (.txt) files. 
Use the Save button (shaped like a disk) to 
save a text file with the list of items. Use the 
Load button (shaped like a folder) to load a 
text file with a list of items.
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7 If you wish to include a third 
criterion in the ranking, check 
the box for the Z criterion and 
enter a name for the Z 
criterion in the box provided.

The Z criterion, if used, is represented in the chart by the size of 
the “bubble” for each item.

8 Choose a method for ranking 
the items:

Ranking Wizard: Ranking Method

• Select Standard X/XY/XYZ 
to rank the items on a 
numerical scale for the 
criteria.

You will specify the numerical scale to use later in the 
Ranking wizard if you choose a standard comparison.

• Select Paired Comparison 
to compare the items by 
pairs on the criteria.

If you choose paired comparisons, you may allow a 
response of No Preference by checking the box for that 
option.

9 If you chose a standard 
comparison, select whether 
you would like the slides to be 
grouped by criterion or by list 
item.

Grouping slides by criterion will present the slides for each item 
about criterion X, then slides for each item about criterion Y, and 
so on.
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Grouping slides by item will present the slides for each criterion 
about item A, then the slides for each criterion about item B, and 
so on.

Ranking Wizard: Standard Comparison

10 Check the box if you would 
like to Auto-Advance the 
slides created by the Ranking 
Wizard.

Using Auto-Advance automatically advances the slide after all 
participants have responded to a question.

Ranking Wizard: Auto - Advance

11 Check the box if you would 
like to display the charts for 
the slides created by the 
Ranking Wizard.

Commonly, you are not interested in seeing the results for 
individual slides in the ranking questions. You can remove the 
check mark and use it in combination with Auto-Advance to 
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make your way quickly through the ranking questions to display 
the ranking chart.

Ranking Wizard: Show Charts

12 If you are using a Z criterion, 
check the boxes if you would 
like to use the following 
options:

Ranking Wizard: Z Criteria

• Show Bubble Names 
shows the name of each 
item on the bubble that 
represents it in the ranking 
chart.

The chart also includes a key that color-codes the 
bubbles with the items.
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• Show Bubble Sizes shows 
the numerical size of each 
item’s bubble on the 
ranking chart.

13 When you have specified all 
the options you would like to 
use, select the Next button.

If you chose a standard comparison, the next set of options 
allowing you to specify the ranking scale is displayed in the 
Ranking Wizard window. (If you chose a paired comparison, a 
summary is displayed and you can skip to step 17.)

Ranking Wizard: Customize Scale

14 Uncheck the boxes next to 
the numbers if you wish to 
limit the scale to less than 1–
10.

Unchecking a lower number also unchecks all the larger 
numbers.

For example, if you would like to use a scale of 1–4, uncheck 
the box next to 5.

15 If you would like to add labels 
to the numbers, select a 
number and enter the label 
text.

You might like to add labels to the lowest and highest numbers 
of the scale (such as “Worst” and “Best”).
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16 When you are finished 
modifying the ranking scale, 
select the Next button.

A summary of all the options you chose is displayed in the 
Ranking Wizard window:

Ranking Wizard: Review Selections

17 Review the information in the 
summary to ensure that it is 
correct.

If any of the information is incorrect, you can select the incorrect 
information to be taken to the set of options in the Ranking 
Wizard where you specified the information. Correct the 
information and then continue with the remaining steps. 
(Alternatively, use the Back button to go back to the incorrectly 
set option.)

18 Select Finish to create the 
ranking slides.

TurningPoint inserts the ranking questions and the ranking chart 
in your presentation. (This may take some time if you have a 
large number of items.)

Next Steps

When you run the presentation containing the ranking slides, the results will be compiled to generate 
the ranking chart, which is displayed in a slide following the ranking questions.

Note Because the Ranking Wizard uses the 
results from the created slides to construct 
the final chart, you should not alter the slides 
created by the Ranking Wizard.
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Standards

TurningPoint’s standards tools allow you to use built-in standards (per state or country, topic, subject 
and grade level) or to create your own lists of standards on which participants can be evaluated. For 
training, teaching, or testing, standards help you organize the material in your presentation into 
subject areas, competencies, or other standards which the participants should meet. You can then 
view participants’ results by standards using Turning Reports. Find more information in Reports on 
page 351.

Before you can assign standards to slides in a presentation, you need to select from the Built-in 
Standards or create a list of the standards you will be using.

This section describes how to:

• Assign Standards Using a Built-in Standards List

• Create a Custom Standards List

• Assign Custom Standards to Slides

Assign Standards Using a Built-in Standards List

TurningPoint 2008 comes loaded with built-in standards per state or country, topic, subject and grade 
level. You can assign these built-in standards to individual slides or to the entire presentation.
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Step by Step Instructions To create a Built-in Standards List…

1 From the TurningPoint 
toolbar, select Tools.

The Tools menu opens.

Select Standards
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2 Select Standards from the 
Tools menu.

The Standards window opens.

Standards Window

3 Select the Built-in Standards 
Lists tab.

A window opens and displays four drop-down menus: Select a 
state or country……, Select a topic…,Select a subject……, and 
Select a grade….

Built-in Standards Window
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4 From the Select a state or 
country… drop-down menu, 
select a state.

The Select a topic… drop-down menu populates with topics for 
the selected state/country.

Built-in Standards: Select a State or Country

5 From the Select a topic  … 
drop-down menu, select a 
topic.

The Select a subject… drop-down menu populates with 
subjects for the selected topic.

Built-in Standards: Select a Topic
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6 From the Select a subject… 
drop-down menu, select a 
subject.

The Select a grade… drop-down menu populates with grade-
levels for the selected subject.

Built-in Standards: Select a Subject

7 From the Select a grade… 
drop-down menu, select a 
grade-level.

All of the standards for the selected state/country, topic, subject, 
and grade-level display in the left pane of the Standards 
window.

Built-in Standards: Select a Grade
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8 Select a standard from the 
list.

Add the standard to the presentation or an individual slide.

9 Select to assign a standard to 
the presentation or an 
individual slide using the 
Current Standards List drop-
down menu.

Built-in Standards: Select Presentation or Slide

10 Select the right arrow button 
(>) to assign the standard to a 
presentation or individual 
slide.

The standard displays in the list of standards in the right of the 
Standards window.

Built-in Standards: Assign Standards

Remove a standard using the left arrow button (<).
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11 Repeat these steps 
beginning with step 4 to add 
standards to additional 
slides.

Assign multiple standards or use multiple Standards Lists.

If you would like to start over, you can select the Clear All button 
to clear all standards from all slides in the presentation.

12 When you are finished 
assigning standards, select 
the Done button.

Create a Custom Standards List

TurningPoint allows you to create a list of standards to suit your specific needs. You can also remove 
catagories and standards using the delete keys on your keyboard.
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Step by Step Instructions To create a Custom Standards List…

1 From the TurningPoint  
toolbar, select Tools.

The Tools menu opens.

Select Standards
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2 Select Standards from the 
Tools menu.

The Standards window opens.

Standards Window

3 Select the Custom Standards 
Lists tab.

The Current Selection drop-down menu displays the selected 
Standards list. The drop-down menu allows you to choose from 
the Standards Lists in your Standards folder.The Load button 
allows you to import a Standards List to your Standards folder 
from elsewhere. The Delete button allows you to delete a 
Standards List from your Standards folder. The New button 
allows you to create a custom Standards List.

Custom Standards Window
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4 Select the New button. TurningPoint prompts you to enter a new name for the 
Standards List.

Custom Standards: New Standards List

5 Enter a name in the box 
provided and select the OK 
button.

TurningPoint creates the Standards List in your Standards 
folder, displays it in the Current Selection drop-down menu, and 
displays the new Standards List in the left-hand pane of the 
Standards window.

Custom Standards: Parent Category

The new Standards List has a top-level (Parent) category with 
the same name as the list.

Categories arrange standards into a hierarchy.



276 Turning Technologies

Chapter 6: Tools

6 To add a category or a 
standard, complete the 
following steps.

a Select the Add Category or 
Add Standard button.

TurningPoint prompts you to enter a title for the category 
or standard.

Custom Standards: Add Category

b Enter a title in the box 
provided and select the 
OK button.

TurningPoint adds the category or standard to the parent 
category you selected.

Custom Standards: Category and Standards Added
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c Repeat steps a and b to 
add additional categories 
and/or standards.

You can delete a category or standard from the list using 
the Remove button. You can change the title of a 
category or standard using the Edit Field button.

Custom Standards: Remove/Edit

7 When you are finished 
creating your Standards List, 
select the Done button.

TurningPoint indicates that you have made changes to the 
Standards List and asks if you would like to save your changes.

8 Select the Yes button. The changes are saved to your Standards List file and the 
Standards window closes.

Next Steps

To associate standards with slides, follow the instructions in the next section, Assign Custom 
Standards to Slides.
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Assign Custom Standards to Slides

Assigning a Custom Standards List to slides allows you to use TurningPoint  reports to assess 
participants’ performance on slides relating to the standards. You can also remove catagories and 
standards using the delete key on your keyboard

Before You Begin

You should create or obtain Standards Lists to be assigned to the slides. Find more information in 
Create a Custom Standards List on page 272.

Step by Step Instructions To assign standards to slides…

1 From the TurningPoint  
toolbar, select Tools.

The Tools menu opens.

Select Standards
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2 Select Standards from the 
Tools menu.

The Standards window opens displaying two tabs: Built-in 
Standards Lists and Custom Standards Lists.

Standards Window

3 Select the Custom Standards 
Lists tab.

The Current Selection drop-down menu displays the selected 
Standards list. The drop-down menu allows you to choose from 
the Standards Lists in your Standards folder.The Load button 
allows you to import a Standards List to your Standards folder 
from elsewhere. The Delete button allows you to delete a 
Standards List from your Standards folder. The New button 
allows you to create a custom Standards List.

Custom Standards Window
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4 Select a Standards List in 
one of the following ways:

a Select a Standards List 
from the Standards folder 
using the Current 
Selection drop-down 
menu.

The categories and standards are displayed in the left-
hand pane of the Standards window.

Custom Standards: Select from Current Selection

b Select a Standards List 
from elsewhere using the 
Load button.

The categories and Standards List file is copied to your 
Standards folder and the standards are displayed in the 
left-hand pane of the Standards window.

Custom Standards: Load Standard
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5 Select to assign a standard to 
the presentation or an 
individual slide using the 
Current Standards List drop-
down menu.

Custom Standards: Select Presentation or Slide

6 Select the right arrow button 
(>) to assign the standard to a 
presentation or individual 
slide.

The standard is displayed in the list of standards in the right-
hand pane of the Standards window.

Custom Standards: Assign Standards

Remove a standard using the left arrow button (<).
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7 Repeat these steps 
beginning with step 4 to add 
standards to additional 
slides.

Assign multiple standards or use multiple Standards Lists.

If you would like to start over, you can select the Clear All button 
to clear all standards from all slides in the presentation.

8 When you are finished 
assigning standards, select 
the Done button.

Next Steps

Several reports allow you to assess participants’ performance on the standards you assigned. Find 
more information in Reports on page 351.
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QuestionPoint

QuestionPoint is a question bank of 30,000 assessment items aligned to state standards and sorted 
by grade and subject. This bank of questions enables teachers and administrators to easily generate 
assessments and create interactive presentations from those assessments.

This section describes how to:

• Create Slides from QuestionPoint

Create Slides from QuestionPoint

You can use the assessments found in QuestionPoint to create an interactive presentation. 
QuestionPoint has been integrated with TurningPoint  to provide a seamless connection between the 
two applications. Creating an interactive presentation is quick and easy. 



284 Turning Technologies

Chapter 6: Tools

Step by Step Instructions To generate a presentation using QuestionPoint…

1 From the TurningPoint  
toolbar, select Tools. 

The Tools menu opens.

Select Question Point
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2 Select QuestionPoint. The QuestionPoint window opens.

QuestionPoint

The window displays three window panes and the Select a 
state…, Select a type…, Select a subject…, Select a grade-
level…, Chart Color, and Correct Answer Indicator drop-down 
menus.

3 From the Select a state… 
drop-down menu, select a 
state on which to base your 
assessment.

QuestionPoint: Select a State

The Select a type… drop-down menu populates with the types 
of standards available for the selected state.
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4 Select a type of standard 
from the Select a type… 
drop-down menu.

QuestionPoint: Select a Type

The Select a subject… drop-down menu populates with the 
available subjects for the selected state.

5 Select a subject from the 
Select a subject… drop-down 
menu.

QuestionPoint: Select a Subject

The select a grade-level… drop-down menu populates with the 
available grade-levels for the selected state, type of standard, 
and subject. 
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6 Select a grade-level from the 
Select a grade-level… drop-
down menu.

QuestionPoint: Select a Grade-level

A list of standards displays in the left pane of the window. The 
standards are based on the selected state, type of standard, 
subject, and grade-level.

7 Select a standard from the list 
of standards.

A list of questions displays in the middle pane of the window.

QuestionPoint: Select a Standard

TurningPoint  highlights the correct answer for each question in 
green.
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8 Select a question from the list 
and click on the right arrow 
button located in the margin 
between the middle and right 
panes. 

Alternatively, right-click on the question to display a contextual 
menu with the option to add the selected question or all 
questions in the list to the presentation. Double clicking on a 
question will add it to the presentation.

QuestionPoint: Select a Question

• Repeat steps 7 and 8 to 
add additional questions.

The selected question(s) display in the right pane of the 
window.

9 Optionally, select the chart 
colors to be used for the 
slides from the Chart Color 
drop-down menu.

QuestionPoint: Select Chart Color

Choose between Color Scheme, Correct Incorrect, and User 
Defined.
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• Color Scheme - uses the color scheme of your 
PowerPoint presentation.

• User Defined - uses ten user-defined colors. Define these 
colors from the Settings window.

• Correct Incorrect - uses two user-defined colors, one for 
correct answers and one for incorrect. (The default colors 
for correct and incorrect are green and red respectively.) 
Define these colors from the Settings window.

Additionally, you can change the Chart Colors after you build 
the slides. Find more information about Changing Chart colors 
in Change Chart Colors on page 120.

10 Optionally, add a Correct 
Answer Indicator from the 
Correct Answer Indicator 
drop-down menu.

QuestionPoint: Add a Correct Answer Indicator

Choose from a Rectangle, Checkmark, Smiley Face, Star, 
Arrow, or Blinking Rectangle.

Additionally, you can add or change a Correct Answer Indicator 
after you build the slides. Find more information in Add a 
Correct Answer Indicator on page 146.
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11 Select the Build Slides 
button.

A dialog opens asking whether you would like to add the slides 
to the end of the current presentation or create a new 
presentation. 

Import Dialog

12 Select the Yes button to add 
the slides to the current 
presentation, or select the No 
button to create a new 
presentation.

You now have a fully functional TurningPoint presentation.

13 Save your presentation as a 
PowerPoint slide show.

Next Steps

Find information about running your TurningPoint  presentation in Run Presentations on page 325. 
Customize your slides by adding a variety of animated feedback mechanisms. Find information about 
these different presentation objects and a variety of other slide features in Creating and Saving 
Slides on page 53.



TurningPoint User Guide 291

Comparative Links

Comparative Links

You can use comparative links to compare the responses from several slides on a single slide’s chart.

This is a sample chart comparing the responses from three slides.

Chart with Comparative Links

The bars are grouped by answer. Each answer’s bars include the results for the current slide at the 
left (or top, depending on the chart type), then the results for each linked slide in the order that the 
links are assigned.

A slide can contain up to three comparative links, so you can compare up to four questions. Generally, 
each question you compare should have the same number of answers, since the first answer in the 
answer region is compared to the first answers on the linked slides, the second answer to the second 
answers on the linked slides, and so on.

This section describes how to:

• Set Up Comparative Links
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Set Up Comparative Links

Set up comparative links using the Comparative Links window, available from the Tools menu in the 
TurningPoint toolbar.

Before You Begin

Before you set up a comparative link, first create the slides you would like to compare. A slide can 
contain one to three comparative links, so you can compare up to four questions. Generally, the slides 
being compared should each have the same number of answers.

For the slide on which the comparison will be displayed, use a vertical, horizontal, offset, or doughnut 
chart. Comparisons cannot be displayed using 3D pie or distributed pie charts. The slide on which the 
comparison will be displayed should come after the slides it is being compared to, so that the results 
of those slides are available for display.
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Step by Step Instructions To create a comparative link…

1 From the TurningPoint 
toolbar, select Tools.

The Tools menu opens.

Select Comparative Links
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2 Select Comparative Links 
from the Tools menu.

The Comparative Links window opens.

Comparative Links Window

3 Select the slide to include the 
comparison in the Selected 
Slide drop-down menu.

Comparative Links Window: Select Slide
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4 Select a slide to compare 
with in the Link to Slide drop-
down menu.

Comparative Links Window: Link to Slide

5 Select the Create Link button 
to create the comparative 
link.

The link is displayed in the list of comparative links.

• Repeat steps 3 through 5 
to add additional 
comparative links.

6 Select the Done button. The Comparative Links window closes. TurningPoint adds the 
comparative link to the slide. (The comparison will not be visible 
until you run the presentation session and collect data.)

Next Steps

When you run your presentation session, the charts in slides containing comparative links will 
automatically show comparisons of the data for the linked slides.

You can delete comparative links by selecting the link in the Comparative Links window and selecting 
the Break Link(s) button.
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Conditional Branching

Conditional branching allows you to control the order of slides in your presentation based on the 
responses received from the audience. 

For example, at the beginning of your presentation you might ask the participants to vote whether 
you’ll cover topic A or topic B. Depending on the results of the vote, the presentation will skip ahead to 
the slides for topic A or topic B. 

Or, you might ask a question covering a specific subject area to assess whether the participants 
understand the subject. If most of the participants respond correctly, you can skip ahead to the next 
section of material.

This section describes how to:

• Set Up Conditional Branching

Set Up Conditional Branching

You set up conditional branching by defining a condition, which, if satisfied, advances to the slide you 
specify. Each condition consists of a comparison. The number or percentage of responses for a 
particular answer (or all correct answers) is compared with a specific value, or with the majority of 
responses for that slide.

Set up conditional branching using the Conditional Branching window, available from the Tools menu 
in the TurningPoint toolbar.

Before You Begin

Before setting up conditional branching, you should create the slides for the branches of your 
presentation and plan their order.
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Step by Step Instructions To set up conditional branching…

1 From the TurningPoint 
toolbar, select Tools.

The Tools menu opens.

Select Conditional Branching
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2 Select Conditional Branching 
from the Tools menu.

The Conditional Branching window opens.

Conditional Branching Window

3  Select the slide where the 
branch will begin in the 
Selected Slide drop-down 
menu.

Specify where to branch (which slide to show next) based on the 
outcome of the selected slide’s polling.

Conditional Branching Window: Select Slide
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4 Select Add to add a 
condition.

The Conditional Rules box displays the condition with a default 
name of New Rule. 

Conditional Branching Window: New Rule

5 Optionally, rename the 
condition by selecting 
Rename.

A dialog opens for you to enter the new name of the rule. Select 
OK. TurningPoint changes the name.

Conditional Branching Window: Rename Condition
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6 Optionally, create multiple 
conditions for a slide by 
selecting AND Condition or 
OR Condition as Logical 
Operators.

Select AND Condition to link a conditional branching item to the 
previous item to specify that both conditions should be met. 
Select OR Condition to link a conditional branching item to the 
previous item to specify that either condition can be met.

Conditional Branching Window: And/Or Condition

Note You can link more than two conditional 
branching items for one slide. 



TurningPoint User Guide 301

Conditional Branching

7 Define all conditions in the 
Conditional Branching Rule 
Description by selecting the 
appropriate link. 

Find some examples of conditions in the examples following 
these instructions on page 303.

a Condition - Choose from 
the number or percentage 
of responders that must 
choose the same 
response to satisfy the 
condition. 

Choose from Percentage of Responses, Number of 
Responders, or Majority Rules. 

Conditional Branching Window: Choose Condition

The Compound Rule Condition Box opens and displays 
up to three components of the Compound rule that must 
be selected: Comparison Operator, Value, and Selected 
Answer.

Conditional Branching Window: Compound Rule Condition

• Comparison Operator - Determines if the condition for 
the branch item has been met. You can choose from: 

• Greater Than (>)

• Less Than (<)

• Equal To (=)

• Not Equal To (<>)
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• Greater Than or Equal To (>=)

• Less Than or Equal To (<=)

• Value - Determines the value or percentage to be 
compared to in the next step. For Number of 
Responders, enter a number of responses (from 0 to 
the total number of participants). If you choose 
percentage, enter a percentage of responses (from 1 to 
100).

• Selected Answer - Determines what answer must be 
selected to make the condition true. The number or 
percentage of responses for the selected answer will 
be used in the comparison. You can choose any of the 
answers on the slide. The condition uses the number of 
responses for that selected answer choice.

b  Slide Selection - Choose 
the slide you want to be 
displayed when the 
condition is fulfilled. 

You can branch to any slide in your presentation.

Conditional Branching Window: Slide Selection

8 Repeat steps 4 through 7 to 
add additional independent 
conditions to same slide. 

See examples of how to add multiple conditions to a slide on 
page 303.
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9 Select the OK button in the 
Conditional Branching 
window when you are 
finished adding all conditions 
to the slide.

For Example

The examples below show you how to add a variety of multiple conditions, both linked and 
independent, to a slide.

Example 1 illustrates multiple conditions linked together. All three conditions must be met for 
TurningPoint to branch to the designated slide listed.

Example 1

During the presentation, if one participant selects Cincinnati AND if one participant selects Cleveland 
AND if less than half select Youngstown, then the presentation continues to slide “4 Where is the 
capital of the United States?”.
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Examples 2.1 and 2.2 illustrate two independent conditions added to the same slide.

Example 2.1

Example 2.2

During the presentation, if all participants answer correctly, the presentation continues with slide “5 
Where is the capital of New Mexico?”. Alternatively, if the majority of participants select Cleveland, the 
presentation continues with slide “6 Where is the capital of Virginia?”.
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Examples 3.1 through 3.3 illustrate both linked and independent conditions added to a single slide.

Example 3.1

Example 3.2
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Example 3.3

Alternatively, if one participant selects Cincinnati AND if one participant selects Cleveland AND if less 
than half select Youngstown, then the presentation continues with slide “4 Where is the capital of the 
United States?”. During the presentation, if all participants answer correctly, the presentation 
continues with slide “5 Where is the capital of New Mexico?”. Alternatively, if the majority of 
participants select Cleveland, the presentation continues with slide “6 Where is the capital of 
Virginia?”. 

Next Steps

When you run your presentation session, the slides set up for conditional branching advance to the 
slide you specified if the condition is met.

You can remove a condition by selecting it in the list in the Conditional Branching window and 
selecting the Delete button.
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Parser Documents

The TurningPoint Parser can import two kinds of documents:

• an XML document

• a Microsoft Word document (.doc)

• an Excel spreadsheet (.xls)

To be imported by the TurningPoint Parser, these documents must be formatted in the proper way. 
The following sections describe the proper formats for documents imported by the Parser.

This section describes how to:

• Format XML Documents

• Format Word Documents
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Format XML Documents
The following is a basic shell of the XML document type accepted by the TurningPoint Parser:

<slides count=”” id=””>
<slide id=”” type=”” multiresponse=””>
<question alias=”” filename=”” imageposition=”” />
<topic id=””> 
</topic id>
<answers>

<answer alias=”” value=”” filename=”” />
</answers>

</slide>
</slides>

Each element is described below, along with an example and an explanation of the attributes.

slides

The slides element is the top-level element in the XML document and contains all the information 
TurningPoint requires to create the interactive presentation. The slides element contains a number 
of slide elements.

<slides count=”1” id=”86FF9DB9”>
</slides>

Note Remember that the following characters are 
reserved in XML: < > & ‘ “
Use the XML entities for these characters 
(&lt; &gt; &amp; &apos; &quot; 
respectively).

Attribute Description

count The total number of slide elements in 
the presentation.

id An optional attribute that contains a 
unique identifier for the group of 
slides.
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slide

Each slide element contains the question and answer information for a single slide.

<slide id=”E15F45B” type=”D” multiresponse=”1”>
</slides>

question

The question element contains the question information (as attributes) and the question text (as 
content).

<question alias=”Gender?” filename=”” 
imageposition=””>

What is your gender?

Attribute Description

id An optional attribute that contains a unique identifier 
for the slide.

type Defines what type of slide to create using a single-
letter code. The following types are accepted:

• Q = standard question slide
• P = picture slide
• D = demographic slide
• S = speed scoring slide
• F = fill in the blank slide (ResponseCard IR, XL, 

and RF users are limited to numerical responses, 
but ResponseCard XR and ResponseWare App 
users may provide alphanumeric responses of 
varying lengths)

• E = essay slide (ResponseCard IR, XL, and RF 
users are limited to numerical responses, but 
ResponseCard XR and ResponseWare App 
users may provide alphanumeric responses of 
varying lengths)

• M = moment to moment slide 

multiresponse An optional attribute that contains the number of 
responses allowed per response device for the slide. 
Accepted values are 1–10.
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</question>

topic

The topic element contains the question topic.

<topic id=””></topic>

answers

The answers element contains a number of answer elements.

<answers></answers>

answer

Each answer element contains answer information (as attributes) and the answer text (as content) 
for a single answer.

<answer alias=”” value=”” filename=””>
Female

</answer>

Attribute Description

alias An optional attribute that contains an 
alias for the question.

filename An optional attribute that contains a 
filename for a picture that can be 
included with the question.

imageposition An optional attribute that sets the 
question picture position. The 
following are acceptable values:

• L = Left
• R = Right
• F = Full

Attribute Description

id An optional attribute that contains a 
unique identifier for the topic.
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Attribute Description

alias An optional attribute that contains an alias for the 
question.

value An optional attribute that contains a value for the 
answer. Valid answer values are “Correct”, 
“Incorrect”, or a point value from negative 10,000 
through 10,000. 

filename An optional attribute that contains a filename for a 
picture that can be used in place of the answer text 
on the slide. This attribute is used only if the slide 
type attribute is set to “P”.
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Format Word Documents
To create a Word document to be imported by the TurningPoint Parser, you must create an outline 
using the heading styles built into Word. You can apply the heading styles using the drop-down menu 
in the Formatting toolbar, or in the Styles and Formatting pane available through the Format menu.

Each question must use the “Heading 1” style. The question is followed by several answers on 
separate lines using the “Heading 2” style.

In addition to the question and answer text, you can use optional TurningPoint tags to control other 
settings. Each TurningPoint tag must use the “Heading 3” style. Tags occur at the start of the outline 
(for tags that apply to the entire presentation) or on the lines immediately following a question or 
answer (for tags that apply only to a specific question or answer). A tag is formatted in the following 
way:

<tag>value

All tags are optional. If omitted, the slide will default to a standard question slide.

The tags are described in the following table.

Tag Location Description and Allowed Values

<c> Start of 
outline.

The number of slides in the presentation.

<d> Start of 
outline or 
following a 
question.

Contains the Session ID (if at the start of the outline) 
or topic ID (if following a question).

<a> Following a 
question or 
an answer.

Contains an alias for a question or an answer.
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<t> Following a 
question.

Defines what type of slide to create using a single-
letter code. The following types are accepted:

• Q = standard question slide
• P = picture slide
• D = demographic slide
• S = speed scoring slide
• F = fill in the blank slide (ResponseCard IR, XL, 

and RF users are limited to numerical responses, 
but ResponseCard XR and ResponseWare App 
users may provide alphanumeric responses of 
varying lengths)

• E = essay slide (ResponseCard IR, XL, and RF 
users are limited to numerical responses, but 
ResponseCard XR and ResponseWare App 
users may provide alphanumeric responses of 
varying lengths)

• M = moment to moment slide 

<f> Following a 
question or 
an answer.

The filename of a picture file. If the tag follows a 
question, the picture will be added next to the 
question text on the slide. If the slide type is “P” and 
the tag follows an answer, the picture will replace the 
answer text on the slide.

<n> Following a 
question.

Contains the question picture position. The following 
are acceptable values:

• L = Left
• R = Right
• F = Full

<m> Following a 
question.

Contains the number of responses allowed per 
ResponseCard for the slide. Accepted values are 1–
10.

<p> Following a 
question.

Contains the question topic. 

<v> Following 
an answer.

Contains a value for the answer. Valid answer values 
are “Correct”, “Incorrect”, or a point value from 
negative 10,000 through 10,000. 

Tag Location Description and Allowed Values
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Format Excel Documents
You can format an Excel spreadsheet so that it can be used with the TurningPoint Parser. The 
TurningPoint Parser will only use the data displayed in the first sheet of an Excel Workbook to create 
question slides. Figure 3-1 displays a sample Excel spreadsheet that contains information to create 
four TurningPoint slides.

Figure 3-1

Figure 3-1 displays four questions and their corresponding answers. Column A contains Question 
Text, columns B through K may contain Answer Text, and all columns that follow after column K are 
ignored by the TurningPoint Parser. The text does not have to be in any specific font. If you want to 
use Questions and Answers only, there must be a blank line after each Answer row.  If you wish to 
use tags, use one row for the Question and Answer Text, one row for all of the tags (multiple tags are 
allowed per cell, see cell D3 in Figure 3-1), and one blank row below the tags.  Make sure to include 
only one blank row between each tag row and the following Question row.  As soon as the 
TurningPoint Parser detects two blank rows, it will stop searching for text.

The spreadsheet also contains several TurningPoint tags that allow the TurningPoint Parser to 
process additional information about the format of slides. A detailed listing of the TurningPoint tags 
and how they are used in figure 3-1 is shown below in figure 3-2. This table explains how the tags are 
used in figure 3-1 to format interactive slides. The tags are not case sesitive. 

Figure 3-2

Tag Cell # Description and Allowed Values

<d> A1 Session ID

A2, or any 
untagged row in 
column A

Question Text
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<a> A6, or directly 
below any 
Question Text

Question Alias Text

<t> A3 or directly 
below Question 
Text

Defines what type of slide to create using a single-
letter code. The following types are accepted:

• Q = standard question slide
• P = picture slide
• D = demographic slide
• S = speed scoring slide
• F = fill in the blank slide (ResponseCard IR, XL, 

and RF users are limited to numerical responses, 
but ResponseCard XR and ResponseWare App 
users may provide alphanumeric responses of 
varying lengths)

• E = essay slide (ResponseCard IR, XL, and RF 
users are limited to numerical responses, but 
ResponseCard XR and ResponseWare App 
users may provide alphanumeric responses of 
varying lengths)

• M = moment to moment slide 

A2, B2, C2, or 
any cell directly 
to the right of 
Question or 
Answer Text

Answer Text

<f> B3, C3, D3, or 
directly below 
Answer Text

The filename of a picture file. If the tag follows a 
question, the picture will be added next to the 
question text on the slide. If the slide type is “P” and 
the tag follows an answer, the picture will replace the 
answer text on the slide.

<n> In the cell 
directly beneath 
the Answer Text

Contains the question picture position. The following 
are acceptable values:

• L = Left
• R = Right
• F = Full

<m> In the cell 
directly beneath 
a question

Contains the number of responses allowed per 
ResponseCard for the slide. Accepted values are 1–
10.

Tag Cell # Description and Allowed Values
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<p> In the cell 
directly beneath 
the Question 
Text

Contains the question topic. 

<v> B6, C6, D6, or 
preceding any 
numerical 
Answer Text

Contains a value for the answer. Valid answer values 
are c or C for Correct, i or I for Incorrect, or a point 
value from negative 10,000 through 10,000. 

Tag Cell # Description and Allowed Values
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Import Slides

TurningPoint can automatically create TurningPoint slides from Microsoft Word files, XML files, or 
TestingPoint files.

Using this feature of TurningPoint provides a quick way to create a number of slides, and it is also 
beneficial if you already have question and answer data in another form that you would like to 
transform into TurningPoint slides.

A simple slide presentation can be created by importing a an XML document, Microsoft Word 
document, or an Excel document using the TurningPoint Parser. Alternatively, you can import 
question and answer data from TestingPoint.

This section describes how to:

• Import Slides with the TurningPoint Parser

• Import Slides from TestingPoint

Import Slides with the TurningPoint Parser

The TurningPoint Parser is located in the Tools menu and allows you to automatically create slides 
from Microsoft Word or XML files. 
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Step by Step Instructions To import slides with the TurningPoint Parser…

1 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.

Select Update Parser Template

2 (Optional) Select Update 
Parser Template.

TurningPoint imports slides with default characteristics that may 
not match your settings. You can use the Update Parser 
Template command to update the imported slides to match your 
settings.
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3 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.

Select TurningPoint Parser
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4 Select TurningPoint Parser. A dialog window opens.

Dialog Window

5 Navigate to the file you would 
like to import (.xml, .doc, 
.doc, .xls, .zip) and select it.

6 Select the Open button to 
continue.

A dialog opens asking whether you would like to add the slides 
to the end of the current presentation or create a new 
presentation.

7 Select the Yes button to add 
the slides to the current 
presentation, or select the No 
button to create a new 
presentation.

TurningPoint builds the slides from the file. If there are many 
slides, this may take some time.

Next Steps

The slides imported by the TurningPoint Parser are normal TurningPoint slides, so you can take 
advantage of any the TurningPoint customizations you would like to make on them.
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Import Slides from TestingPoint

TurningPoint can insert files from TestingPoint and create slides based on them. TurningPoint retains 
the features used in the TestingPoint files.

Step by Step Instructions To import slides from TestingPoint…

1 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.

Select TestingPoint
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2 Select Import from 
TestingPoint.

A dialog opens.

Import a TestingPoint Document dialog

3 Navigate to the file you would 
like to import and select it.

4 Select the Open button to 
continue.

A dialog opens asking whether you would like to add the slides 
to the end of the current presentation or create a new 
presentation.

Import Dialog Box

5 Select the Yes button to add 
the slides to the current 
presentation, or select the No 
button to create a new 
presentation.

TurningPoint builds the slides from the file. If there are many 
slides, this may take some time.
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Where Do I Go From Here?

This chapter has demonstrated how to use tools with TurningPoint. After you create your TurningPoint 
slides, you are ready to run a presentation. 

Chapter 7: Run Presentations describes the process of running a presentation. 
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Run 
Presentations

After you have created the slides and objects discussed in Chapter 3: Creating and Saving Slides, 
you are ready to run an interactive presentation. The process of running a presentation requires a few 
preliminary steps and offers some options and tools that this chapter demonstrates for you.

Each time you run a presentation, TurningPoint creates a unique session. A session is made up of 
data pertaining to the response devices, the participants in the audience, and the responses of the 
participants. This data typically saves to the computer that is running the presentation. 

To run a presentation:

• Establish the settings for gathering and storing responses on the computer that runs the 
presentation. The settings are made up of the results data, which may need to be reset, the 
response devices, and the Participant List. Optionally, the settings could include preferences for 
the Response Grid, especially if infrared ResponseCards are used.

• Run a presentation session. A session is similar to running a typical PowerPoint slide show, but as 
you present, the Showbar is initially available at the top of the screen during interactive slides. The 
Showbar can be moved to any location on the screen by selecting the appropriate icon. The 
Showbar allows you to open and close polling, view polling status, and view the response data in 
a variety of ways. 
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• Save a session. You can save the results of your interactive presentation and generate reports 
through TurningPoint to evaluate the audience’s responses. You will want to save the responses 
provided by your audience for each presentation session. 

You can perform test runs or present the completed presentation to your audience. Behind the 
scenes, TurningPoint gathers, tallies, and stores the responses from your audience. You can choose 
to share the results of the session with the audience or keep them confidential.

Recall the five steps to presentation success. As depicted in the following diagram, running a 
presentation session is the fourth step when using TurningPoint.

Five Steps to Success

This chapter describes the following activities to help your presentation run smoothly:

• Run an interactive presentation using the Slide Show functionality. Find instructions for running a 
presentation in Run a Presentation on page 328.
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• Control the presentation using the Showbar. Find instructions for using the Showbar in Run the 
Slide Show on page 333 and View Polling Status on page 337.

• Monitor the audience participation. Find instructions for monitoring in View Polling Status on 
page 337 and Use the Participant Monitor on page 340.
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Run a Presentation

You run an interactive presentation session using PowerPoint’s Slide Show functionality. 

You control the presentation session by opening and closing polling. Polling is the mechanism by 
which TurningPoint accepts and tallies the responses provided by the audience using response 
devices.

This section describes how to:

• Establish the Presentation Settings

• Run the Slide Show

• View Polling Status

• Use the Participant Monitor

• Add Slides During a Presentation Session

• Use Data Slicing (View Results by Question)

Establish the Presentation Settings

The presentation settings consist of the results data and Participant List to be used, which are 
important items to check before running the presentation.

Prior to starting a presentation session, you must perform the following steps: 

• Clear any previous session results.

• Identify the Participant List to be used.

This section explains how to perform these steps. It also demonstrates how to create the settings for 
the Response Grid, an option especially helpful to sessions with infrared ResponseCards, that gives 
participants confirmation that their responses were received.

Before You Begin

Chapter 4 discusses the response devices you set up before you begin. Find information on getting 
the response devices ready in Chapter 4: Response Device and Settings Management.
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If you are using ResponseCards or the ResponseWare App, you can use the Polling Test feature to 
test TurningPoint’s ability to successfully receive responses. Find information on Polling Test in 
Chapter 4: Response Device and Settings Management. 

If you want to track responses, you must have also created a Participant List using the Participant List 
Wizard. Without a Participant List, the session collects anonymous responses and generates an 
automatic participant list. Find information on Participant Lists in Chapter 5: Track Participants and 
Teams.

Step by Step Instructions To create the settings for the presentation session…

1 From the PowerPoint Office 
menu, select Open.

A window opens and displays the available files.

2 Select the TurningPoint 
presentation to be used, and 
select the Open button.

The file’s contents are visible in the PowerPoint window. You 
can use the TurningPoint toolbar to clear any previous results 
data and identify the use of response devices and a Participant 
List.

3 From the TurningPoint 
toolbar, select Reset > 
Session.

Reset Sessions

Prior to starting the presentation session, you must clear all 
prior audience responses that are stored in memory. 

If you select Reset > All Slides, new data is appended to the end 
of the session without resetting the entire session. If you select 
Reset > Current Slide, you remove values for the current slide 
without removing the data from the session.

TurningPoint displays a window instructing you to wait until all 
responses have been cleared before continuing with your slide 
show.
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4 Optionally, from the 
TurningPoint toolbar, select 
the Response Device menu 
and select an option for 
testing the presentation.

Response Device Selection

Response Devices is the default setting. TurningPoint allows 
you to select how responses will be provided during the 
presentation. Your choices are:

• Response Devices—a response device will be used 
during the presentation. The response device must have 
been set up as outlined in Chapter 4: Response Device 
and Settings Management.

• Keyboard Keys 0–9—you will provide input to the 
presentation using the keyboard, keypad, or number 
keys.

• Simulated Data—TurningPoint provides random 
responses to the presentation. TurningPoint determines 
the number of responses to provide based on the number 
of expected devices designated in settings. i.e. If you 
enter expected devices as 100, TurningPoint will provide 
100 responses to each question in your presentation. 
Find more information on expected devices in Enable 
ResponseWare App on page 177.

Note Always use the Response Devices default 
setting for an actual presentation. Select 
Keyboard Keys 0-9 or Simulated Data when 
testing a presentation.
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5 Optionally, from the 
TurningPoint toolbar, select 
Tools > Settings. In the 
window, select the 
Presentation from the 
Settings Hierarchy.

The TurningPoint Settings window opens.

Settings Window

Use these settings to establish the settings for the entire 
presentation. You can establish the settings for a specific slide 
or answer by selecting that slide or answer, respectively, from 
the Settings Hierarchy. Find more information about modifying 
settings in Response Device and Settings Management on 
page 157. 

If infrared ResponseCards are used, it is recommended that you 
use a Response Grid, which gives participants confirmation that 
their responses are received. The Response Grid is 
unnecessary with radio frequency and ResponseWare App 
devices provide on-screen confirmation that responses have 
been received. The following settings affect the presentation 
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and style of the Response Grid that can be shown during an 
interactive slide show. 

Response Grid

These settings affect what is displayed in each box of the 
Response Grid. 

• Display Device IDs—select True to include the deviceID 
field in the Response Grid.

• Display Participant Names—select True to display the 
participant’s name in the Response Grid.

These settings affect how the Response Grid is displayed.

• Grid Opacity—enter a percentage to identify how opaque 
the Response Grid should be when opened.

• Grid Position—choose a selection from the menu to 
identify where the Response Grid should be positioned 
on the screen. The selections include Top, Bottom, Left, 
Right, Center, TopLeft, TopRight, BottomLeft, and 
BottomRight.

• Grid Rotation Interval—enter the number of seconds per 
interval the Response Grid takes to rotate through 
responses. This is needed when there are too many 
participants to fit in one grid.

Note A Response Grid is recommended for use 
with infrared ResponseCards to give 
participants confirmation that their responses 
are received. Other options for tracking 
responses, such as a Response Counter or 
Response Table, are located in the Insert 
Objects menu. Find information on these 
objects in Add Objects on page 130.
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• Grid Size—identifies how wide and tall the Response Grid 
should be on the screen. The height and width are 
measured in pixels. The default setting is 1024 x768 (or 
full screen).

• Maximum Grid Width—identifies how wide the Response 
Grid should be on the screen. The width is measured in 
pixels. The default setting is 800.

• Use Scheme Colors—Determines if Scheme Colors or 
Custom Colors will be displayed on the Response Grid as 
established in Chart Settings.

Next Steps

After establishing the settings, you are now ready to run the presentation.

Run the Slide Show

Use PowerPoint’s Slide Show functionality to run your interactive presentation. TurningPoint accepts 
responses provided by your audience, presents the results of the responses, and stores the 
responses in memory. You either save the responses to a session file or clear the memory.

Before You Begin

To run the slide show, you must first perform the steps listed under Establish Presentation Settings to 
create the settings for your presentation session.

Step by Step Instructions To run the interactive presentation…

1 From the PowerPoint menu, 
select Slide Show > View 
Show, or press the F5 key.

The first slide of the presentation is shown. TurningPoint 
displays the Showbar in the top right corner of the screen. The 
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Showbar is a toolbar that provides activation buttons for polling, 
monitoring, and viewing responses during the slide show.

Showbar

Right-click on the Showbar and move your cursor across the 
Showbar to display each command’s name. To activate the 
command, you can select the Showbar icon or use the 
respective Fn key on your keyboard. Use the commands on the 
Showbar as follows:

F9-Show/Hide 
Showbar 

Closes the Showbar for the 
duration of the current 
presentation session.

F2-Toggle 
Results

Changes the values displayed 
on each chart. The values can 
be represented as either 
numbers or percents.

F3-Data Slicing Shows the responses on the 
chart for the portion of the 
audience who chose a certain 
response on another question.

F6-Show the 
Original Chart

Use this command after using 
the Toggle Results or Data 
Slicing commands to return the 
chart to its appearance when it 
was first created.

F4-Repoll 
Question

Clears the responses and 
accepts new responses from 
the audience for the currently 
displayed question. Both the 
original responses and the new 
responses are stored in the 
session file.
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F7-Show the 
Response Grid

Opens a Response Grid on the 
screen allowing you to see 
which participants have 
responded to the question.

The size, location, visual 
display, and contents of the 
grid are controlled in the 
Presentation Settings. Find 
more information about 
settings in Establish the 
Presentation Settings on 
page 328.

F8-Show Non-
Response Grid

Opens a Response Grid on the 
screen. As each participant 
responds to a question, their 
response box is removed from 
the grid.

The size, location, visual 
display, and contents of the 
grid are controlled in the 
Presentation Settings. Find 
more information about 
settings in Establish the 
Presentation Settings on 
page 328.

F10-Go to Next 
Slide

Advances the slide show to the 
next slide.

F12-Display 
Participant 
Monitor

Opens the Participant Monitor. 
Find more information in Use 
the Participant Monitor on 
page 340.

F5-Insert Slide Select the down arrow to open 
a drop-down menu allowing 
you to select the slide type to 
be inserted into the 
presentation. Select the icon to 
open a window askind for a 
question and answers.



336 Turning Technologies

Chapter 7: Run Presentations

2 Click the mouse to control the 
progress of the slide show. 

The control of each slide will vary slightly depending on the 
objects you choose to insert when you create the slides. Find 
information on slide objects and their behavior in Add Objects 
on page 130.

a Open polling. Polling will 
automatically open when 
you display a slide.

TurningPoint receives responses when polling is open.

Polling Open

b Click a second time to 
close polling and display 
the results.

No responses are accepted when polling is closed.

Polling Closed

c Click again to advance to 
the next slide.

3 Click at the end of the slides 
to exit from the Slide Show 
(or optionally, press the Esc 
key).

If you exit TurningPoint, the program prompts you to name and 
save the session results to a file. The default location is My 
Documents/TurningPoint/Sessions. If you choose the default 
name, TurningPoint adds the date and time to the file name. If 
you choose to name it specifically, the name you enter is stored.

Display 
interactive results

Expands the Showbar to 
display the responses, user 
feedback, and polling status. 

Press for 
moveable 
Showbar

Allows the Showbar to be 
moved anywhere on the 
Screen.

Note To advance slides, you may use any method 
PowerPoint allows, such as clicking the mouse 
or pressing the space bar, arrow keys, or Enter 
key.
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For every session, TurningPoint automatically creates a backup 
copy and stores it at My 
Documents\TurningPoint\Sessions\Backup.

You can set TurningPoint to automatically delete old backup 
sessions using the Backup Maintenance setting, a presentation-
level setting. In the Backup Maintenance field, enter the number 
of days you want to keep files. TurningPoint will eliminate 
backup sessions created before that time. Find more 
information on modifying settings in Response Device and 
Settings Management on page 157.

View Polling Status

TurningPoint provides three mechanisms to see how many participants have responded to the 
question when polling is open. You can expand the Showbar to see how many responses are 
received. You can display a Response Grid, or you can open the Participant Monitor to see the full 
details of the audience responses.

This section describes using the expanded Showbar and the Response Grid to view participant 
results. Find more information about the Participant Monitor in Use the Participant Monitor on 
page 340.

Tip Store your session file in the Sessions folder 
suggested by TurningPoint to allow the session 
file to be used again by TurningPoint to restart 
sessions or generate reports. Find information 
about reports in Reports on page 351.
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Step by Step Instructions To view the polling results…

1 On the Showbar, select 
Display Interactive Results. 

The Showbar expands to display three additional regions that 
show the polling status. The number in the Responses column 
is updated as responses are received.

Showbar Expansion

i-Display 
Interactive 
Results

Displays the responses, user 
feedback, and polling status. 
The Showbar toggles from the 
default setting from fully visible 
to invisible on the slide.

Press for 
moveable 
Showbar

Allows the Showbar to moved 
anywhere on the Screen.

Responses Identifies the number of 
responses received from the 
audience. This area is visible 
when the slide show starts 
unless you set the Expand 
Showbar setting to False.

User Feedback Shows the typed questions for 
ResponseWare App devices. 
For ResponseCards, shows 
the presses of the question 
mark key. Response Cards can 
only respond with the question 
mark once per slide, while 
ResponseWare Apps can 
submit multiple answers per 
slide.

Polling Identifies whether polling is 
open or closed. The 
background of this region is 
green when polling is open and 
red when closed.
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This step may meet all your needs for viewing polling status. 
You also have the option to use the Response Grid explained in 
step 2, especially if you use infrared responsecards.

2 Optionally, display a 
Response Grid during the 
session. From the Showbar, 
select the Show Response 
Grid button.

The Response Grid is a grid that is overlaid on a slide during the 
presentation and indicates which individuals enter responses. 
Similarly, the Non-Response Grid indicates which participants 
have yet to respond. Specifically helpful to participants using 
infrared devices, these grids give the participants confirmation 
that their responses were received. Radio frequency and 
ResponseWare App devices display confirmation right on the 
device.

Response Grid

The Response Grid can be shown or hidden at will by selecting 
the Show Response Grid button. When this button is selected, 
the Response Grid does not display.

3 After polling closes, click the 
mouse to advance to the next 
slide.

Viewing the polling status becomes disabled in the Showbar 
until you activate another poll. If you do not want to display the 
Showbar expansion, the the Expand Showbar setting to false. 

Note A Response Counter or Response Table are 
two other options for viewing polling status that 
can be added when you create the slides, 
before you run the presentation.
The Response Counter shows how many 
participants have responded, while the 
Response Table, which can be fixed or rotating, 
shows who has responded. A fixed table 
displays all the participants, ideal for groups 
with 40 or fewer participants. The rotating table 
is best for very large groups and displays 
participants in sets of 40.
Find information about inserting objects in 
slides in Add Objects on page 130.
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Expand Showbar is a presentation-level setting. Find more 
information about modifying settings in Response Device and 
Settings Management on page 157.

Use the Participant Monitor

The Participant Monitor shows which participants have responded to a question and displays details 
about the responses, such as the percentage of correct responses, how long participants took to 
respond, and which answers they chose. Use of the Participant Monitor is optional, but it is helpful if 
you would like to keep track of how people are responding during your presentation.

You can access the Participant Monitor from the Showbar while the slide show is running, or from the 
TurningPoint toolbar under the Participants drop-down menu after you end the slide show. 

Step by Step Instructions To monitor participants…

1 While running the slide show, 
from the Showbar select the 
Display Participant Monitor 
button.

Showbar Expansion: Display Participant Monitor

Note If you want to limit the Participant Monitor to 
your eyes only, then you can set up a second 
monitor for displaying it. Find information about 
setting up a second monitor in Windows Help 
and Chapter 4: Response Device and 
Settings Management. 
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Alternatively, you can display the Participant monitor after 
running a slide show by selecting Participants > Display 
Participant Monitor from the TurningPoint toolbar.

Participants Menu: Display Participant Monitor

TurningPoint opens the Participant Monitor window displaying 
Question, Participant, and Individual details about each 
participant’s response and the percentage of correct answers. 

Participant Monitor Window
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The Question Region lists all of the questions and the Overall 
percentage correct for the group and the total point value per 
question.

Participant Monitor Window: Question Region

The Participant Region lists the details about the participant, 
overall percentage of correct answers, total points 
accumulated, and the response time and response for the 
question selected in the Question Region.

Participant Monitor Window: Participant Region
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The Individual Region lists details about the response results for 
each participant for each question in the presentation. 

Participant Monitor Window: Individual Region

2 You can hide one or more of 
the three regions by selecting 
the close button (X) in the 
upper right corner. To view a 
region you have hidden, 
select it from the View menu 
in the Participant Monitor 
window. 

When viewing the Participant Monitor while running the slide 
show, the Participant Monitor window must be closed to 
advance to the next slide. To view the window again, press the 
F12 key. (Alternatively, you can also press the Alt + Tab keys, 
or simply end the slide show.)

Participant Monitor Window: View Menu
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3 Optionally, you can expand 
or reduce the size of the three 
regions by selecting the 
borders and dragging them 
up or down. 

Add Slides During a Presentation Session

TurningPoint gives you the flexibility of adding a template or custom slide while running the 
presentation. Inserting a new slide is an option available at your fingertips through the Showbar. 

Step by Step Instructions To add a new slide…

1 Insert a new slide in one of 
the following ways:

• Template Slide - select the 
arrow next to the Insert an 
on-the-fly slide button on 
the Showbar and select 
the type of slide. The slide 
is automatically inserted 
after the slide you had 
been viewing in the 
presentation.

A drop-down menu opens from the Showbar allowing you 
to select the slide type to be inserted into the 
presentation.

Showbar Expansion: Insert a Template Slide

The slide is automatically inserted.
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• Custom Slide - select the 
Insert an on-th-fly Slide 
drop-down menu on the 
Showbar, select Custom, 
and go to step 2.

 Showbar Expansion: Insert a Custom Slide

The Custom Question window opens to display the fields 
for typing the question and answer choices to be used on 
the interactive slide.

 Insert Slide: Custom Question
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2 Enter the question in the top 
region of the window. Enter 
the answer choices in the 
lower region, separating each 
answer with a line break.

 Insert Slide: Custom Question

• If you select the the Insert 
Slide button, the Custom 
Question window is 
displayed.

3 Select the Insert button.

Use Data Slicing (View Results by Question)

After receiving response data, TurningPoint can cross-reference the responses of one question to 
another set of responses. This function, called data slicing, is particularly useful for analyzing 
demographic information. For example, you can find out whether a certain age group in the audience 
prefers a certain type of music. By asking participants to identify their age group in one question, and 

Note If you would like to reuse the presentation with 
the newly added slide, save the file. From the 
PowerPoint menu, select File > Save As. If you 
forget, TurningPoint asks you before closing.
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later asking them to pick their favorite type of music, you use data slicing to find out how many young 
adults in the crowd prefer R&B music, how many seniors prefer big-band music, and so on.

Before You Begin

To measure demographic information, insert a question slide early in the presentation that asks the 
audience to identify themselves in a demographic category, such as an age group or gender.

Step by Step Instructions To use data slicing…

1 Run the presentation. (From 
the PowerPoint menu, select 
View > Slide Show.)

2 Use the arrow keys to go to 
the primary question slide 
whose data you want to slice.

For the example, to find out whether a certain age group in the 
audience prefers a certain type of music, you would go to the 
question slide that asks participants to select a favorite type of 
music. 

3 From the Showbar, select the 
Data Slicing button.

The Data Slicing window opens and displays a list of all 
questions from the interactive slides followed by their answers. 

Showbar Expansion: Data Slicing

Note To use demographic information in reports, 
identify a slide as a demographic question in 
the TurningPoint settings at the slide-level. Set 
the Demographic setting to True. Find more 
information in Response Device and Settings 
Management on page 157 and Reports on 
page 351.
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4 Select the answer whose 
data you wish to reference in 
the primary question slide. 

For the example, to find out how many young adults prefer each 
type of music, you would select the 18–35 age range.

Data Slicing

5 Select the Select button. TurningPoint retabulates the data to show the new distribution. 
Instead of viewing the results for the entire audience, you see 
the distribution for only the participants in the audience who 
submitted the selected answer. 

After you have displayed a data slice, you can select a number 
on the keyboard corresponding to an answer to see the slice 
associated with that answer. You can also cycle through groups 
that have responded by pressing the G key. When finished 
viewing the data slices, press the F6 key to return to the original 
chart.

6 To return the chart to its 
original data, press the F6 
key.
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Where Do I Go From Here?

This chapter has demonstrated how to run and manage presentations.

You are now ready to begin reviewing reports and understanding presentation data. You can find 
information in Chapter 8: Reports.
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Turning Reports allows you to generate and view a wide variety of reports based on the responses 
you received during your TurningPoint, TurningPoint Anywhere, or TestingPoint sessions. The reports 
are generated as printable Word documents or Excel worksheets with information about the questions 
and answers, participants, and responses gathered in your presentation. Turning Reports displays a 
hierarchical menu of reports organized by category, such as Results by Question Reports and 
Demographic Reports. If you click on one of these categories, the Turning Reports screen displays 
subheadings of specific report titles, and shows samples of each selected report.

Thirty-one reports are available for reporting on the entire audience, by individual participants, by 
groups, by standards, and on the basis of demographics. If you have specified correct answers or 
point values, you can “grade” participants and groups, verify that standards are met, and provide 
valuable feedback to participants.
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View a Report

You can create reports using Turning Reports available in the Tools menu in the TurningPoint toolbar.

This section describes how to:

• View a Report

View a Report

Use Turning Reports to generate reports.

Before You Begin

Create a session file by running a presentation session. Find more information in Chapter 7: Run 
Presentations.
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Step by Step Instructions To view a report…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Turning Reports

2 Select Turning Reports from 
the Tools menu.

The Turning Reports window opens, displaying two tabs: 
Sessions and Reports.
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3 Select the Sessions tab. The Turning Reports window displays a list of the session files 
in your Sessions folder.

Turning Reports: Select Session

You can toggle which files are displayed in the list by selecting 
My Session Files or My Backup Session Files. Find more 
information about where your session files are stored in Save 
Results from a Session on page 393.

4 Choose a session file. You may choose a session file in one of the following ways:

• Select the Current Session 
(in red text) to use the 
session currently open in 
PowerPoint.

This option is available only if you have a TurningPoint 
presentation open and response data has been collected.

• Select a session file from 
the list of files in your 
Sessions folder.

To display the session files from your Sessions folder in 
the list of files, select My Session Files. 

• Select a session file from 
your backup session files.

To display the backup session files in the list of files, 
select My Backup Session Files. 

• Import a session file from 
another location.

You can also import a session using the Import Session 
button (shaped like a folder) above the list of files. This 
allows you to use TurningPoint, TurningPoint Anywhere, 
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and TestingPoint session files you have stored 
elsewhere.

5 Select the Reports tab once 
you have selected a session 
file.

The Turning Reports window displays a list of the categories of 
reports you can generate from your session file.

Turning Reports: Generate Reports

Each category of reports is listed by name. You can double-click 
the category or click on the plus sign beside the category to view 
a list of reports in each category. The icon beside the report 
name indicates whether it generates an Excel file or a Word file. 

When you select a report, you can see a sample preview of the 
report on the right-hand side of the Turning Reports window.

6 Select the type of report(s) 
you would like to generate by 
selecting the check box next 
to the report name.

Find more information in Types of Reports on page 358.

You can select multiple reports by selecting multiple check 
boxes. You can also select an entire category of reports by 
selecting the check box for the category.
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You can change numeric responses to alphabetic responses by 
checking the Change numeric responses to alphabetic 
responses check box.

Click Change Numeric Responses...

Depending on the type of report you select, the Include Page 
Breaks check box may be displayed below the report preview.

Include Page Breaks
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7 Specify whether to include 
page breaks in the report by 
checking the Include Page 
Breaks check box (if 
available).

If you check the box, TurningPoint will create page breaks at 
convenient places in the report for ease of printing.

8 Select the Generate Report 
button.

Turning Reports generates the report(s) and opens it in 
Microsoft Excel or Word, which ever is appropriate.

This may take some time, especially if you selected to generate 
a large number of reports or if there are a large number of 
questions or participants in the session.

You can generate as many reports as you like. When one report 
is finished being created, select another type of report from the 
list and select the Generate Report button again.

9 When you are finished 
creating reports, select the 
Exit button to close the 
Turning Reports window. 

Next Steps

You can use Excel or Word to edit, save, or print the reports.

Note If you selected to generate multiple reports, 
one Excel file is created with worksheets for 
each report. 

Note Alternatively, you can generate a report by 
double clicking on the report name. Only that 
report will be generated. Any other reports 
that were selected will have to be generated 
by double clicking each report or selecting 
the Generate Report button to generate them 
all.
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Types of Reports

This section describes:

• Results by Question Reports (2 Reports)

• Demographic Reports (2 Reports)

• Participant Results Reports (4 Reports)

• Results by Participant Reports (4 Reports)

• Participant List Reports (2 Reports)

• Standards Reports (3 Reports)

• Comparative Scoring Reports (2 Reports) 

• Team Scoring Reports (2 Reports) 

• Percentile Reports (2 Reports) 

• Other Reports (8 Reports)

• Attendance Report

• Moment to Moment Report

• Outline Report

• Response Data Export Report

• Ranking Summary Report

• Results by Group Report

• Statistics Report
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Results by Question Reports
The Graphical Results by Question and Results by Question Reports show a summary of responses 
for each question. Each of these reports creates an Excel worksheet.

Graphical Results by
Question Report

The report includes the following information for each question:

• the answers

• an indication of the correct answer(s)

• the number of responses for each answer

• the percentage of responses for each answer

• pie chart with a percentage of the responses per answer

Graphical Results by Question Report
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Results by Question Report

The report includes the following information for each question:

• the answers

• an indication of the correct answer(s)

• the number of responses for each answer

• the percentage of responses for each answer

• the total count of participants that responded to the question

Results by Question Report
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Demographic Reports
The Demographic Comparison and Graphical Demographic Comparison Reports show a summary of 
responses for each question broken down by demographics. Each of these reports creates an Excel 
worksheet.

Demographic Comparison
Report

The Demographic Comparison Report includes the following information for each question:

Demographic Comparison Chart

Graphical Demographic
Comparison Report

The Graphical Demographic Comparison includes the following information for each question:

• the answers

• an indication of the correct answer(s)
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• the percentage of responses for each answer from each group

• a vertical bar chart of the responses for each answer from each group

When generating the Graphical Comparison Report, you have the option of creating page breaks 
between each question.

Graphical Comparison Report
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Participant Results Reports
The Participant Results, Graded Participant Results (correct/incorrect), Graded Participant Results 
(point values), and Graded Participant Results (ratio) Reports show a detailed question by question 
breakdown of responses. When generating these reports you have the option of displaying the entire 
question or excluding the question text. Each of these reports creates an Excel worksheet.

Participant Results Report

The report includes the following information for each participant: 

• Device ID 

• fields defined in the Participant List

• the numerical value of the participant’s response to each question

Participant Results Report

Graded Participant Results
(correct/incorrect) Report

The report includes the following information for each participant: 

• Device ID 
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• fields defined in the Participant List 

• the numerical value of the participant’s response to each question

• an indication of whether the response is correct or incorrect

• total percent correct 

Graded Participant Results (correct/incorrect) Report

Graded Participant Results
(point values) Report

The report includes the following information for each participant: 

• Device ID 

• fields defined in the Participant List 

• the numerical value of the participant’s response to each question

• an indication of whether the response is correct or incorrect
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• the total number of points 

Graded Participant Results (point values) Report

Graded Participant Results
(ratio) Report

The report includes the following information for each participant: 

• Device ID 

• fields defined in the Participant List 

• the numerical value of the participant’s response to each question

• an indication of whether the response is correct or incorrect

• the ratio of correct answers to total number of answers for each question 

Graded Participant Results (ratio) Report
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Results by Participant Reports
The Results by Participant, Results by Participant (Answer Detail), Response by Participant 
(Response Detail), Results by Participant (Score Detail) show a detailed listing of responses for each 
question from each individual participant. Each of these reports create an Excel worksheet.

When generating these reports, you have the option of creating page breaks between each 
participant’s section.

Results by Participant Report

The report includes the following information for each participant for each question:

• the question

• the numerical value of the participant’s response

• an indication of whether the response is correct or incorrect

• the correct answer

Results by Participant Report
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Results by Participant
(Answer Detail) Report

The Answer Detail Report includes a complete list of answers for each question. The list enables you 
to match the numerical value of the participant’s response (number 1 or 2, etc.) to the actual answer 
(e.g. yes or no) and highlights the correct answer in green. The report also shows whether responses 
are correct or incorrect by marking them with a ‘c’ or an ‘i.’

Results by Participant (Answer Detail) Report

Results by Participant
(Response Detail) Report

The Response Detail Report includes the question along with the participant’s response. The report 
displays correct answers in green, incorrect answers in red, the correct answer in brackets for 
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incorrect answers, and calculates the percentage of correct answers and the total points accumulated 
by each participant.

Results by Participant (Response Detail) Report
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Results by Participant (Score
Detail) Report

The Score Detail Report calculates the percentage of correct answers and total points accumulated 
by each participant. 

Results by Participant (Score Detail) Report



TurningPoint User Guide 371

Types of Reports

Participant List Reports
The Participant List Reports show the participant data from the Participant List in either an Excel 
worksheet or a Word document. 

Participant List (Excel)
Report

The report shows Device ID and any of the fields defined in the Participant List (name, contact 
information, demographic groups or teams, etc.)

Participant List (Excel) Report

Note If you selected to generate the Word 
document version of the Participant List 
along with any other report, the Word 
document is included as a worksheet in the 
Excel file.
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Participant List (Word)
Report

The report shows Device ID and any of the fields defined in the Participant List (name, contact 
information, demographic groups or teams, etc.)

Participant List (Word) Report
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Standards Reports
The Group Standards, Individual, and Overall Standards Reports show response information based 
on standards identified for each question. Each of these reports creates an Excel worksheet.

Group Standards Report

The Group Standards Report displays the percentage of correct responses from each group for each 
standard.

Group Standards Report

Individual Standards Report

The Individual Standards Report includes the following information for each individual participant for 
each standard:

• the participant’s percentage of comprehension for all questions that are associated with the 
standard

• the questions associated with the standard
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• the answers for each question

• an indication of the correct answer(s)

• an indication of the participant’s response and whether it was correct

Individual Standards Report

When generating the Individual Standards Report, you have the option of creating page breaks 
between each participant’s section.

Overall Standards Report

The Overall Standards Report is very similar to the Results by Question Report but includes additional 
information relating to standards. It includes the following information for each standard:

• the percentage of overall comprehension for all questions that are associated with the standard

• the questions associated with the standard

• the answers for each question

• an indication of the correct answer(s)

• the number of responses for each answer
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• the total count of participants that responded to the question

• the percentage of responses for each answer

Overall Standards Report
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Comparative Scoring Reports
The Individual Scoring and Scoring Distribution Reports show a summary of scoring information 
based on participant responses in comparison to other participants. Each of these reports creates an 
Excel worksheet.

Individual Scoring Report

The Individual Scoring Report includes the following information for each participant:

• numeric response labeled correct or incorrect 

• question’s overall percentage correct 

• participant’s percentage score

• whether the participant’s score puts him/her above or below the class average 

Individual Scoring Report
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Scoring Distribution Report

The Scoring Distribution Report includes the following information: 

• the total number of participants

• the score ratios for assessment (number of correct answers to questions)

• the number of participants achieving each score ratio

• the answer value (correct, incorrect, points, no value, keywords)

• acceptable answer choices

• number of responses each answer received

Scoring Distribution Report



378 Turning Technologies

Chapter 8: Reports

Team Scoring Reports
The Team Scoring (Percentage) and the Team Scoring (Points) Reports show overall team results, 
the correct answer for each questions, the number of responses per answer for each question, the 
results for each question, and the correct answer highlighted in green. While generating these 
reports, you have the option to exclude response details. Each of these reports creates an Excel 
worksheet.

Team Scoring (Percentage)
Report

The Team Scoring Percentage Report includes the following additional information:

• the answers

• the overall percentage of questions each team answered correctly

• the percentage of team members that answered each question correctly

Team Scoring (Percentage) Report
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Team Scoring (Points) Report

The Team Scoring Points Report includes the following additional information:

• the answers

• the total points accumulated by each team 

• the points each team received for every question

Team Scoring (Points) Report
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Percentile Reports
The Percentile (correct/incorrect percentage) and Percentile (points) Reports show how participants’ 
responses. The reports include the Device ID, first and last name, and the percentile ranking for each 
participant grouped by percentiles. You can change the percentiles shown by entering the new 
percentiles separated by a semicolon in the appropriate box. Each of these reports creates an Excel 
worksheet.

Percentile (correct/incorrect
percentage) Report

The Percentile (correct/incorrect percentage) Report includes the following additional information:

• the total percentage of questions each participant answered correctly

Percentile (correct/incorrect percentage) Report

Percentile (points) Report

The Percentile (points) Report includes the following additional information:
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• the total points accumulated by each participant

Percentile (points) Report
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Other Reports
The Other Reports option TurningPointoffers seven uncategorized reports: Attendance, Participants 
Questions/Comments, Moment to Moment, Outline, Response Data Export, Ranking Summary, and 
Statistics Reports. Each of these reports with the exception of the Outline Report creates an Excel 
worksheet. The Outline Report creates a Word document.

Attendance Report

The Attendance Report provides basic participant information, including name and Device ID, and 
shows who has attended the presentation.

Attendance Report
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Moment to Moment Report

Moment to Moment Report shows a chart of the moment to moment rating results. 

Moment to Moment Report
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Outline Report

The Outline Report provides an outline of slide questions and answers. The outline shows all answer 
values.

Outline Report

Participant Questions and
Comments Report

The Participant Questions and Comments Report shows any comments or questions sent by any 
participants during the presentation. The report includes the following additional information:

• time the presentation started and ended

• time the slides were polled

• time the presenter sent information to ResponseWare App users
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• time any participant sent a question or comment or indicated that they had a question or comment

Participant Questions and Comments Report
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Response Data Export Report

The Response Data Export Report gives the raw response data. It creates a table of values displaying 
the numerical response values for each Device ID.

Response Data Export Report

Ranking Summary Report

The Ranking Summary Report shows a summary of Ranking Slides. 

The Ranking Report includes the following information:

• a list of the ranking criteria

• a list of the ranked items and the rank assigned for each criterion
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• the chart showing the ranking

Ranking Summary Report

Results by Group Report

The Results by Group Report shows a summary of correct responses for each question by group. 

The report includes the following information for each question:

• the answers

• an indication of the correct answer(s)
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• the percentage of correct responses from each demographic group

Results by Group Report

Statistics Report

The Statistics Report shows the overall correct percentage per participant versus the mean and 
median.

Statistics Report



TurningPoint User Guide 389

Types of Reports



390 Turning Technologies

Chapter 8: Reports

Where Do I Go From Here?

This chapter has introduced the various report types and has demonstrated how to view these 
reports.

You are now ready to begin managing sessions. You can find information in Chapter 9: Sessions.
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TurningPoint creates session files whenever you run a TurningPoint presentation. When you save a 
session, a default TurningPoint setting automatically includes the PowerPoint presentation with your 
TurningPoint file. You have the option to exclude the PowerPoint presentation from the TurningPoint 
session file. This function allows you to save only the TurningPoint results data without the 
presentation slides. If you do NOT wish to include the PowerPoint presentation in your TurningPoint 
session file, navigate to the Settings menu and, under the Misc settings, change ‘Include 
Presentation’ from True to False.

The session results are stored temporarily during a session. You can save the session results to a file 
to access them later. This chapter provides instructions for accessing and managing your 
TurningPoint sessions through Turning Reports. In addition to Turning Point sessions, Turning 
Reports allows you to access and manage TurningPoint Anywhere and TestingPoint sessions.
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Recall the five steps to presentation success:

Five Steps to Success

This chapter discusses how to save and manage sessions. 



TurningPoint User Guide 393

Manage and Edit Sessions

Manage and Edit Sessions

With TurningPoint, you can stop and save a session, and pick up where you left off at a later time. You 
can also use a TurningPoint setting to create back-up files of your session. Knowing how to save and 
resume a session gives you greater flexibility during your presentation.

This section describes how to: 

• Save Results from a Session

• Change the Default Save Location

• Continue a Previously Saved Session

• Edit Session Data

• Delete Results from a Session

Save Results from a Session

TurningPoint can quickly save a session so it is available for retrieving the results or resuming the 
session later.

Before You Begin

Identify a reliable location on the computer or on a data storage device where you would like to save 
the presentation. 

Step by Step Instructions To save a session…

1 From the Slide Show view, 
right-click the screen. Select 
End Show.

TurningPoint concludes the presentation.
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2 From the TurningPoint 
toolbar, select the Save 
Session button. 

Save Session

TurningPoint displays the Save Session dialog that shows the 
file name, file type, and where the file will be saved. The default 
location is My Documents\TurningPoint\Sessions. If you choose 
the default name, TurningPoint adds the date and time to the file 
name. If you choose to rename it, the name you chose is stored. 

Save Session Dialog

If you wish to change the default location, select a file folder to 
save the session and give the session a file name. To 
permanently change the default location, go to Change the 
Default Save Location on page 395.
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3 Select the Save button. TurningPoint saves the file in the designated location.

Change the Default Save Location

Change the default save location for your TurningPoint folder. This changes the save location of your 
session files, Participant Lists, and standards.

Before You Begin

Identify a reliable location on the computer where you would like to save your TurningPoint 
documents.

Note TurningPoint can save an automatic backup file 
of your session. To enable Real-time Backup, 
navigate to the Settings menu, select the 
Settings tab, select Presentation from the 
Settings Hierarchy, and select All Settings. 
Then, under Backup Settings, select Real-time 
Backup Path and designate a location where 
the backup file should be stored. After you 
designate the location, it will be listed in the 
Settings menu beside Real-time Backup Path. 
Find more about changing the default Real-
time Backup Path, go to Chapter 4: Response 
Device and Settings Management.
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Step by Step Instructions To change the default save location…

1 From the TurningPoint 
toolbar, select Tools > 
Settings.

The Settings window opens.

Settings Window
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2 Select the Settings tab from 
the Settings window.

3 Select Presentation from the 
Settings Hierarchy.

4 Select All Settings at the 
bottom of the Settings 
window.

Find the Misc settings.

Settings Window: Misc Settings
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5 Under the Misc settings, find 
Default Save Location and 
click on the file path.

Settings Window: Default Save Location

A Default TurningPoint Save Path window opens. 

Default Save Location Window

You can manually enter the location or click on the box to the 
right of the file path (box with ellipses) to display a dialog box. 
From the dialog box, you can browse to an existing folder 
location or create a new folder location.

6 Select a new default location. 

7 Select Done. Your TurningPoint folder location has been changed.

Note You can restore your save location to the 
default settings by selecting Reset to default 
path from the Default TurningPoint Save 
Path window.
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Continue a Previously Saved Session

TurningPoint can resume your presentation using a saved session file. TurningPoint appends new 
session information to the opened session file, allowing you to save the polling results for the 
presentation in one file.

Before You Begin

If the session file is saved on an external storage device, insert the device into the computer. 

Locate the session you wish to open. On the computer that is running the presentation, the default 
location for saved sessions is My Documents\TurningPoint\ Sessions. 

Step by Step Instructions To continue a previously saved session…

1 From the TurningPoint 
toolbar, select the Continue 
Prior Session button. 

Continue Prior Session

TurningPoint displays the Continue Prior Session window that 
shows the file name, file type, and where the file is located. The 
default location is My Documents\TurningPoint\Sessions.

2 Navigate to the file you wish 
to open and select the Open 
button. 

TurningPoint opens the previously saved file.

Next Steps

From the PowerPoint menu, select Slide Show > View Show.  Advance to the slide from which you 
want to resume your presentation. Continue presenting the session.

Note If you did not manually save your last session, 
TurningPoint automatically creates a backup 
copy and stores it at My Documents\ 
TurningPoint\Sessions\Backup.
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Edit Session Data

You can edit TurningPoint, TurningPoint Anywhere, or TestingPoint session data after the session is 
saved. You can choose to exclude a question, make a question demographic, or change answer 
values.

Step by Step Instructions To edit session data…

1 From the TurningPoint tool 
bar, select Tools > Session 
Management.

The Tools menu opens.

Select Session Management: Edit Session
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2 Select Session Management 
> Edit Session.

The Edit Session window opens, displaying a list of session files 
in your sessions folder. 

Edit Session Window

You can toggle which files are displayed in the list by selecting 
My Session Files or My Backup Session Files. Find more 
information about where your session files are stored in Save 
Results from a Session on page 393.

3 Choose a session file. You may choose a session file in one of the following ways:

• Select the Current Session 
(in red text) to use the 
session currently open in 
PowerPoint.

This option is available only if you have a TurningPoint 
presentation open and response data has been collected.

• Select a session file from 
the list of files in your 
Sessions folder.

To display the session files from your Sessions folder in 
the list of files, select My Session Files. 

• Select a session file from 
your backup session files.

To display the backup session files in the list of files, 
select My Backup Session Files. 

• Import a session file from 
another location.

You can also import a session using the Import Session 
button (shaped like a folder) above the list of files. This 
allows you to use a TurningPoint, TurningPoint 
Anywhere, or TestingPoint session file you have copied 
from elsewhere.
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4 Select the Next button to 
continue.

The Edit Session window displays options for editing the 
session file.

Edit Session Window: Edit Session

The window shows a list of all questions in the session. Below 
the list of questions is a list of answers, which shows the 
answers for the questions selected in the list above.

5 Uncheck the box next to any 
question in the list that you 
would like to exclude from the 
session.

Excluding a question will omit all data about that question from 
the session file.
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6 If you would like to change 
the question type or value, 
right-click on the question 
and select the desired option 
from the Contextual menu 
that opens.

You can change the default Correct and Incorrect point values, 
or designate a question as demographic.

Edit Session Window: Change Question Value

Demographic questions can be used in reports. Find more 
information in Reports on page 351.

7 If you would like to change an 
answer value, right-click on 
the answer in the answer list 
and select an option from the 
Contextual menu that opens.

You can mark the answer Correct or Incorrect, assign a point 
value, or clear the answer value (set to No Value).

Edit Session Window: Change Answer Value
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8 When you are finished 
making changes to the 
session data, select the Save 
Session button below the list 
of answers.

A dialog opens listing the current location and name for the 
session file you edited. You can keep the same location and file 
name or specify a new name and location.

9 Specify a name and location 
or keep the current name and 
location for the edited file. 

10 Select the Save button. The file is saved and the dialog closes.

11 Select the Finish button to 
exit the Edit Session window.

Delete Results from a Session

You can use the same presentation to create a new set of responses. The Reset menu on the 
TurningPoint toolbar gives you the option of deleting the results from slides in order to redo a session 
or present a new session. The slide results will still be stored in the session data, but the slide will be 
cleared so that it can be used again in a new presentation. You also have the option to redo only one 
question slide in a session.

Note Ensure that the .tpz file extension is used for 
session files.

Note  You cannot undo the Reset function, so be 
certain that you wish to delete the results 
form the slide.
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Before You Begin

If you want to view the results at a later time, save the session before proceeding with the following 
steps. 

Step by Step Instructions To delete the results of a session from a slide…

1 Open the presentation. To 
delete the results of one 
question only, the slide with 
this question should be in 
view.

2 From the TurningPoint 
toolbar, select the Reset 
menu.

The Reset menu opens offering the options to reset either the 
entire session, all the slides or simply the current slide. 

Reset Session

3 When you are ready to delete 
the results from the slide, 
select either Session, All 
Slides or Current Slide. 

• Selecting Session resets every slide in the presentation 
by resetting the values to zero on all slides and clears all 
of the results data from the temporary session file by 
removing all of the response and participant data.

• Selecting All Slides resets every slide in the presentation 
by resetting the values to zero on all slides.

Note Be certain that you wish to delete the results 
from the slide! You cannot undo the Reset 
function for either the Session, All Slides or 
Current Slide options. 
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• Selecting Current Slide resets the currently viewed slide 
only by resetting the values to zero on that slide.
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Where Do I Go From Here?

This chapter has demonstrated how to save and continue sessions and manage session data.

You are now ready to begin exporting information. Find more information in Chapter 10: Export.
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When you complete a session, you save the data in a TurningPoint session file (extension.tpz). Find 
more information on how to save a session in Save Results from a Session on page 393.

The session file contains all the information about your presentation, including the questions and 
answers, the response data, and the Participant List. This information is used to generate reports 
(find more information in Reports on page 351). 

Session files and can be merged with other session files and Participant Lists with other Participants 
Lists to show aggregated results from your presentations. TurningPoint also allows you to share and 
extract the information in your TurningPoint, TurningPoint Anywhere, or TestingPoint session files by 
exporting the data into several formats.

This section describes how to:

• Export Session Data 

• Export Session Results to VantagePoint

• Export Results Data to a WebCT Server (Campus Edition 6.0 or Vista 3, 4)

• Export Results Data to a WebCT Server (Campus Edition 4.1)

• Merge Participant List

• Merge Session Files

• Extract Participant List

• Extract PowerPoint Presentation
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• Extract Session Data as XML

• Email Session



TurningPoint User Guide 411

Export Session Data

Export Session Data

You can export the data from a TurningPoint, TurningPoint Anywhere, or TestingPoint session file into 
a text file. You can use the text file to import the data into a variety of other applications.

You can choose to export the data from the session file in one of two ways:

• Export some or all of the session data to a text file where you determine the contents and format.

• Export the session data using a predefined scheme for certain gradebook applications.

Step by Step Instructions To export session data into a text file…

1 From the TurningPoint 
toolbar, select Tools > 
Session Management.

The Tools menu opens.

Select Session Management > Export Session Data
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2 Select Session Management 
> Export Session Data. 

The Export Session window opens, displaying a list of session 
files in your Session Folder. 

Export Session Data Window

You can toggle which files are displayed in the list by selecting 
My Session Files or My Backup Session Files. Find more 
information about where your session files are stored in Save 
Results from a Session on page 393.

3 Choose a session file. You may choose a session file in one of the following ways:

• Select the Current Session 
(in red text) to use the 
session currently open in 
PowerPoint.

This option is available only if you have a TurningPoint 
presentation open and response data has been collected.

• Select a session file from 
the list of files in your 
Sessions folder.

To display the session files from your Sessions folder in 
the list of files, select My Session Files. 

• Select a session file from 
your backup session files.

To display the backup session files in the list of files, 
select My Backup Session Files. 

• Import a session file from 
another location.

You can also import a session using the Import Session 
button (shaped like a folder) above the list of files. This 
allows you to use a TurningPoint, TurningPoint 
Anywhere, or TestingPoint session file you have copied 
from elsewhere.
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4 Select the Next button. The Export Session window displays lists of the data and 
formats you can use to export the session file.

Export Session Data: Select Export Scheme or Data Groups

5 Choose one of these two 
ways to export the data:

• Check some or all of the 
boxes in the Data Group 
list to manually specify the 
contents and format of the 
exported text file.

The following data is available for export:

• The text of questions and answers.

• Participant information, such as names and groups, 
defined in the Participant List.

• Participant’s responses to the questions.

• Participant’s scores.

• Check the Use Export 
Schemes box to select a 
pre-defined export scheme 
for a gradebook 
application from the Export 
Schemes list.

Export schemes for several gradebook applications are 
available, including Angel, Easy Grade Pro, Gradebook 
for Windows, Gradekeeper for Windows, MicroGrade, 
Moodle for use with Moodle Participant List and 
Teacher’s Marksheet.

Export schemes are saved as .tpx files in the Export 
Schemes folder, which is located in your TurningPoint 
folder. You can use an export scheme you have copied 
from elsewhere by selecting the Load an Export Scheme 
button (shaped like a folder).

Using an export scheme automatically specifies the 
settings available to you in the next steps to match the 
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format required by the application you are exporting to. 
You may still choose to modify some settings, to specify 
a grading scale, for example.

6 Select the Next button to 
continue.

The Export Sessions window displays a tabbed view for you to 
specify the data to be used.

Export Session Data: Include or Exclude Data

There are four tabs, one for each of the main groups of data you 
specified to include in the exported file. In each area you chose 
to include, review and modify the settings on the corresponding 
tab. The next few steps explain the settings on each tab.
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7 If you chose to include the 
question and answer data, 
specify which particular 
questions to include by 
checking the boxes on the 
Questions & Answers tab.

By default, all questions are checked and will be included.

Include or Exclude Data: Questions & Answers Tab

8 Select the Participant Info 
tab.

The Export Data window displays the Participant Info tab.

 Include or Exclude Data: Participant Info Tab

9 If you chose to include the 
participant information, select 
which fields from the 
Participant List to include by 
checking the boxes on the 
Participant Info tab.

To view the information from the Participant List, press the F5 
key or right-click in the window and select Refresh Participant 
List Data. This allows you to see the Participant List to help you 
decide which fields you would like to include in the exported 
data.

You can include any of the information defined in the Participant 
List. 
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10 Select the Responses tab. The Export Data window displays the Responses tab.

Include or Exclude Data: Responses Tab

11 If you chose to include the 
responses, choose whether 
to group responses by 
question or by participant by 
selecting Show Responses 
Horizontally or Show 
Responses Vertically on the 
Responses tab.

Show Responses Horizontally will group the response data by 
question in the exported file. Show Responses Vertically will 
group the response data by participant in the exported file.

Responses Tab: Show Responses
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12 Select the Scores tab. The Export Data window displays the Scores tab.

Include or Exclude Data: Scores Tab

13 If you chose to include the 
scores, specify the following 
settings:

• Select whether to calculate 
scores based on 
Correct/Incorrect values or 
based on point values.

If you base scores on Correct/Incorrect values, the 
percentage score is calculated by dividing the 
participant’s number of correct answers by the number of 
total answers. If you base scores on point values, the 
percentage score is calculated by dividing the 



418 Turning Technologies

Chapter 10: Export

participant’s number of correct answers by the point value 
you specify in the box provided.

Scores Tab: Calculate Scores

• Select to show scores as 
percentages, as letter 
grades, as point values, or 
any combination by 
checking the boxes.

You may include any or all of these ways of representing 
the scores in the exported file.

Scores Tab: Show Scores

• Specify the grading scale 
by selecting ranges for the 
letter grades from the 
drop-down menus.

The default ranges show a typical grading scale. You can 
alter the grading scale by selecting a new range. To 
change values upward (grade on a stricter scale), start 
from A and work your way down the list to specify the 
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ranges. To change values downward (grade on an easier 
scale), start from D and work your way up the list.

Scores Tab: Specify Grading Scale

• Designate questions as 
bonus questions (not to be 
included in the score 
totals) by checking the 
boxes.

Questions you designate as bonus questions are not 
included in the total number of questions for calculating 
scores, but are included in a participant’s number of 
correct responses.

Scores Tab: Designate Bonus Questions
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14 When you have finished 
modifying the settings on the 
applicable tabs, select the 
Next button.

The Export Data window displays a group of settings for 
specifying the format of the exported file.

 Export Session Data: Select Format

There is an example entry at the bottom of the window showing 
a sample based on the settings specified. Observe this example 
as you change the format settings in the next few steps to 
ensure it matches your expectations.

15 Specify the order of the fields 
in the exported file by moving 
the fields up and down the 
list, by selecting the Move Up 
and Move Down arrow 
buttons.

 Select Format: Specify Order

Additionally, you can join two fields together or include blank 
fields in the exported file. Use the Insert A Blank Field and Insert 
A Join Field buttons below the list of fields to insert a blank field 
or join one or more fields. You can move blank fields and joined 
fields up and down the list just like the other fields.
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A blank field simply puts a blank separator between fields. 
Depending on how you will use the exported file, you may need 
to separate some data with blank fields.

A join field joins the previous field and the following field into a 
single field. You might wish to do this with the First Name and 
Last Name fields, for example.

16 Specify whether to create a 
delimited or fixed-width file.

A delimited file includes a “delimiter” between each of the fields. 
You can select a comma, semicolon, tab, space, or other 
delimiter.

A fixed-width file uses fields of a specified width (number of 
characters). You can choose a width for the fields.

The format you choose depends on how you will use the 
exported file.

Select Format: Create Delimited or Fixed
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17 Specify whether to use 
double quotes, single quotes, 
or no quotes to enclose the 
text in fields.

Select Format: Enclose Text

18 When you have finished 
modifying the settings for the 
format of the file, select the 
Next button.

The Export Data window displays the data in the format to be 
exported.

Export Session Data: Verification

Below the data are two buttons. The first, shaped like a 
document and a disk, saves the export file (.txt). The second, 

Note You should use either double or single 
quotes for the text qualifier if you are 
exporting a fixed-width file or using spaces 
as delimiters in a delimited file. Without 
quotes, the field boundaries in the exported 
file will be impossible to interpret correctly.
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shaped like a disk, saves the format as an export scheme you 
can reuse for other session files (.tpx).

19 To save your export data, 
select the Save button 
(shaped like a document with 
a disk).

A dialog opens for you to specify a location and filename for the 
exported file.

20 Specify a name and location 
for the exported file.

21 Select the Save button. The file is saved and the dialog closes.

Optionally, you can also select the Save Export Scheme button 
(shaped like a disk) to create an export scheme you can reuse 
to save the data from other session files in the same format. 
Specify a location and filename for the export scheme in the 
same way.

22 Select the Finish button to 
exit the Export Data window.

If you forgot to save before selecting Finish, a message window 
opens containing ‘Are you sure you want to exit without saving 
an export?’ Select Yes to exit without saving the session file; 
select No to save before exiting.
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Export Session Results to VantagePoint

VantagePoint is a data assessment management system that enables superintendents, curriculum 
directors, principals, and teachers to view quarterly Adequate Yearly Progress (AYP) and 
performance reports in real-time at the district, building and classroom level.

VantagePoint allows you to monitor and improve performance on state testing through aggregate 
tracking and reporting to determine early intervention needs. VantagePoint provides a mechanism by 
which you can evaluate your class’ progress by comparing your TurningPoint session against your 
state’s standards. 

Step by Step Instructions To upload a session into VantagePoint…

1 From the TurningPoint 
toolbar, select Tools > 
VantagePoint.

The tools menu opens.

Select VantagePoint



TurningPoint User Guide 425

Export Session Results to VantagePoint

2 From the VantagePoint 
window, enter the Server 
URL, User Name, Password.

3 Select Login. A window opens and displays the Subject and Academic Term 
drop-down menus.

VantagePoint: Select Subject and Academic Term

4 Select a subject from the 
Subject drop-down menu.

Choose from Math, Science, Social Studies, and Writing.

5 Select a term from the 
Academic Term drop-down 
menu.

Choose from Quarters 1 through 4.
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6 Select Next. A window opens and displays the Assessment and Session 
drop-menus.

VantagePoint: Select Assessment and Session

7 Select an assessment from 
the Assessment drop-down 
menu.

Choose from any of the assessments listed.

8 Select a session. Select a session in two ways:

• Select Current Session to send your current session. 
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• Select Change to open a dialog. Choose from any 
sessions to which your computer has access and select 
Open.

Choose Session Dialog

9 Select Upload. A dialog displays confirming that your session and assessment 
has been uploaded. 

10 Select Ok.

Next Steps

You can now launch VantagePoint to run reports to analyze specific questions or create a summary of 
student performance.
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Export Results Data to a WebCT Server (Campus Edition 6.0 or 
Vista 3, 4)

If you are using WebCT CE 6.0/Vista 3, 4, follow the steps below to export results data. Instructors 
can perform the same functions; they can export results data from participants to an available WebCT 
server and send grade reports to their students via WebCT email. 

However, with WebCT CE 6.0/Vista 3, 4, instructors may select specific TurningPoint, TurningPoint 
Anywhere, or TestingPoint sessions to upload and then enter the name of the assignment and the 
maximum point value for responses.

Before You Begin

A gradebook, or similar file, should reside on the WebCT Server. TurningPoint exports and saves the 
results data to this file.

Step by Step Instructions To export data to a WebCT 6.0/Vista 3, 4 Server…

1 From the TurningPoint 
toolbar, select Tools > 
WebCT Wizards > Campus 
Edition 6.0/Vista 3, 4. 

TurningPoint displays a window asking which task you would 
like to perform with the WebCT Wizard.

WebCT Wizard > Campus Edition 6.0/Vista 3,4
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2 Select the button next to 
Export Student Data to the 
WebCT Gradebook/Email 
Student Reports.

WebCT Wizard: Select Task

3 Select the Next button. TurningPoint displays the WebCT Log-In window.

4 Enter your login information. WebCT Wizard: Login

TurningPoint saves the Server Name (IP) and the Port Number. 
You must enter your username and password. The system 
prompts you for the Institution’s name and then displays all 
courses associated with your user name and password.

5 Select the Next button. TurningPoint displays a window asking you to select the 
institution you belong to.
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6 Select your institution. WebCT Wizard: Select Institution

7 Select the Next button. TurningPoint displays a window asking you to select the course 
to export data to.

8 Select the course you wish to 
export data to.

WebCT Wizard: Select Course

9 Select the Next button. TurningPoint displays a window asking you to select the session 
you wish to upload. 
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10 Select the Session you wish 
to upload.

You can also import a session using the Import Session button 
(shaped like a folder) above the list of files. This allows you to 
use a TurningPoint, TurningPoint Anywhere, or TestingPoint 
session files you have copied from elsewhere.

WebCT Wizard: Select Session

11 Select the Next button. TurningPoint displays an Export Preview/Options window 
asking you to enter the name of the assignment for the session 
and a maximum point value. 

12 Enter the name of the 
assignment and a maximum 
point value for responses.

WebCT Wizard: Export Preview/Options
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You can also select the checkbox to email individualized reports 
to students through WebCT.

13 Select the Finish button. TurningPoint displays a confirmation message that the export 
was successfully completed.

14 Select the OK button. WebCT Wizard: Export Complete

You can now login to WebCT and view the results data in your 
Gradebook.
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Export Results Data to a WebCT Server (Campus Edition 4.1)

TurningPoint allows participants to quickly export results data from participants to an available WebCT 
server. With this function, instructors who test students through TurningPoint can easily save 
participants’ test scores for grading purposes. 

TurningPoint also lets instructors send grade reports to their students via WebCT email. Instructors 
enter their WebCT IDs and select the checkbox to email reports to students. Instructors can then view 
the sent mail and the new results that have been posted to the gradebook.

Before You Begin

A gradebook, or similar file, should reside on the WebCT Server. TurningPoint exports and saves the 
results data to this file. You must know the Column Name in this gradebook where the results data 
should be saved. The Column Name may have any title, but you must know the exact title and provide 
it to the WebCT Wizard.

Step by Step Instructions To export results data to a WebCT 4.1 Server…

1 From the TurningPoint 
toolbar, select Tools > 
WebCT Wizard > Campus 
Edition 4.1. 

TurningPoint displays a window asking which task you would 
like to perform with the WebCT Wizard.

WebCT Wizard > Campus Edition 4.1
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2 Select the button next to 
Export Grade Data.

WebCT Wizard: Select Task

3 Select the Next button. TurningPoint displays the WebCT Log-In window.

4 Enter your login information. WebCT Wizard: Login

TurningPoint saves the Server Name (IP) and the Port Number. 
You must enter your username and password. The system 
prompts you for the Institution’s name and then displays all 
courses associated with your user name and password. 

5 Select the Next button. TurningPoint displays a window asking you to select the class 
for which you have new data.
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6 Select the class to which you 
want to export data. The 
class should match the 
Participant List you used.

WebCT Wizard: Select Class

7 Enter the Column Name. The Column Name is the title of the column in the class 
gradebook to be used to store the scores for this particular 
activity or test. 

8 Enter the Maximum Value for 
Column.

The Maximum Value for Column is the total possible score a 
participant could achieve for this particular activity or test or 
simply the maximum number of characters accepted. 

9 Select the Finish button. TurningPoint displays a confirmation message and then closes 
the WebCT Wizard window. The results data should now 
appear in the column you designated in the file on the WebCT 
server.
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Merge Participant List

Participant Merge allows you to combine participant results of multiple Participant Lists with multiple 
sessions to generate a report based on a common field (Student ID, Device ID, etc.). The report 
shows the total scores of the sessions in an Excel file. 

Step by Step Instructions To merge Participant List…

1 From the TurningPoint 
toolbar, select Participant 
Merge (Excel).

The Tools menu opens.

Select Participant Merge (Excel)
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2 Select Session Management 
> Participant Merge (Excel).

Participant Merge window opens. 

Participant Merge Window

Initially, the left pane is empty. This is where your new column 
and sessions to be merged will be displayed. Above the left 
pane is the Available Fields for Merge drop-down box. Below 
the left pane is the Add Column text box and button.

The right pane displays all of the sessions available to be 
merged. Above the right pane are the Percentage Correct and 
Points radio buttons. 

3 Add a Column. TurningPoint displays the percentage correct or points in the 
added column when the sessions are merged. 

Participant Merge Window: Add Column
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4 Select the sessions you want 
to merge from the list of 
sessions.

Highlight the sessions and use the left (<) button to add the 
sessions to your column. Use the right (>) to remove sessions 
from your columns. 

When selecting session files, hold Shift to select multiple 
contiguous sessions, or Control to select multiple sessions. 

Participant Merge Window: Select Sessions

• Select the Current Session 
(in red text) to use the 
session currently open in 
PowerPoint.

This option is available only if you have a TurningPoint 
presentation open and response data has been collected.

• Select a session file from 
the list of files in your 
Sessions folder.

To display the session files from your Sessions folder in 
the list of files, select My Session Files. 

• Import a session file from 
another location.

You can also import a session using the Import Session 
button (shaped like a folder) above the list of files. This 
allows you to use a TurningPoint, TurningPoint 
Anywhere, or TestingPoint session file you have copied 
from elsewhere.

Note Alternatively, double click on an session to 
add it to your column.
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5 Alternately, remove all of the 
columns by selecting the 
button that looks like a trash 
can.

6 Select the Field you want to 
merge the Participants Lists 
under from the Available 
Fields for Merge drop-down 
menu.

The sessions will be merged based on the selected value. Only 
fields that are common between the Participant Lists will be 
available from the drop-down menu.

Participant Merge Window: Select Merge Field

7 Select whether the report 
should display the 
Percentage Correct or 
Points.

Participant Merge Window: Select Percentage/Points

Note Alternatively, double click on an session to 
remove it from your column.
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8 Select Merge. TurningPoint generates a report in an excel file. 

Participant Merge Report
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Merge Session Files

You can merge multiple TurningPoint, TurningPoint Anywhere, or TestingPoint session files together 
to create a single session file, from which you can generate reports and extract data.

This is especially useful if you have session files from multiple presentations given to the same 
participants. You can aggregate the data from all the presentations into a single file with all the 
responses from each participant.

Conversely, if you gave the same presentation to several groups of participants, you could aggregate 
the responses from all participants into a single session file.

Before You Begin

The Import Session button allows you to import session files into youir Sessions file (as it is described 
in step 3). The list of sessions to choose from in the Merge Session Files windown lists the files in 
your sessions folder.

Step by Step Instructions To merge session files…

1 From the TurningPoint 
toolbar, select Tools > 
Session Management.

The Tools menu opens.

Select Merge Session File
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2 Select Session Management 
> Merge Session File.

The Merge Session Files window opens and displays a list of 
session files in your Sessions folder. 

Merge Session Files Window

You can toggle which files are displayed in the list by selecting 
My Session Files or My Backup Session Files. Find more 
information about where your session files are stored in Save 
Results from a Session on page 393.

3 Choose a session file to be 
merged. 

Merge Session Files Window: Select Files

You may choose a session file in one of the following ways:



TurningPoint User Guide 443

Merge Session Files

• Select the Current Session 
(in red text) to use the 
session currently open in 
PowerPoint.

This option is available only if you have a TurningPoint 
presentation open and response data has been collected.

• Select a session file from 
the list of files in your 
Sessions folder.

To display the session files from your Sessions folder in 
the list of files, select My Session Files. 

• Select a session file from 
your backup session files.

To display the backup session files in the list of files, 
select My Backup Session Files. 

• Import a session file from 
another location.

You can also import a session using the Import Session 
button (shaped like a folder) above the list of files. This 
allows you to use a TurningPoint, TurningPoint 
Anywhere, or TestingPoint session file you have saved 
elsewhere. Unless you originally created the session in 
TurningPoint, TurningPoint Anywhere, or TestingPoint, 
the session files will not hold a PowerPoint presentation 
file.

4 Select additional files to be 
merged in the list by holding 
Shift to select multiple 
contiguous files, or Control to 
select multiple files.

Repeat this step until all the files you would like to merge are 
selected.

5 Optionally, check the box to 
include the PowerPoint 
presentations in the merged 
session file.

If you include the presentations in the merged session file, the 
slides from the presentations of each of the merged files are put 
together into a single presentation saved in the merged session 
file. This may greatly increase the size of the merged session 
file.
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6 Select the Merge button 
below the list of files.

A dialog opens for you to specify a location and filename for the 
merged session file.

Merge Turning Session Dialog Box

7 Specify a name and location 
for the exported file.

8 Select the Save button. The file is saved and the dialog closes.

You can access TurningPoint Reports by selecting Open 
TurningPoint Reports located next to the Finish button.

9 Select the Finish button to 
exit the Merge Session Files 
window.

Next Steps

You can now generate reports or extract other data from the merged session file, just as if it were an 
original session file.

Note Ensure that the .tpz file extension is used for 
session files.
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Extract Participant List

Extract Participant List

You can extract the Participant List from a TurningPoint, TurningPoint Anywhere, or TestingPoint 
session file. This is especially useful if you have a session file but have lost the Participant List file or 
if you set up the list on a different computer.

Step by Step Instructions To extract a Participant List…

1 From the TurningPoint 
toolbar, select Tools > 
Session Management.

The Tools menu opens.

Select Extract Participant List
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2 Select Session Management 
> Extract Participant List.

The Extract Participant List window opens to display the session 
files in your Sessions folder. 

Extract Participant List Window

You can toggle which files are displayed in the list by selecting 
My Session Files or My Backup Session Files. Find more 
information about where your session files are stored in Save 
Results from a Session on page 393.

3 Choose a session file. You may choose a session file in one of the following ways:

• Select the Current Session 
(in red text) to use the 
session currently open in 
PowerPoint.

This option is available only if you have a TurningPoint 
presentation open and response data has been collected.

• Select a session file from 
the list of files in your 
Sessions folder.

To display the session files from your Sessions folder in 
the list of files, select My Session Files. 

• Select a session file from 
your backup session files.

To display the backup session files in the list of files, 
select My Backup Session Files. 

• Import a session file from 
another location.

You can also import a session using the Import Session 
button (shaped like a folder) above the list of files. This 
allows you to use TurningPoint session files you have 
saved elsewhere.
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Extract Participant List

4 Select the Extract Participant 
List button below the list of 
files.

A dialog opens for you to specify a location and filename for the 
Participant List file.

Extract Participant List Dialog

5 Specify a name and location 
for the exported file. 

6 Select the Save button. The file is saved and the dialog closes.

7 Select the Finish button to 
exit the Extract Participant 
List window.

Next Steps

You can now edit the Participant List or use it in a presentation. Find more information in Chapter 5: 
Track Participants and Teams.

Note Ensure that the .tpl file extension is used for 
Participant List files.
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Extract PowerPoint Presentation

You can extract the PowerPoint presentation from a session file. This is especially useful if you have 
a session file but have lost the corresponding PowerPoint presentation or if you created the 
presentation on a different computer.

Step by Step Instructions To extract a PowerPoint presentation…

1 From the TurningPoint 
toolbar, select Tools > 
Session Management.

The Tools menu opens.

Select Extract PowerPoint Presentations
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Extract PowerPoint Presentation

2 Select Session Management 
> Extract PowerPoint 
Presentations.

The Extract PowerPoint Presentations window opens to display 
a list of the session files in your Sessions folder.

Extract PowerPoint Presentations Window

You can toggle which files are displayed in the list by selecting 
My Session Files or My Backup Session Files. Find more 
information about where your session files are stored in Save 
Results from a Session on page 393.

3 Choose a session file. You may choose a session file in one of the following ways:

• Select the Current Session 
(in red text) to use the 
session currently open in 
PowerPoint.

This option is available only if you have a TurningPoint 
presentation open and response data has been collected.

• Select a session file from 
the list of files in your 
Sessions folder.

To display the session files from your Sessions folder in 
the list of files, select My Session Files. 

• Select a session file from 
your backup session files.

To display the backup session files in the list of files, 
select My Backup Session Files. 

• Import a session file from 
another location.

You can also import a session using the Import Session 
button (shaped like a folder) above the list of files. This 
allows you to use a TurningPoint, TurningPoint 
Anywhere, or TestingPoint session file you have copied 
from elsewhere.
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4 Select the Extract 
PowerPoint Presentation 
button below the list of files.

A dialog opens for you to specify a location and filename for the 
PowerPoint presentation.

Extract PowerPoint Presentations Window: Export Dialog

5 Specify a name and location 
for the exported file. 

6 Select the Save button. The file is saved and the dialog closes.

7 Select the Finish button to 
exit the Extract PowerPoint 
Presentations window.

Note Ensure that the .ppt file extension is used for 
PowerPoint presentations.
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Extract Session Data as XML

You can extract your TurningPoint, TurningPoint Anywhere, or TestingPoint session data into an XML 
file. The XML file is a text markup format that you can use to exchange and manipulate the data.

Step by Step Instructions To extract the session data XML file…

1 From the TurningPoint 
toolbar, select Tools > 
Session Management.

The Tools menu opens.

Select Extract Session XML File
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2 Select Session Management 
> Extract Session XML File.

The Extract Session XML File window opens, displaying a list of 
session files in your Sessions folder.

Extract Session XML File Window

You can also import a session using the Import Session button 
(shaped like a folder) above the list of files. This allows you to 
use a TurningPoint, TurningPoint Anywhere, or TestingPoint 
session file you have copied from elsewhere.

3 Choose a session file. You may choose a session file in one of the following ways:

• Select the Current Session 
(in red text) to use the 
session currently open in 
PowerPoint.

This option is available only if you have a TurningPoint 
presentation open and response data has been collected.

• Select a session file from 
the list of files in your 
Sessions folder.

To display the session files from your Sessions folder in 
the list of files, select My Session Files. 

• Select a session file from 
your backup session files.

To display the backup session files in the list of files, 
select My Backup Session Files. 

• Import a session file from 
another location.

You can also import a session using the Import Session 
button (shaped like a folder) above the list of files. This 
allows you to use a TurningPoint, TurningPoint 
Anywhere, or TestingPoint session file you have copied 
from elsewhere.
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Extract Session Data as XML

4 Select the Extract Session 
XML File button below the list 
of files.

A dialog opens for you to specify a location and filename for the 
XML file.

Extract Session XML File Dialog Box

5 Specify a name and location 
for the exported file. 

6 Select the Save button. The file is saved and the dialog closes.

7 Select the Finish button to 
exit the Extract Session XML 
File window.
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Email Session

You can use Session Management to quickly and easily send one or more TurningPoint, TurningPoint 
Anywhere, or TestingPoint session files by email.

Before You Begin

To use this feature, you must have access to the internet on the computer that has TurningPoint 
installed.

Step by Step Instructions To email a session file using an SMTP client…

1 From the TurningPoint 
toolbar, select Tools > 
Session Management.

The Tools menu opens.

Select Session Management > Send Session



TurningPoint User Guide 455

Email Session

2 Select Session Management 
> Send Sessions.

The Send Sessions window opens, displaying a blank email 
form.

Send Sessions Window

3 Enter the recipient’s email 
address in the To box for 
delivery of the session files. 

You may enter more than one email address. Separate multiple 
email addresses with semicolons.

4 Enter your email address in 
the From box.

5 Enter a subject for the email 
in the Subject line.

6 Optionally, add a message to 
the email in the space 
provided. 

If you choose not to add a message, the body of the email will 
be blank for delivery.
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7 Select File > Attach 
Session(s). 

This opens a window displaying a list of sessions files from your 
Sessions folder.

From this window, you can also navigate to any other location 
where TurningPoint, TurningPoint Anywhere, or TestingPoint 
session files are located. 

Send Sessions: Select a Session

8 Choose a session file. When selecting session files, hold Shift to select multiple 
contiguous sessions, or Control to select multiple sessions.
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Email Session

9 When you have selected all 
the files you would like to 
send, select the Open button 
to continue.

TurningPoint attaches the session(s) to the email and displays 
the session name in the lower portion of the Send Sessions 
window.

Send Session Session Attached

10 Set the SMTP Server.

a Select Tools > Change 
SMTP Server.

An SMTP Server window opens.

Send Sessions: SMTP Server Window

b Enter the SMTP server. You may need to check with your IT Department for this 
information.

c Select OK. Your SMTP server has been set. If you need to change 
the SMTP Sever, repeat this step.
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11 Select the Send button. A confirmation message displays indicating that the email was 
successfully sent.
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Where Do I Go From Here?

Where Do I Go From Here?

This user guide has introduced you to the process of creating interactive presentations with 
TurningPoint. You have learned how to successfully build, deliver, and save the results of an 
interactive presentation in five easy steps.

You have customized the slides and included animation, feedback mechanisms, and excitement in 
your presentation. You have also created reports to view the results of your presentation session.

If you have further questions about the TurningPoint system, please feel free to contact Customer 
Support at Turning Technologies. See “Customer Support” on page 21.
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Glossary
Answer

An Answer is one of a list of choices on a TurningPoint slide. 
The answers are enumerated and participants’ responses 
correspond to the number of the answer.

Answer Now Indicator
An Answer Now Indicator is an object on a TurningPoint slide 
that gives the audience a visual indication that polling is open 
and they should respond to the question.

Answer Region
The Answer Region is the area on a TurningPoint slide that 
contains the list of answers.

Answer Value
For purposes of scoring and competition, you can assign 
answer values to answers on a TurningPoint slide. The 
possible values are “correct”, “incorrect”, “no value,” or a point 
value range of negative 10,000 through 10,000.

Chart
A chart is a visual representation of the results of polling on a 
TurningPoint slide.

Comparative Link
A comparative link is used to link a slide to the results from 1–3 
additional slides to show all the results on a single chart.

Conditional Branching
Conditional branching determines the order of slides based on 
participant responses.

Correct Answer Indicator
A Correct Answer Indicator is an object on a TurningPoint slide 
that gives a visual indication of the correct answer(s) after 
polling has closed.
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Countdown Indicator
A Countdown Indicator is an object on a TurningPoint slide that 
gives the audience a visual indication that polling is about to 
close and that they should respond soon.

Countdown Sound
A Countdown Sound is a sound file used with a Countdown 
Indicator that gives the audience an audible indication that 
polling is about to close and that they should respond soon. 
The acceptable file extensions include: .aiff, .au, .mid, .midi, 
.mp3, .wav, and .wma.

Criteria
In a ranking slide, the criteria are the qualities on which the 
items to be ranked are compared. There are 1–3 criteria for the 
ranking, corresponding to the X, Y, and Z axes of the ranking 
chart.

Data Slicing
Data slicing is data analysis that entails cross-referencing the 
results from a question to the results of a another question.

Device ID
The Device ID is a number that uniquely identifies a response 
device. For hardware devices, it may be printed on the tag on 
the back of the device. For ResponseWare App, it is embedded 
in the application.

Essay Slide
An Essay slide asks an open-ended question. ResponseCard 
IR, XL, and RF users are limited to numerical responses, but 
ResponseCard XR and ResponseWare App users may provide 
alphanumeric responses of varying lengths.

Fill in the Blank Slide
A Fill in the Blank slide asks a question or makes a statement 
with a missing word. Types of responses are determined by the 
type of device a participant is using. For instance, 
ResponseCard IR, XL, and RF users are limited to numerical 
responses, but ResponseCard XR and ResponseWare App 
users may provide alphanumeric responses of varying lengths.
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Infrared (IR)
Infrared light is invisible to the human eye and can be used to 
transmit information. Some of the response devices that work 
with TurningPoint use infrared technology. IR devices require a 
direct line of sight to the receiver. The IR response devices 
allow only one-way communications.

Interactive Results
Interactive results are the data from the audience’s responses 
that are displayed in real-time while polling is open. 

Moment to Moment Slide
A Moment to Moment slide is a special TurningPoint slide for 
getting feedback from the participants on a continual basis. 
The participants respond on a scale from -2 to +2 at regular 
intervals and the responses are displayed in a chart.

Parser
A parser examines a file and breaks it into logical units to use 
and recombine. The TurningPoint Parser can take several 
kinds of files and create TurningPoint presentations from them.

Participant List
A Participant List is the file used during a session to match 
participant information with the response device used. Users 
can customize the type of participant information/data fields to 
include in the list but every list will include a field for the Device 
ID.

Participant List Wizard
The Participant List Wizard is a tool that guides you through 
the creation of a Participant List to be used with your 
presentation session.

Participant Monitor
The Participant Monitor displays the participants’ status and 
information pertaining to the participants’ responses to all of 
the questions. This information includes the total percentage of 
correct responses, the answers that participants picked, and 
individual overall points and percentages scored. 
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Participants
The people in the audience of a presentation who use the 
response devices to respond to questions.

Picture Slide
A picture slide is a TurningPoint slide in which the answer text 
is replaced with pictures.

Polling
Polling is the mechanism by which TurningPoint accepts and 
tallies the responses provided by the audience using Response 
Devices.

Presentation Session
See Session.

Radio Frequency (RF)
Radio frequency devices use radio waves to transmit 
information. Some of the response devices that work with 
TurningPoint use radio frequency technology. RF devices do 
not require a direct line of sight. The RF response devices use 
two-way communications, so the response device can confirm 
that a response was received by the receiver.

Ranking
A ranking is an exercise in which items are compared on 1–3 
criteria and ranked. You can set up a ranking in TurningPoint 
using the Ranking Wizard.

Receiver
A receiver is a device that attaches to your computer to receive 
IR or RF signals from response devices.

Report
Reports present session data in a variety of useful ways 
allowing you to analyze that data. You can generate reports 
from a session using Turning Reports.

Reset
To return the response tallies from the audience to zero.
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Response
A response is the signal received from a participant during 
polling. The response usually corresponds with one of a list of 
answers on the slide.

Response Grid
A Response Grid is available from the Showbar and is used to 
show which participants have responded to a question.

Response Table
A Response Table is an object on a TurningPoint slide that 
shows which participants have responded to a question.

ResponseCard
A ResponseCard is a type of hardware response device that 
use infrared (IR) or radio frequency (RF) signals to 
communicate a participant’s response.

Response Counter
A Response Counter is an object on a TurningPoint slide that 
gives a visual indication of how many of the participants have 
responded to the question.

Session
A session is a run-through of an interactive presentation where 
an audience has submitted responses to some or all of the 
questions.

Session File
A session file is created to store the results and other data 
when you run a session. Session files are usually stored in My 
Documents\TurningPoint\Sessions and have the .tpz 
extension.

Showbar
The Showbar is a toolbar that provides activation buttons for 
polling, monitoring, and viewing responses during the slide 
show.
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Slide Show
A slide show is a presentation created in PowerPoint, which 
may or may not include TurningPoint slides.

Speed Scoring
Speed scoring scales the number of points a participant 
receives for responding to a question correctly by how quickly 
the participant responded.

Standard
A standard is any framework for the evaluation of participants. 
You can assign standards to slides in a TurningPoint 
presentation to compare participants’ performance to a 
standard.

Statistic Indicator
A Statistic Indicator is an object on a TurningPoint slide that 
shows the mean (average), median, standard deviation, or 
variance of responses after polling has closed.

Text Messaging
Text Messaging is a feature for sending messages to 
participants using ResponseWare App during a presentation.

TurningPoint Slide
TurningPoint slides are slides in a PowerPoint presentation 
with the ability to dynamically display information based on the 
responses of an audience.

TurningPoint Toolbar
A series of menus and buttons displayed below the PowerPoint 
toolbars that contains the tools for using the TurningPoint 
software.

ResponseWare App
A ResponseWare App is a software version of a response 
device that is set up for use in Settings. It can be installed on a 
networked computer or Smart Device.
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WebCT
WebCT is a software product that is popularly used by 
educational institutions to facilitate e-systems.

WebCT Wizard
The WebCT Wizard is a tool that guides you through the 
process of connecting to an institution’s WebCT server.

XML
XML is a markup language for text files, similar to HTML, that is 
used by TurningPoint for storing session data and as an import 
format for the TurningPoint parser.
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Frequently 
Asked Questions

This appendix offers you a quick reference to common questions that customers have about using the 
TurningPoint software. If you do not find an answer to your question here, visit the Turning 
Technologies web site at http://www.turningtechnologies.com or call a Turning Representative toll-free 
at 1-866-746-3015.

Why can’t I install TurningPoint?
You must be the local administrator to install TurningPoint for 
the first time using the administrative username and password. 

Where is my product serial number (activation 
code)?

The product serial number, also called the activation code, is 
located on a label inside the ResponseCard Kit. 

Which response devices are compatible with 
TurningPoint?

Turning Technologies partners with Responsive Innovations to 
provide audience response devices that are specifically 
designed to support the functionality of TurningPoint. The 
ResponseCard IR, ResponseCard XL, ResponseCard RF, and 
ResponseCard XR from Responsive Innovations are products 
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that are optimally suited for use with TurningPoint. Users also 
have the option of using TurningPoint’s ResponseWare App for 
using a virtual keypad. 

How do I set up the response devices?
All of the response device settings can be found in the Settings 
windows. From the TurningPoint Toolbar, select the Tools > 
Settings. Find information about Installing Response Devices in 
Chapter 4: Response Device and Settings Management.

Where should I put the receiver?
Because the IR device uses infrared technology and line-of-
sight communication, place it in a central location in the front of 
the room where it is high enough for everyone to see. The 
effective range of an IR device receiver is about 90 feet (27 
meters). You will need to install one receiver for every 80 
participants. The effective range of a ResponseCard RF is 
about 200 feet (60 meters) and the ResponseCard XR is about 
400 feet (120 meters). A single receiver is sufficient for up to 
1000 ResponseCards, and a direct line of sight between the 
receiver and the ResponseCard is not necessary. When the 
receiver is connected, the participant has to simply press the 
number or letter on the ResponseCard to send a response. 
Find information about setting up the receiver in Chapter 4: 
Response Device and Settings Management.

Why is a ResponseCard not working?
The correct ResponseCards may not be matched with the 
receiver. Check your response device settings. Find 
information about the response device settings in Chapter 4: 
Response Device and Settings Management.

The ResponseCard’s batteries may be too low or dead. Press a 
button on the ResponseCard. The light on the ResponseCard 
blinks or does not light up if the batteries need to be replaced. 

The ResponseCard may not be correctly programmed. Refer to 
the Programming ResponseCards insert in the TurningPoint kit.

How do I track responses from participants?
Create a Participant List in TurningPoint and then use the 
Participant Monitor to view the responses from each 
participant. You can either create a Participant List using the 
Participant List Wizard or by importing an existing file. Find 
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information about Participant Lists in Chapter 5: Track 
Participants and Teams. Find information about the 
Participant Monitor in Chapter 7: Run Presentations.

When running the presentation, why don’t the 
graphs appear unless I advance to the next slide 
and then go back?

The animations in the charts vary between Office 2003 and 
Office 2007. It is likely that Microsoft Office has been upgraded 
since TurningPoint was installed. Uninstall TurningPoint, and 
then reinstall it. 

How do I clear data from a session or a slide?
From the TurningPoint Toolbar, select the Reset menu, and 
then select Session or Current Slide from menu. Find 
information about working with sessions in Chapter 9: 
Sessions.

How do I save a session?
From the TurningPoint Toolbar, select the Save Session button, 
which looks like a disk. A window opens allowing you to select 
a file name and location. Save the file in the Sessions folder, 
located at My Documents\TurningPoint\Sessions. Find 
information about saving a session in Chapter 9: Sessions.

How do I make a report with the data from my 
session?

TurningPoint enables you to create several types of reports. 
Find information about your options and instructions for 
creating reports in Chapter 8: Reports.
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